
Payroll  
User’s Guide

   2012SageDacEasy



Sage DacEasy

Payroll



ii

Copyright

Information in this document is subject to change without notice. Company names and data 
used in examples herein are fictitious unless otherwise noted. No part of this document may 
be reproduced or transmitted in any form or by any means without the express written 
permission of Sage Software Inc, 1715 North Brown Rd, Lawrenceville, Georgia 30043.

© 1998-2011 Sage Software, Inc. All rights reserved.

Printed in the United States of America.

This document, the associated software, and the associated online documentation are the 
property of Sage Software, Inc. and are loaned to the user under the terms of the Limited Use 
License Agreement. Unauthorized copying or use of the software or any associated materials 
is contrary to the property rights of Sage Software, Inc. and is a violation of state and federal 
law. This material must be returned to Sage Software, Inc. upon demand.

Trademarks

Sage, the Sage logos, Sage DacEasy, and the Sage product and service names mentioned 
herein are registered trademarks or trademarks of Sage Software, Inc., or its affiliated entities. 
All other trademarks are the property of their respective owners.

Some of the artwork in this manual is modified from illustrations provided by the Corel 
Corporation.



iii

• Table of Contents •

Chapter 1 Welcome

Overview .......................................................................................... 2
Key Features..................................................................................... 2
Additional Features ....................................................................... 10

Chapter 2 Getting Started

Overview ........................................................................................ 14
Starting Sage DacEasy Payroll ...................................................... 14
Exiting Sage DacEasy Payroll ........................................................ 15
Working With Sage DacEasy Payroll ........................................... 16

Opening and Adding Companies .................................................... 16
Setting the Default Company........................................................... 18
Copying Companies ......................................................................... 18
Creating and Restoring a Backup..................................................... 19
Using the Utilities Feature................................................................ 21

Chapter 3 Quick Tour

Overview ........................................................................................ 24
Getting Started Checklist .............................................................. 24
Understanding the Payroll Process Checklist .............................. 26
Periodic Routines Checklist .......................................................... 29

Monthly Routine Checklist .............................................................. 29
Quarterly Routine Checklist............................................................. 30
Yearly Routine Checklist .................................................................. 32

Chapter 4 Setting Up

Setting Up Default Information ................................................... 36
Setting Up System Preferences......................................................... 36
Interfacing Sage DacEasy Payroll with Sage DacEasy Accounting. 37
Setting Up Job Tracking ................................................................... 38
Files Shared with Sage DacEasy Accounting ................................... 39
Setting Up Company Information................................................... 40
Editing Standard Earning Code Descriptions ................................. 42
Setting Up Security ........................................................................... 42
Setting Up the Printer....................................................................... 43



Table of Contents
Sage DacEasy Payroll User’s Guide

iv

Setting Up Tax Table Information................................................44
Setting Up Federal Tax Tables ......................................................... 45
Setting Up State Tax Tables ............................................................. 48
Setting Up Local Tax Tables............................................................. 51

Setting Up Code Information .......................................................52
Adding and Editing Codes ............................................................... 53
Adding and Setting Up User Defined Liabilities............................. 54
Adding and Setting Up User Defined Earnings .............................. 56
Adding and Setting Up User Defined Deductions.......................... 57

Setting Up Department Information............................................59
Assigning Account Numbers ........................................................... 59
Adding or Editing Departments ...................................................... 60

Setting Up Employee Information................................................62
Adding or Editing Employees .......................................................... 62

Chapter 5 Processing Payroll

When to Use the Transaction Entry dialog box...........................66
Learning About Negative Pay .......................................................... 67
Processing a Payroll Using the Transaction Entry.......................... 67
Processing a Payroll Using Renew Payroll ...................................... 70
Processing a Payroll Using Blanket Entry ....................................... 71
Payroll Processing with Groups....................................................... 73
Editing a Transaction After Printing Checks .................................. 75

Using Time Cards ..........................................................................76
Entering Time Cards ........................................................................ 76
Printing the Time Card Report........................................................ 78

Calculating Payrolls .......................................................................79
Canceling the Automatic Payroll Calculation................................. 82

Printing the Payroll Register .........................................................83
Printing Payment Forms ...............................................................85

Printing Payroll Checks.................................................................... 85
Printing Direct Deposit Advices ...................................................... 88
Correcting Unposted Payroll Entry Errors ..................................... 89

Printing the Check Register...........................................................90
Printing the Department Report...................................................91
Creating the Direct Deposit File ...................................................93

Prenoting a Direct Deposit .............................................................. 93
Creating a Generic ACH Direct Deposit File .................................. 95
Creating an NPC Direct Deposit File .............................................. 96

Posting Payroll Transactions.........................................................97
Printing the Posting Report ............................................................. 99



Table of Contents
Sage DacEasy Payroll User’s Guide

v

Reversing Payrolls........................................................................ 100
Using AutoReverse Posting ............................................................ 100
Manually Reversing a Payroll ......................................................... 103

Making Tax Deposits .................................................................. 105
Making 940 Tax Deposits ............................................................... 105
Making 941 Tax Deposits ............................................................... 107
Making State Tax Deposits............................................................. 108
Making Local Tax Deposits ............................................................ 110

Chapter 6 Management Reporting

Overview ...................................................................................... 114
Printing the Employee Directory Report ................................... 114
Printing Employee Labels ........................................................... 115
Printing the Employee History Report....................................... 116
Printing the Detail Report........................................................... 117
Printing the New Hire Report .................................................... 119
Integrating With Microsoft Word.............................................. 121
Printing the Transaction History Report ................................... 123
Printing the Codes History Report............................................. 124
Vacation/Sick time report ........................................................... 125
Print 1096 Forms......................................................................... 126

Chapter 7 Periodic Operations

Checking for Tax Updates Online.............................................. 130
Printing W-4s .............................................................................. 131
Reconciling Checks ..................................................................... 132
Purging Checks............................................................................ 134
Closing the Month....................................................................... 135
Printing State Quarterly Reports ................................................ 135
Printing State Quarterly Worksheets ......................................... 136
Printing the 941 ........................................................................... 137
Printing the Schedule B............................................................... 138
Closing the Quarter ..................................................................... 139
Printing the 940 ........................................................................... 140
Printing W-2s .............................................................................. 141
Printing the W-3.......................................................................... 142
Printing 1099s and 1096s ............................................................ 143
Creating Magnetic Media Files ................................................... 144
Closing the Year........................................................................... 145



Table of Contents
Sage DacEasy Payroll User’s Guide

vi

Chapter 8 Custom Reporting

Overview.......................................................................................148
Using the Query ...........................................................................150

Using the Query Checklist ............................................................. 151
Completing the Header Area ......................................................... 151
Selecting Fields in the Column Selection Area ............................. 152
Selecting the Sort Order for the Query.......................................... 152
Creating User Defined Fields ......................................................... 154

Limiting Records on a Query ......................................................155
Establishing Criteria ....................................................................... 156
Understanding AND/OR Logic ..................................................... 157
Understanding Joins....................................................................... 159
Printing the Query.......................................................................... 160

Using the Publisher......................................................................161
Using the Publisher Checklist ........................................................ 163
Completing the Header and Page Header Area ............................ 163
Completing the Detail Area ........................................................... 164
Completing the Group Footer Area .............................................. 164
Completing the Report Footer Area.............................................. 164
Previewing and Printing the Final Report..................................... 166



Table of Contents
Sage DacEasy Payroll User’s Guide

vii

Chapter 9 Glossary of Terms

1099 Misc Form .............................................................................. 167
940 Form ......................................................................................... 167
941 Form ......................................................................................... 167
ACH (Automated Clearing House) ............................................... 168
Sage DacEasy Business Center ....................................................... 168
Code................................................................................................. 168
Deduction........................................................................................ 168
Direct Deposit ................................................................................. 169
Earning ............................................................................................ 169
EIC (Earned Income Credit).......................................................... 169
Federal Withholding....................................................................... 169
FICA ................................................................................................ 170
FUTA ............................................................................................... 170
Liability............................................................................................ 170
Magnetic Media .............................................................................. 171
Medicare.......................................................................................... 171
New Hire Report............................................................................. 171
NPC (National Payment Corporation) ......................................... 171
Prenote ............................................................................................ 172
Reconciliation ................................................................................. 172
Schedule B ....................................................................................... 172
SDI ................................................................................................... 172
Social Security ................................................................................. 172
Standard Codes ............................................................................... 172
SUI ................................................................................................... 173
SUTA ............................................................................................... 173
Third Party Sick Pay (TPSP) .......................................................... 173
User Defined Codes ........................................................................ 173
W-2 Form........................................................................................ 173
W-3 Form........................................................................................ 174
W-4 Form........................................................................................ 174
W-4+ Form ..................................................................................... 174



Table of Contents
Sage DacEasy Payroll User’s Guide

viii



1Welcome

Overview 2

Key Features 2

Additional Features 10



Welcome
Sage DacEasy Payroll User’s Guide

2

1

• Welcome •

Overview
Welcome to Sage DacEasy Payroll. Sage DacEasy Payroll makes automating 
your payroll a simple process, yet offers you the power and sophistication of 
much more expensive payroll systems. For more than a decade, we have listened 
to our customers’ suggestions to develop a robust payroll system with the 
features needed to successfully grow a business. 

This User’s Guide assists you with setting up your company and details basic 
payroll routines. For more detailed instructions on related or advanced features, 
the User’s Guide includes a “Related Help Topics” section. Each “Related Help 
Topics” section in the User’s Guide lists the related topics included in the Sage 
DacEasy Payroll Help system. Use the Contents tab or the Index tab in the Help 
to locate the topic.

Refer to the Getting Started Guide for assistance with using Help, 
documentation conventions and other methods of obtaining assistance with 
your software. The Getting Started Guide also includes information on installing 
Sage DacEasy and adding or converting company files with the Sage DacEasy 
Business Center. In addition, global Sage DacEasy features such as printing and 
using the LookUp are explained. 

Note: If you choose to use the Sage DacEasy Business Center, and select a 
scheme with multiple Sage DacEasy programs, please note the following change 
regarding menu selections. When this User’s Guide instructs you to select a 
command from a menu in Sage DacEasy Payroll, select the Payroll menu in the 
Sage DacEasy Business Center, and then proceed with the steps. For example, if 
the User’s Guide instructs you to select Copy from the File menu, you have to 
select File from the Payroll menu in the Sage DacEasy Business Center, and then 
select Copy. 

Key Features
The following information highlights some of the many powerful features in 
Sage DacEasy Payroll. 

Note: For a list of key features common to all Sage DacEasy programs, refer to 
Chapter 1, “Welcome” in the Getting Started Guide.
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Stand Alone Module or Interfaced with Sage DacEasy Accounting

Sage DacEasy Payroll can be run as a stand alone program or as an add-on 
module to Sage DacEasy Accounting. If you currently use Sage DacEasy 
Accounting, you can set up a direct interface to the Sage DacEasy Accounting 
General Ledger module. Then, when you post a payroll, the appropriate 
accounts are updated in the General Ledger automatically.

Processing Payrolls Easily

Payrolls are a snap to process using the Transaction Entry, Time Card Entry and 
Calculate Payroll routines. You can enter any out of the ordinary payroll 
situation, such as paying vacation or sick time using the Transaction Entry 
routine. You can also enter time cards for your hourly employees using the Time 
Card Entry routine, and the regular and overtime is automatically calculated for 
you. The Calculate Payroll routine automatically calculates a full payroll for all 
other selected employees and calculates the liabilities and deductions for 
employees with time cards and other manual entries you made using the 
Transaction Entry routine.

Sage DacEasy Payroll lets you choose which employee pay type you want to 
include when you automatically calculate a payroll. This allows you to generate 
a payroll for only hourly employees if you want. You also have the ability to 
calculate payroll for a select number of employees in a range or certain 
frequencies. 

Renew Payroll

The Renew Payroll feature allows you to select any previously posted payroll and 
reuse that payroll as a template for a new payroll. The selected posted payroll is 
used to copy most of the transactions that you usually use when processing a 
payroll. For more information on this feature, refer to Chapter 5, “Processing 
Payroll."

Blanket Entry

The Blanket Entry feature dramatically reduces the time and error associated 
with making payroll entries. You can define the common exceptions once, along 
with the set of employees affected, and Sage DacEasy generates the necessary 
transactions for each individual employee. Once the transactions have been 
generated, you can continue the normal payroll process, as well as add non-
conforming exceptions to individual employees if necessary. For more 
information on this feature, refer to Chapter 5, “Processing Payroll."

Automatic Employee Loan Repayment

With the Automatic Employee Loan Repayment feature, it has never been easier 
for your employees to pay off a loan or repay for supplies and equipment to the 
company. 
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This feature allows you to create a loan for an employee that automatically 
repays the loan as a recurring deduction. This works as a negative deduction that 
automatically stops calculating when the amount reaches zero. This type of 
deduction code also carries the balance to the next year after closing the current 
year. For more information on this feature, refer to the Help topic titled “Setting 
up a repayment deduction.”

Increased Field Sizes

Certain fields in Sage DacEasy Payroll have been extended to accommodate 
larger memos giving you more flexibility to provide detailed memo 
information. The employee memo field has increased from 30 characters to 40 
characters. In addition, both the payroll check memo and tax deposit check 
memo have increased from 20 characters to 40 characters.

Select Individual Employees When Printing Checks and Advices

Now you can print checks for only the employees you want in a single run, even 
if they have nonconsecutive employee information. When you use this feature, 
a list of all employees in the range you select appears. You can pick only the 
employees you want included when printing checks. This feature is also 
available in the new Direct Deposit Advice feature. For more information on 
this feature, refer to Chapter 5, “Processing Payroll."

Exclude Social Security Number On Payment Forms

This new feature allows you to protect your employee’s social security number, 
considered by most confidential information. At check and direct deposit advice 
print time, you have the option of masking the social security number.

Exclude Routing and Bank Account Numbers on Payment Forms

You now have the option of hiding the bank account and routing numbers on 
direct deposit advices and checks.  These preferences are easily available at check 
or direct deposit advice print time. 

OCReady Long Stub Checks

This feature allows you to print more detail lines on your payroll check stubs. 
You can print up to 27 earnings and 27 deductions on the check as opposed to 
the limited 10 from previous versions. Also, vacation and sick time print in an 
area specifically designed for this purpose. To use this feature select OCReady 
Long Stub Format as the Check Type option on the Payments Settings tab of 
the System Preferences dialog box. For more information on this feature, refer 
to Chapter 5, “Processing Payroll."
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Direct Deposit Advice

You can print a Direct Deposit Advice also known as Direct Deposit Slips for 
employees using direct deposit. This saves you time and money. You no longer 
have to void checks for those employees using direct deposit to provide them 
with their payroll information. For more information on this feature, refer to 
Chapter 5, “Processing Payroll."

Direct Deposit Disbursement Report

This report for Direct Deposit Disbursements allows better reporting of the 
employees’ payment history. The Direct Deposit Disbursement Report available 
in Sage DacEasy is based on the Direct Deposit History, so it is always available 
for current or past payrolls. The Direct Deposit Disbursement Report that prints 
after creating your Direct Deposit file includes payment information for the 
current payroll. 

You also have access to past payment history by viewing and printing the 
Deposit History from the Edit Employee Information and Edit Employee 
Accumulations dialog boxes. You also have access to the new Direct Deposit 
History information when creating custom reports in DacAccess and Crystal 
Reports. 

Reconcilable Direct Deposit Transactions

In previous versions, the Check Reconciliation routine could be complicated 
and confusing when an employee was partially paid with direct deposit and a 
check was printed for the remaining portion. This confusion was because a 
Check Register entry was created for the full amount the employee was paid 
(both the amount paid by direct deposit and the amount paid by check) and not 
just the amount for which the check was printed. Sage DacEasy creates Check 
Register entries for the amounts paid by check, as well as creates separate Check 
Register entries for the direct deposit payments. This feature allows you to 
accurately track the Check Register information and reconcile your bank 
account.

Employee Method of Payment History

Posted employee payment information is stored in the Payroll Detail History 
files. Unlike the previous versions, you can differentiate the amounts paid to 
employees if they were paid by check and direct deposit.  

When printing checks or direct deposit advices, a snap shot of the current direct 
deposit information is stored in a temporary file. When you post a payroll 
transaction, the information stored in the temporary file is transferred to the 
Payroll Detail History files. A new file is added to the Payroll Detail History file 
set to store the records for direct deposit only. Only those employees that have 
direct deposit are included in this new file. 
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Once you post your payroll transactions, you can view the direct deposit 
information in the Payroll Transaction History LookUp. To view this direct 
deposit information, select History from the Edit Employee Information or 
Edit Employee Accumulations dialog box, select a direct deposit transaction, 
and then click Deposit.

AutoReverse Payroll

It is easier than ever to reverse a payroll. This feature allows you to automatically 
reverse the payroll quickly and accurately. You no longer have to manually 
record a payroll entry using the Payroll Register. Instead, you can select the 
payroll transaction, and then select the employees within the payroll transaction 
you want reversed. For more information on this feature, refer to Chapter 5, 
“Processing Payroll."

AutoApply Regular Earnings

Stop manually calculating regular earnings for your employees when they take 
vacation or sick time. This time consuming task has been conveniently replaced 
with the AutoApply button on the Transaction Entry dialog box. When 
entering a payroll for an employee, simply enter their vacation or sick time, and 
then click AutoApply. The amount of regular time is automatically calculated 
and inserted into the payroll entry for the employee. Now all you have to do is 
run the Calculate Payroll routine to automatically calculate the employee’s 
liabilities and deductions. For more information on this feature, refer to 
Chapter 5, “Processing Payroll."

Calculate Payroll for Selected Employees

You can calculate a single payroll for only the employees you want, even if they 
have nonconsecutive employee codes. When you use this feature, a list of 
employees in the range you select appears. You pick only the employees you 
want included in the payroll calculation. This feature is also available when 
printing checks and direct deposit advices and in the AutoReverse Payroll 
feature. For more information on this feature, refer to Chapter 5, “Processing 
Payroll."

View Payroll Transaction History

Viewing your employee’s payroll transaction history is quick and easy. You have 
several choices to view the payroll transaction history. A History button is 
available on the Edit Employee Information and Edit Employee Accumulations 
dialog box that allows you to quickly view the payroll transaction history for the 
employee. You can also print two additional reports. 

The Transaction History report is available in summary or detail. The 
information on this report is similar to the Payroll Register, but includes only 
posted payroll transactions. 
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Another report is the Codes History report. This report can be customized to 
print the payroll history of individual codes. You can use this report to print 
your vacation and sick time paid, or use it as a 401k report. For more 
information on the payroll transaction history reports, refer to Chapter 6, 
“Management Reporting."

Payroll Processing with Groups

More flexible payroll processing! You may classify your payroll runs into defined 
groups. For example, you may want to run payroll for a group of employees that 
contain both hourly and salaried employees. Payroll Groups consist of one or 
more salaried or hourly employees that are processed in the same payroll run. 
Use Payroll Groups when you want to have payroll processing cycles segregated 
by groups of employees with similar characteristics. 

Custom Checks

Customize employee payroll checks to your company’s needs by positioning 
information based on your bank’s suggestions. You may print checks based on 
templates defined by you the same way as invoices, purchase orders and other 
forms print in Sage DacEasy Accounting. To use customized checks in Sage 
DacEasy payroll, setup Custom as the check printing option in Preferences, and 
define the check template to use. 

Audit Trail

Improve auditing and defend against potential fraud. With this feature, you have 
a register of user activity in the system. Audit Trail records insertions, deletions, 
and modifications of the most relevant master tables in Sage DacEasy Payroll. 
This important enhancement keeps a record of the date and time of all changes 
to the Payroll Employee file and the Tax Tables.

Customized Lookups

Allows you to select the columns that appear in lookups, and the width of each 
column displayed. The feature also includes an option to export customized 
lookups to an ASCII file.  Records which have notes attached will be flagged in 
the lookup with a note icon.

Email Reports and Forms

Currently you may select whether to send a given report or form to the Printer, 
Screen, HTML, Excel, or whether to export the output to a comma delimited or 
text file. This feature adds email to these options so that a form or a report can 
be sent to an email address directly from within Sage DacEasy.
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Print 1096 Form

Sage DacEasy includes the ability to print Federal Form 1096. When users 
prepare their 1099s they can print the summary data onto a pre-printed Form 
1096 to send to the IRS.

Reprint Closed Quarter Reports

This feature in the Sage DacEasy Payroll module allows you to re-print your 
State Quarterly report, State Quarterly Worksheet, Form 941, and Schedule B 
reports after you run the Close Quarter periodic function. Sage DacEasy saves a 
snapshot of your quarterly reports as they were printed prior to closing the 
quarter. You can then re-print these reports for any previously closed quarter.

Protect Sensitive Information

As your business grows, you will want to maintain control over what type of 
business information employees can access. With Sage DacEasy’s security 
system, you can restrict users’ access to certain areas of the program. Just enter 
a password for each level. Each level provides access to select parts of the 
program.

Federal Forms

You can print certain federal forms to plain paper, which prints the form and 
your accompanying payroll data. Sage DacEasy Payroll includes the option to 
print the following approved federal forms complete with your payroll data, the 
940, 941, Schedule B and W-4. This feature saves you the time of having to locate 
the form if you do not already have it, aligning your printer to ensure the 
information prints on the form correctly or manually writing out the 
information from a worksheet to the form. To print these forms to plain paper 
be sure to select the Plain Paper check box on the Report Layout dialog box.

Custom Fields

Custom fields are available for you to track specific information in your 
employee records. You can track up to six text fields, four amount fields and two 
date fields, and then use this information on custom reports generated in 
DacAccess.
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Online Tax Updates

Sage DacEasy includes an Online Tax Update feature. This feature allows the 
program to periodically check the Sage DacEasy Web site for the latest Payroll 
Tax Updates. Using this feature saves you the headache of having to keep up 
with your state and federal tax legislation changes. To receive Tax Updates 
automatically online, sign up for the Sage DacEasy Tax Service. For more 
information on this plan, contact the Sage DacEasy Sales division at (800) 987-
5212.  Read the section titled “Checking for Tax Updates” in the chapter titled 
“Periodic Operations” for more information on this feature.

Enable and Disable Custom Earning Codes

Simplify bonus payouts, sales commission payments, and other non-regular 
payments to employees with the ability to enable and disable user-defined 
earnings codes. You can create user-defined earnings codes and enable or 
disable them for individual payroll runs making non-regular payments to 
employees easy. 

Forms Available From Sage DacEasy

When you print checks, W-2s, W-3s or 1099s, you can print the documents on 
preprinted paper forms supplied by Sage DacEasy. You can use preprinted 
checks right out of the box or have custom checks made with your company 
name, address and logo. Call our Sage DacEasy Forms division at (800) 222-
0505 for more information on the wide range of forms available.

Edit Standard Earning Code Descriptions

Sage DacEasy Payroll allows you to edit the standard earning code descriptions 
that display on the Earnings page of the Edit Codes dialog box. This allows you 
to customize the descriptions to suit your business needs. The descriptions you 
enter display throughout Sage DacEasy Payroll in areas such as reports, pay 
checks, and direct deposit advices.

Job Tracking

Sage DacEasy Payroll now includes the Use Job Tracking option on the Posting 
tab of the System Preferences dialog box, which allows you to disable job 
tracking if the Job ID field does not pertain to your business. After disabling job 
tracking, the Job ID field will no longer appear on the transaction entry screen.

Note: If you interface Sage DacEasy Payroll with Sage DacEasy Accounting, the 
Use Job Tracking option is read-only. It is automatically marked or unmarked 
according to your selection on the General page of the System Preferences 
dialog box in Sage DacEasy Accounting. You must unmark Interface with Sage 
DacEasy Accounting if you want to use job tracking only in Sage DacEasy 
Payroll.
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Additional Features

• Prints state and local tax deposits on the Payroll Register.

• Permits Third Party Sick Pay and Group Term Life.

• Prints a memo line on payroll check stubs.

• Option to enter time card information and print a Time Card report.

• Prints 940, 941 and Schedule B forms and the State Quarterly 
worksheet and report.

• Calculates next quarter amounts while allowing current quarter or year 
to remain open.

• Processes payrolls for employees in different pay frequencies 
simultaneously.

• Allows limits on user defined deductions at the company, department 
or employee level.

• Allows pay type selection and employee ranges when running the 
Calculate Payroll routine.

• Optional group deletion for terminated employees during the Year End 
routine.

• Includes state information on the W-2 magnetic media file.

• Calculates earnings, deductions and liabilities for all payroll periods.

• The Sage DacEasy Payroll journal (Posting report) includes each 
general ledger account’s name, if interfacing with Sage DacEasy 
Accounting.

• Calculates and tracks SDI employee wages and SDI employer liability.

• Automatically saves user defined earnings and deductions setting in the 
Calculate Payroll routine.

• Prints W-3 Form by itself, or after printing W-2s.

• DacAccess, the custom report writer pulls data from multiple files.

• Generates vacation, sick, bonus or commission pay with or without 
generating regular pay.

• Supports hourly, salary and contract labor payroll structures.

• Tracks up to 30 user defined earnings and deductions per employee.

• Tracks up to 12 user defined liabilities per employee.

• Customize W-2s and 1099s, as well as business reports.
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• Creates direct deposit files in an NPC (National Payment Corporation) 

format or ACH (Automated Clearing House) format.

• Includes special features for the District of Columbia, Puerto Rico and 
the cities of New York and Yonkers.

• Performs after-the-fact, irregular and nonstandard payrolls.

• Meets federal government magnetic media requirements of W-2 data 
for companies with over 250 employees.
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• Getting Started •

Overview
This chapter gets you started using the program if you choose to run Sage 
DacEasy Payroll independent of the Sage DacEasy Business Center. It includes 
information on starting and exiting Sage DacEasy Payroll, adding and opening 
companies, backing up and restoring your data and other commands found on 
the File menu.

Starting Sage DacEasy Payroll 
If you are using the Sage DacEasy Business Center, you do not have to start Sage 
DacEasy Payroll separately. When you are using a scheme with multiple 
programs, access the Payroll menu located on the menu bar in the Sage DacEasy 
Business Center, the same menus and commands that appear in Sage DacEasy 
Payroll are available. When you select a command from the Payroll menu, the 
appropriate dialog box appears. Refer to Chapter 3, “Installing Sage DacEasy” in 
the Getting Started Gudie for information on starting the Sage DacEasy Business 
Center.

To start Sage DacEasy Payroll independent of the Sage DacEasy Business Center, 
complete the following steps.

Note: If you are upgrading your data from a previous version, refer to Chapter 
3, “Installing Sage DacEasy” in the Getting Started Guide  before completing the 
following steps. 

To Start Sage DacEasy Payroll

1 Click the Start button, point to Programs, then to Sage DacEasy, then click 
Modules, and then Payroll. 

The first time you load the program you are asked to register the program. If 
you select Yes, the Serial Number dialog box appears. Type your serial 
number and activation key using all capital letters, and then click OK. Choose 
No if you want to register at a later time. The Welcome to Sage DacEasy 
dialog box appears. 

Note: After you access Sage DacEasy Payroll for the first time, this dialog box 
does not appear, and Sage DacEasy Payroll opens your default company.

2 Select the Add New Company Data option. The Add Company dialog box 
appears. Use this dialog box to create a new company.
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3 Complete each field on the Add Company dialog box. You can click Help for 
more information about each option on the dialog box.

4 Click OK to create the new company data files. The Open Company dialog 
box appears.

5 Double-click the company you want from the dialog box.

To Start Sage DacEasy Payroll From Sage DacEasy Accounting

If you are not using the Sage DacEasy Business Center, there are two ways to 
start Sage DacEasy Payroll while in the Sage DacEasy Accounting program; you 
can use the Modules menu found on the menu bar or you can customize the 
Sage DacEasy Accounting system toolbar to include a Payroll button. To use the 
Modules menu, you need to make sure the external modules path is set up 
properly in Sage DacEasy Accounting.

To set up the external module path, start the Sage DacEasy Accounting 
program. Point to Defaults on the Edit menu, and then select System 
Preferences. The System Preferences dialog box appears. Click the Paths tab 
and type the path to the Sage DacEasy Payroll program files in the Sage DacEasy 
Payroll field. Click OK to save the change. Then, to start Sage DacEasy Payroll 
from Sage DacEasy Accounting, choose Payroll on the Modules menu. The Sage 
DacEasy Payroll program appears with the Sage DacEasy Accounting program 
still open. 

To customize the Sage DacEasy Accounting system toolbar to include a Payroll 
button, refer to the Sage DacEasy Accounting Help topic titled “Customizing 
the toolbar.” 

Exiting Sage DacEasy Payroll
If you are not using the Sage DacEasy Business Center, choose Exit from the File 
menu to exit Sage DacEasy Payroll. You can also exit Sage DacEasy Payroll by 
clicking the Close button located on the Sage DacEasy Payroll title bar. A 
message appears confirming you want to exit the program. Choose Yes to 
continue.

The Add Company dialog
box appears the first time

you access the program
and select the Add New

Company data option.
This is the same dialog box

that appears each time
you select to add a

company to Sage DacEasy
Payroll.
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Note: A tip may appear recommending that you back up your data. Click Cancel 
to return to the program and make a backup or click Exit to close the program.

Working With Sage DacEasy Payroll
This section outlines the various company routines available on the File menu. 
These commands allow you to open, add and copy companies, create and 
restore a backup and perform utilities on company data files without exiting the 
program. If you are using the Sage DacEasy Business Center, refer to the Sage 
DacEasy Business Center Guide  for more information on the Backup and 
Restore routines. You can also refer to the Getting Started Guide  for information 
on general features available in all Sage DacEasy programs such as using the 
LookUp and the calculator.  

Opening and Adding Companies

If you are not using the Sage DacEasy Business Center to access Sage DacEasy 
Payroll, you are prompted for information about your company when you start 
the program the first time. Sage DacEasy uses this information to create your 
company’s data files. This company becomes the default company and is 
opened automatically the next time you start the program. 

The Open command on the File menu displays the Open Company dialog box. 
From the Open Company dialog box, you can open a company, delete the path 
to a company, add a company and select the default company. The following 
steps explain how to add new companies and open existing companies directly 
in Sage DacEasy Payroll. 

To Open a Company

You can add an unlimited number of companies; however, you can only open 
one company at a time if you choose not to use the Sage DacEasy Business 
Center. The following steps explain how to open a different company if you 
choose not to use the Sage DacEasy Business Center. When you select a different 
set of data files, Sage DacEasy closes the current data files before opening the 
next company.

Tip: You can include your Sage DacEasy Payroll data files in a company profile 
in the Sage DacEasy Business Center, and then open the company from the Sage 
DacEasy Business Center. This gives you all the advantages of the Sage DacEasy 
Business Center, including the ability to have multiple windows open at once. 
In addition, you don’t have to close one company before opening a different 
company. Refer to Chapter 3, “Installing Sage DacEasy” in the Getting Started 
Guide  for more information.
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1 Choose Open on the File menu. The Open Company dialog box appears.

Tip: You can sort on any column to help you quickly locate a company. Refer 
to the “Using the LookUp” section in Chapter 4, “Working With Sage 
DacEasy” in the Getting Started Guide for more information.

2 Double-click a company from the list. Sage DacEasy Payroll opens the 
company. 

Note: Your current company and period date appear on the status bar at the 
bottom of the application window.

To Add a Company

Use the Add button on the Open Company dialog box to create a new set of 
company data files in Sage DacEasy Payroll or to reestablish a path between Sage 
DacEasy Payroll and an existing set of company data files. 

1 Choose Open on the File menu. The Open Company dialog box appears.

2 Click Add. The Add Company dialog box appears.

3 Type a short description of the company in the Identification Name field. 

Tip: Click Help for a detailed description of each field on the Add Company 
dialog box.

4 Type the path for the new data files in the Path field if creating a new 
company. Type the path to an existing set of data files if reestablishing the 
path between the data files and Sage DacEasy Payroll. If you are not sure of 
the path, click the Browse button to locate the data files.

Use the Add Company
dialog box to set up new

company data files or
reestablish the path to an

existing set of data files.

Use the Open Company
dialog box to select the

company you want to
view.
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5 Click OK.

If you are creating a new company, the new company data files are created. 
After creating the data files, the Open Company dialog box appears and you 
can select the company you want to open.

If you were reestablishing a path between Sage DacEasy Payroll and an 
existing set of company data files, a message appears stating files exist in the 
path specified. Choose Yes to continue to reestablish the path. The Open 
Company dialog box appears and you can select the company you want to 
open.

Related Help Topic

• Deleting companies

Setting the Default Company

If you have set up only one company, it is the default company. If you have 
multiple companies, select one company as the default company. Sage DacEasy 
opens the default company automatically each time you access the program. 
You can change the default to any of the companies on the Open Company 
dialog box. A Y appears in the Default column indicating which company is the 
default. 

To Set the Default Company

1 Choose Open on the File menu. The Open Company dialog box appears.

2 Select the company you want set as the default from the list.

3 Click Default. A Y appears in the Default column next to the company. The 
next time you access the program, the new default company data files 
automatically open.

Copying Companies

Sage DacEasy Payroll has a Copy routine that allows you to copy the user 
defined codes, account numbers and departments from an existing company 
and copy it to a new folder. The copied files are treated as a new company and 
appear on the Open Company dialog box. This is useful when establishing 
multiple companies that share similar department structures. 
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To Copy a Company’s Data Files

1 Choose Copy on the File menu. The File Copy dialog box appears.

2 Double-click the company you want to copy from the list. The Add Company 
dialog box appears.

3 Type a short description of the company in the Identification Name field. 

4 Type the path for the new data files in the Path field. 

5 Click OK. A message appears when the Copy routine is successfully complete. 
Click Continue.

Creating and Restoring a Backup

With the Backup routine, you can back up your data to a disk, to your hard drive 
or to a network drive. We recommend you keep a backup copy of your data files 
on disk so you do not lose your data in the event of a hard drive failure.

It is recommended that you make frequent backups of your data. It is especially 
important to make a backup before performing certain irreversible functions 
such as posting or purging. You can make a backup at any time by selecting 
Backup/Restore on the File menu. In addition, you can make backups directly 
from a number of irreversible functions such as the Posting routine by selecting 
the Backup button on the toolbar.

Tip: You can back up or restore all data files in a company profile at one time 
using the Sage DacEasy Business Center. Refer to Chapter 5, “Working With the 
Sage DacEasy Business Center” in the Getting Started Guide for more 
information.

To Create a Backup of Your Data Files

1 Choose Backup/Restore on the File menu. The File Backup/Restore dialog 
box appears.

2 Select Backup in the Operation field.

Use the File Backup/
Restore dialog box to

make a backup of your
data files.
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3 Select Payroll to backup only payroll data files. Select Accounting to backup 

only accounting data files. 

4 Type the path to the data files you want to back up in the Source field. Sage 
DacEasy displays the path to the files currently open, but you can change the 
path if you want to back up files located elsewhere on your hard disk drive.

5 Type the path to where you want to store the backup files in the Target field. 
If you are not sure of the path, click the Browse button to locate the drive 
and folder you want.

6 Click OK. A message appears confirming you want to make a backup. 
Choose Yes to continue. During the routine, Sage DacEasy prompts you to 
insert disks in the appropriate drive, if necessary.

Related Help Topic

• Setting up backup and restore defaults

To Restore a Backup of Your Data Files

1 Choose Backup/Restore on the File menu. The File Backup/Restore dialog 
box appears.

2 Select Restore in the Operation field.

3 Select Payroll to restore only payroll data files. Select Accounting to restore 
only accounting data files. 

4 Type the path to the backup you want to restore in the Source field. If you are 
not sure of the path, click the Browse button to locate the backup you want 
to restore.

5 Type the path to the company receiving the backup in the Target field. If you 
are not sure of the path, click the Browse button to locate the data files.

6 Click OK. A message appears confirming you want to restore a backup. 
Choose Yes to continue. During the routine, Sage DacEasy prompts you to 
insert disks in the appropriate drive, if necessary.

Related Help Topic

• Setting up backup and restore defaults
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Using the Utilities Feature

The File Utilities feature allows you to periodically check the integrity of your 
data files, and if necessary, repair any damaged files. There are two routines 
available from within the Utilities command, Drop Indexes and Recover. You 
can perform these routines at any time. You should run recover on all your data 
files at least once a month. Make a backup of your data files before running any 
of the Utility routines.

Important: You can click the Close button on the Operation Status dialog box 
to interrupt the Drop Indexes and Recover routines. If you choose to interrupt 
a routine, a confirmation screen appears. Choose Yes to stop the utility routine. 
Sage DacEasy completes the utility on the current file and displays a cancellation 
message. It is very important you return later and run the utility routine again.

To Run the Drop Indexes and Recover Routines

1 Choose Utilities on the File menu. The File Utilities dialog box appears.

2 Type the number of the file in the File Selection field. If you are not sure of the 
file number, click LookUp to select a file from a list. 

3 Select the routine you want to run in the File Operation field. You can click 
Help from the File Utilities dialog box for a detailed description of each field.

4 Click OK. Sage DacEasy displays a message when the operation is complete. 
Click Continue to return to the File Utilities dialog box.

5 Click Close to exit the dialog box.

Related Help Topic

• Sage DacEasy Payroll file utility numbers

Use the File Utilities dialog
box to select the routine

and file.
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• Quick Tour •

Overview
Use the Quick Tour to accustom yourself with Sage DacEasy Payroll. The Quick 
Tour gives you checklists that take you through the program explaining the key 
processes you perform to create a company, calculate a payroll and run periodic 
routines.

Getting Started Checklist
Use this checklist to get your payroll information into Sage DacEasy Payroll. 
Enter this information before you process your first payroll to ensure a fast and 
accurate payroll.

 Add your company

Sage DacEasy Payroll lets you track payroll information for multiple 
companies. You are prompted to add a company the first time you access 
Sage DacEasy Payroll. Add additional companies to Sage DacEasy Payroll 
using the Open command on the File menu. For more info on adding a 
company to Sage DacEasy Payroll, refer to “Opening and Adding 
Companies” on page 16.

Tip: You can also add your new company using the Sage DacEasy Business 
Center, and then use the Setup Workflow Guide to assist you with the 
setup process.

 Enter passwords to set up security

To set up security in Sage DacEasy Payroll, enter a unique password for 
each level. Each level password allows access to certain areas of the 
program. The controller has full access to all areas of the program. For 
more info on on setting up the security in Sage DacEasy Payroll, refer to 
“Setting Up Security” on page 42.

 Enter system preferences

Use the System Preferences dialog box to customize the software to meet 
your needs for the current company. For example, if you are interfacing 
with Sage DacEasy Accounting, enter the path to your accounting data in 
the appropriate field. To view the System Preferences dialog box, point to 
Defaults on the Edit menu, and then select Preferences. For more info on 
setting up preferences, refer to “Setting Up System Preferences” on page 
36.
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 Enter company information

Enter your company’s name, address information and yearly information. 
The company address information prints at the top of each report. When 
entering this information you will also select settings specific to the 
structure of your working year and direct deposit. Sage DacEasy uses the 
company information to accurately calculate your payroll. Add your 
company information by choosing Company on the Edit menu. For more 
info on adding company information in Sage DacEasy Payroll, refer to 
“Setting Up Company Information” on page 40.

Note: If you add your company using the Sage DacEasy Business Center, 
you have the option to automatically update the company information in 
each Sage DacEasy module when you save the new company profile. This 
keeps you from entering your address info more than once; however, you 
still need to set up the structure of your year and direct deposit 
information for your company in Sage DacEasy Payroll.

 Set up your default printer

Use the Edit Default Printer dialog box to set your default printer settings. 
These settings are used when you print your reports in Sage DacEasy 
Payroll. To access the Edit Default Printer dialog box, point to Defaults on 
the Edit menu, and then select Printer. For more info on setting up the 
application printer, refer to “Setting Up the Printer” on page 43.

 Add and edit the tax tables

Sage DacEasy uses tables to store federal, state and local tax tables. Set up 
each tax table appropriately to ensure an accurate payroll calculates for 
each employee. To set up your tax tables, choose the appropriate tax on the 
Edit menu. For more info on working with your tax tables, refer to “Setting 
Up Tax Table Information” on page 44.

 Edit the standard codes and add any user defined codes necessary

Sage DacEasy uses codes to calculate earnings, deductions and liabilities 
for each employee. In addition to the standard codes (for example, Social 
Security and Medicare), you can add user defined codes. Examples of user 
defined codes include insurance, profit-sharing plans and bonus plans. 
Select Codes on the Edit menu to edit any standard codes and add any user 
defined codes. For more info on adding and editing codes, refer to “Setting 
Up Code Information” on page 52.



Quick Tour
Sage DacEasy Payroll User’s Guide

26

3
 Add the departments

Payroll expense is often one of the biggest expenses affecting a company’s 
bottom line. Therefore, it is important that your payroll software provide 
you with a method to monitor this expense closely. Sage DacEasy Payroll 
allows you to set up departments to assist you in monitoring your payroll 
expense. Add your departments by selecting Departments on the Edit 
menu. After setting up each department, you can assign each employee a 
home department. After calculating a payroll, you can print reports 
tracking each department’s payroll expense. For more info on adding 
departments, refer to “Setting Up Department Information” on page 59.

 Add the employees and their necessary information

Add your employees using the Employee Information and Employee 
Accumulations commands on the Edit menu. Enter information such as 
name, address and payment information used to calculate the employee’s 
paycheck. If you want to use the Direct Deposit feature, use the Edit 
Employee Information dialog box to set up the employee’s direct deposit 
account information. Sage DacEasy Payroll updates the employee’s 
earnings, deductions, liabilities, payment information, vacation time and 
sick time each time you process and post a payroll for an employee. For 
more info on adding employees, refer to “Setting Up Employee 
Information” on page 62.

Understanding the Payroll Process Checklist
Use the Understanding the Payroll Process checklist to accustom yourself with 
processing a payroll. The checklist goes into each step of processing a payroll.

 Enter the hours each employee worked 

Use the Transaction Entry dialog box to enter the hours worked for hourly 
employees if they did not work their regular scheduled hours. You can also 
use the Time Card Entry feature from this dialog box to automatically 
calculate the number of hours your employees worked. You also use the 
Transaction Entry dialog box to enter the amount of time a salaried 
employee worked if they did not work their normal schedule because of 
vacation or sick time. 

You can access the Transaction Entry dialog box by choosing Entry on the 
Process menu. For more info on using the Transaction Entry dialog box, 
refer to “Processing a Payroll Using the Transaction Entry” on page 67.

Tip: You can also use the Blanket Entry or Renew Payroll features to create 
your payroll entries. Refer to Chapter 5, “Processing Payroll." for more 
information on using these features.
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 Process the payroll using the Calculate Payroll routine

Use the Calculate Payroll routine to automatically generate a payroll for 
your employees. If you have entered some payroll entries using the 
Transaction Entry, Renew Payroll or Blanket Entry features, the Calculate 
Payroll routine calculates the correct deductions and liabilities for those 
employees. If you have hourly or salaried employees who worked their 
regular scheduled days or hours, just use the Calculate Payroll routine to 
calculate their earnings, deductions and liabilities automatically. 

You can access the Automatic Payroll Calculation dialog box by choosing 
Calculate Payroll on the Process menu. For more info on running the 
Calculate Payroll routine, refer to “Calculating Payrolls” on page 79.

 Print the Payroll Register

Print the Payroll Register to verify that all payroll entries were processed 
correctly. This report is also useful when determining the amount of your 
tax deposit. Print a Payroll Register by choosing Payroll Register on the 
Process menu. For more info on printing the Payroll Register, refer to 
“Printing the Payroll Register” on page 83.

 Print the payroll checks and direct deposit advices

Sage DacEasy supports both dot matrix and laser checks. To order checks 
or envelopes, contact the Sage DacEasy Forms division at (800) 222-0505. 
Sage DacEasy also prints direct deposit advices on plain paper. For more 
info, refer to “Printing Payment Forms” on page 85.

 Print the Check Register

Print the Check Register report to retain a copy of your employee 
payments. To do this, choose Check Register on the Process menu. For 
more info on printing the Check Register, refer to “Printing the Check 
Register” on page 90.

 Print the Department report

The Department report is useful to managers who want to monitor the 
cost of labor in their department. This report is only available prior to 
posting the payroll. Print your Department report by choosing 
Department Report on the Process menu. For more info on printing the 
Department report, refer to “Printing the Department Report” on page 91.
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 Create and transmit your direct deposit information

Creating and transmitting your direct deposit information is optional. You 
only need to perform this step if you decide to use the Direct Deposit 
feature. Access the Direct Deposit dialog box by choosing Direct Deposit 
on the Process menu. For more info on creating and transmitting direct 
deposit information, refer to the section titled “Creating the Direct 
Deposit File” on page 93.

 Backup your data files

It is important that you back up your payroll data files prior to posting. If 
you are running Sage DacEasy Payroll interfaced with Sage DacEasy 
Accounting, you also want to make a backup of your accounting data files. 
If you encounter an error during the Posting routine, the first step in fixing 
the problem is restoring the backup. Make a backup of your data files by 
choosing Backup/Restore on the File menu. For more info on making a 
backup, refer to “Creating and Restoring a Backup” on page 19.

 Post your payroll transaction

Posting your payroll transaction updates your data files in Payroll, it also 
updates your accounting data files if you are interfacing the two programs. 
Complete the Posting routine before entering a new payroll. To post your 
payroll transaction, choose Posting on the Process menu. For more info on 
posting a payroll, refer to “Posting Payroll Transactions” on page 97.

 Process and record any necessary tax deposits

Sage DacEasy automatically tracks your tax liabilities and deposits for you. 
Depending on how much your company is withholding each payroll, you 
may need to process and record your state or local tax deposits. Use the Tax 
Deposit option to print checks for your various tax liabilities. 

To process and record your tax deposits, point to Tax Deposit on the 
Process menu, and then choose the appropriate tax deposit. For more info 
on processing and recording tax deposits, refer to “Making 940 Tax 
Deposits” on page 105, “Making 941 Tax Deposits” on page 107, “Making 
State Tax Deposits” on page 108 and “Making Local Tax Deposits” on page 
110.



Periodic Routines Checklist
Monthly Routine Checklist

29

3
Periodic Routines Checklist

Periodic routines refer to activities you perform occasionally, such as once a 
month, quarter or year. 

Monthly Routine Checklist

Use the Monthly Routine checklist to accustom yourself with the month end 
process.

 Process and record any necessary tax deposits

Sage DacEasy automatically tracks your tax liabilities and deposits for you. 
Depending on how much your company is withholding each payroll, you 
may need to process and record your state or local tax deposits before 
running the Month End routine. Use the Tax Deposit option to print 
checks for your various tax liabilities. 

To process and record your tax deposits, point to Tax Deposit on the 
Process menu, and then choose the appropriate tax deposit. For more info 
on processing and recording tax deposits, refer to “Making 940 Tax 
Deposits” on page 105, “Making 941 Tax Deposits” on page 107, “Making 
State Tax Deposits” on page 108 and “Making Local Tax Deposits” on page 
110.

 Reconcile the check register

Reconcile your check register using the Reconcile Checks routine. This 
routine allows you to track checks that are void, have cleared the bank or 
are still outstanding. To access the Reconciliation routine, point to 
Reconciliation on the Periodic menu, and then choose Reconcile Checks. 
For more info on reconciling the check register, refer to “Reconciling 
Checks” on page 132.

 Print any custom reports pulling monthly information

If you have created any custom reports pulling monthly accumulations, 
print the reports before running the Month End routine. The Month End 
routine clears monthly accumulations and the custom reports will not give 
you accurate information if you print them after you run the Month End 
routine. For more info on custom reports, refer to Chapter 8, “Custom 
Reporting.".
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 Purge checks from the check register

If you are running low on disk space, you can purge checks. It is 
recommended that you purge at the end of the year if you must purge data. 
To purge checks from your data files, point to Reconciliation on the 
Periodic menu, and then choose Purge Checks. Be sure to make a backup 
of your data before purging information. For more info on purging checks, 
refer to “Purging Checks” on page 134.

 Close the month

Closing the month clears the monthly accumulations on the Edit 
Employee Accumulations dialog box. After the monthly accumulation 
fields are cleared, they are ready to receive accumulations for the next 
month. Run the Month End routine prior to posting the first payroll of 
each month. To close the month, choose Month End on the Periodic 
menu. For more info on running the Close Month routine, refer to 
“Closing the Month” on page 135.

Quarterly Routine Checklist

Use the Quarterly Routine checklist to accustom yourself with the quarter end 
process.

 Process and record any necessary tax deposits

Sage DacEasy automatically tracks your tax liabilities and deposits for you. 
Depending on how much your company is withholding each payroll, you 
may need to process and record your 941, state or local tax deposits before 
you run the Close Quarter routine. Use the Tax Deposit option to print 
checks for your various tax liabilities. 

To process and record your tax deposits, point to Tax Deposit on the 
Process menu, and then choose the appropriate tax deposit. For more info 
on processing and recording tax deposits, refer to “Making 940 Tax 
Deposits” on page 105, “Making 941 Tax Deposits” on page 107, “Making 
State Tax Deposits” on page 108 and “Making Local Tax Deposits” on page 
110.

 Print any custom reports pulling quarterly information

If you have created any custom reports pulling quarterly accumulations, 
print the reports before running the Close Quarter routine. The Close 
Quarter routine clears quarterly accumulations and the custom reports 
will not give you accurate information if you print them after you run the 
Close Quarter routine. For more info on custom reports, refer to Chapter 
8, “Custom Reporting."
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 Print the State Quarterly report 

Print the State Quarterly report after posting the last payroll for the 
quarter. To print a State Quarterly report, point to Quarter End on the 
Periodic menu, and then choose State Quarterly Report. For more info on 
printing the State Quarterly report, refer to “Printing State Quarterly 
Reports” on page 135.

 Print the State Quarterly worksheet

Print the State Quarterly worksheet after posting the last payroll. To print a 
State Quarterly worksheet, point to Quarter End on the Periodic menu, 
and then choose State Qtrly Worksheet. For more info on printing the 
State Quarterly worksheet, refer to “Printing State Quarterly Worksheets” 
on page 136.

 Print the 941

Print the 941 form before closing the quarter. This form must be 
submitted to the IRS at the end of every quarter. To print the 941 form, 
point to Quarter End on the Periodic menu, and then choose Form 941. 
For more info on printing the Form 941, refer to “Printing the 941” on 
page 137.

 Print the Schedule B

Use the Schedule B to print a report of your tax liability on a daily basis. To 
print the Schedule B, point to Quarter End on the Periodic menu, and 
then choose Schedule B. For more info on printing the Schedule B, refer to 
“Printing the Schedule B” on page 138.

 Print the Transaction History and Codes History reports

All payroll history information is recorded in detail format to a set of 
Payroll History files. You can view the information in these files using the 
Transaction History and Codes History reports. Since you can purge the 
payroll history files using the Close Quarter routine, you should print and 
archive hard copies of these reports for the quarter before purging the 
information. For more info on printing these reports, refer to “Printing the 
Transaction History Report” on page 123 and “Printing the Codes History 
Report” on page 124.
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 Close the quarter

Closing the quarter clears the quarterly accumulations on the Edit 
Employee Accumulations dialog box. You have the option to purge the 
Payroll History files during this routine. If you select to purge the history, 
be sure to print the Transaction History, Codes History and Detail reports. 
After the quarterly accumulation fields are cleared, they are ready to 
receive accumulations for the next quarter. Run the Close Quarter routine 
prior to posting the first payroll of each quarter. 

To close the quarter, point to Quarter End on the Periodic menu, and then 
choose Close Quarter. Be sure to make a backup of your data before 
closing the quarter because you cannot access a previous quarter once the 
quarter is closed. You also want to make a backup if you need to retrieve 
any quarterly accumulations especially if you select to purge history during 
the Close Quarter routine. For more info on running the Close Quarter 
routine, refer to the section titled “Closing the Quarter” on page 139.

Yearly Routine Checklist

Use the Yearly Routine checklist to accustom yourself with the year end process.

 Process and record any necessary tax deposits

Sage DacEasy automatically tracks your tax liabilities and deposits for you. 
Depending on how much your company is withholding each payroll, you 
may need to process and record your 940, 941, state or local tax deposits 
before you run the Close Year routine. Use the Tax Deposit option to print 
checks for your various tax liabilities. 

To process and record your tax deposits, point to Tax Deposit on the 
Process menu, and then choose the appropriate tax deposit. For more info 
on processing and recording tax deposits, refer to “Making 940 Tax 
Deposits” on page 105, “Making 941 Tax Deposits” on page 107, “Making 
State Tax Deposits” on page 108 and “Making Local Tax Deposits” on page 
110.

 Print any custom reports pulling yearly information

If you have created any custom reports pulling yearly accumulations, print 
the reports before running the Close Year routine. The Close Year routine 
clears yearly accumulations and the custom reports will not give you 
accurate information if you print them after you run the Close Year 
routine. For more info on custom reports, refer to Chapter 8, “Custom 
Reporting."
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 Print the W-2s

Print W-2s before you close the year. To print W-2s, point to Year End on 
the Periodic menu, and then choose W2 Forms. For more info on printing 
W-2s, refer to “Printing W-2s” on page 141.

 Print the W-3

The W-3 form is a summary of the information printed on the W-2 forms. 
You have the option to print the W-3 form automatically after you print 
the W-2 forms. To print just the W-3 form, point to Year End on the 
Periodic menu, and then choose W3 Forms. For more info on printing the 
W-3 form, refer to “Printing the W-3” on page 142.

 Create the W-2 Magnetic Media file

If your company employs more than 250 employees, the federal 
government requires you to file W-2 forms in a Magnetic Media file. You 
must register with the Social Security Administration before you can 
submit a Magnetic Media file. Sage DacEasy Payroll prints W-2 forms to a 
file that meets the Magnetic Media file requirement set by the Social 
Security Administration. Sage DacEasy also includes your state records in 
the Magnetic Media file. If you are required to file magnetically with your 
state and this form is accepted, you can use the same file. 

To create a Magnetic Media file, point to Year End on the Periodic menu, 
and then choose W2 Magnetic Media. For more info on creating the W-2 
Magnetic Media file, refer to “Creating Magnetic Media Files” on page 144.

 Print the 1099s and 1096s

Print 1099s before you close the year. The IRS requires 1099 forms for 
contract labor employees. To print 1099s, point to Year End on the 
Periodic menu, and choose Federal 1099. For more info on printing 1099s, 
refer to “Printing 1099s and 1096s” on page 143.

 Print the 940

Print the 940 form. You can print the actual form or a worksheet to assist 
you in filling out your annual federal unemployment (FUTA) tax return. 
To print the 940, point to Year End on the Periodic menu, and then choose 
940. For more info on printing the 940, refer to “Printing the 940” on page 
140.
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 Print the Transaction History and Codes History reports

All payroll history information is recorded in detail format to a set of 
Payroll History files. You can view the information in these files using the 
Transaction History and Codes History reports. Since you can purge the 
payroll history files using the Close Year routine, you should print and 
archive hard copies of these reports for the quarter or year before purging 
the information. For more info on printing these reports, refer to “Printing 
the Transaction History Report” on page 123 and “Printing the Codes 
History Report” on page 124.

 Close the year

Closing the year clears the yearly accumulations on the Edit Employee 
Accumulations dialog box. You also have the option of purging the Payroll 
History files during this routine. If you select to purge the history, be sure 
to print the Transaction History, Codes History and Detail reports. After 
the yearly accumulation fields are cleared, they are ready to receive 
accumulations for the next year. You can still post a payroll in the next year 
without running the Close Year routine. The payroll transaction 
accumulations for the next year are held in the Next Quarter field until you 
run the Close Year routine. Run the Close Year routine prior to posting the 
first payroll in the second quarter of the new year. 

To close the year, point to Year End on the Periodic menu, and then choose 
Close Year. Be sure to make a backup of your data before closing the year 
because you cannot access a previous year once the year is closed. You also 
want to make a backup if you need to retrieve any yearly accumulations 
especially if you select to purge history during the Close Year routine. For 
more info on running the Close Year routine, refer to “Closing the Year” on 
page 145.
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• Setting Up •
This chapter helps you get started using the program by setting up all the 
necessary information. The first section explains what default information you 
need to set up and the steps on how to do it. The next sections explain items you 
need to set up before processing your first payroll. These items include codes, 
departments, tax tables and employees.

Setting Up Default Information
Before you start using the program, you need to tell Sage DacEasy how to 
perform certain operations. This information is referred to as “setting your 
defaults.” You enter default information one time and Sage DacEasy uses this 
information every time it performs an operation. For example, one default you 
enter pertains to how vacation time is accrued. You select the method you want 
to use and Sage DacEasy uses this method to accrue vacation time for every 
employee, each time a payroll is processed.

Setting Up System Preferences

Information on the System Preferences dialog box indicates how you want to 
accumulate information and process payroll transactions. The information you 
enter on this dialog box controls many different routines throughout Sage 
DacEasy Payroll. These settings include how you want to use direct deposit, 
whether or not you want to interface Sage DacEasy Payroll with Sage DacEasy 
Accounting and if you want to reconcile with Sage DacEasy Accounting.

To Set System Preferences

You can customize how Sage DacEasy displays, prints or processes data. Select 
your preferences on the System Preferences dialog box. 
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1 Select Defaults from the Edit menu, and then select Preferences. The 

System Preferences dialog box appears.

2 Select your preferences for each option on the Posting tab.

3 Click the Calculations Settings tab and make your selections for each 
option.

4 Click the Renew Settings tab and make your selections for each option.

5 Click the Payment Settings tab and make your selections for each option.

6 Click the Labels tab to label the employee custom fields. You can click Help 
from the System Preferences dialog box for a detailed description of each 
field. 

7 Click OK to save your preferences.

Interfacing Sage DacEasy Payroll with Sage DacEasy Accounting

Because you can interface Sage DacEasy Payroll with Sage DacEasy Accounting, 
a special section is dedicated to explaining how to set up the interface between 
the two programs and what files are affected in Sage DacEasy Payroll when 
interfacing with Sage DacEasy Accounting. 

After you install and set up your accounting company in Sage DacEasy 
Accounting, you can easily set up an interface between the two programs. Enter 
and store the path to the accounting data files in the System Preferences dialog 
box in Sage DacEasy Payroll. If you have been using Sage DacEasy Payroll as a 
stand alone program and you want to begin interfacing it with Sage DacEasy 
Accounting, contact Sage DacEasy Customer Support Services for help 
completing this process.

Use the System
Preferences dialog box to

indicate how you want
Sage DacEasy to perform

specific functions.
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Tip: If you are using the Sage DacEasy Business Center, you can set up the 
interface automatically when you add both the Sage DacEasy Accounting and 
Sage DacEasy Payroll module to the company profile.

When you interface Sage DacEasy Payroll with Sage DacEasy Accounting, your 
payroll transactions are recorded in Sage DacEasy Accounting when you post. 
This means you do not need to make a separate entry in Sage DacEasy 
Accounting to record your payroll transactions. 

To Set Up the Interface Between Sage DacEasy Accounting and 
Sage DacEasy Payroll

1 Access Sage DacEasy Accounting and choose Open on the File menu. The 
Open Company dialog box appears. Each company set up in Sage DacEasy 
Accounting appears with the corresponding path to their data files. Select the 
company you want to interface with Sage DacEasy Payroll and write down the 
path to the accounting data files.

2 Access Sage DacEasy Payroll and open the company you want to interface 
with Sage DacEasy Accounting. Point to Defaults on the Edit menu, and 
then select Preferences. The System Preferences dialog box appears.

3 Select the Interface with Sage DacEasy Accounting check box and type 
the path to the accounting data files in the Sage DacEasy Accounting Path 
field. If you are not sure of the path, click the Browse button to locate the 
data files.

4 Click OK to save the change and exit the dialog box.

Setting Up Job Tracking

Job tracking allows you to create job templates for employees in Sage DacEasy 
Payroll. You can then select a job template when entering transactions and 
running pay calculations. If you interface Sage DacEasy Payroll with Sage 
DacEasy Accounting, you can select job ID codes you entered in Sage DacEasy 
Accounting when creating job templates. Use the job tracking feature in Sage 
DacEasy Payroll with or without interfacing with Sage DacEasy Accounting. 
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To enable job tracking

1 Select Edit > Defaults > Preferences to open the Posting page of the 
System Preferences dialog box.

2 Mark Use Job Tracking. If you interface Sage DacEasy Payroll with Sage 
DacEasy Accounting, this option is read-only. It is automatically marked (or 
unmarked) according to your selection (on the General page of the System 
Preferences dialog box) in Sage DacEasy Accounting. You must unmark 
Interface with Sage DacEasy Accounting if you want to use job tracking 
only in Sage DacEasy Payroll.

Note: Sage DacEasy Payroll displays the Job ID field on the Transaction 
Entry dialog box if you mark Use Job Tracking or hides it if you unmark 
Use Job Tracking.

3 Click OK to accept and to close the System Preferences dialog box.

4 Select Process > Job Assignments to open the Assign Jobs to Employees 
dialog box, where you can create job templates.

Files Shared with Sage DacEasy Accounting

Some files are shared when Sage DacEasy Payroll is interfaced with Sage DacEasy 
Accounting. These files are the link between the two programs and 
automatically update Sage DacEasy Accounting with transactions from Sage 
DacEasy Payroll. The Update General Ledger Online and Update Check Register 
Online features in Sage DacEasy Accounting do not include the payroll 
transactions. Sage DacEasy Payroll only updates the following files during the 
Posting routine.

• Accounts—Sage DacEasy Payroll uses this file when you specify default 
account numbers. The accounts used for liabilities, taxes, etc. must 
match the accounts that exist in Sage DacEasy Accounting. When you 
post a payroll transaction, the dollar amounts are distributed to the 
specified accounts in Sage DacEasy Accounting and increase or 
decrease the account balance accordingly.

• General Ledger files—Sage DacEasy Payroll updates the General 
Ledger module in Sage DacEasy Accounting with a summary 
transaction each time you post payroll. The transaction created by Sage 
DacEasy Payroll affects the specified accounts. The entry is recorded in 
the General Ledger module showing how each account was affected.

• Check Register—If you selected to reconcile the Check Register with 
Sage DacEasy Accounting on the System Preferences dialog box, the 
Sage DacEasy Accounting Check Register file is updated with the 
payroll checks when you post in Sage DacEasy Payroll.
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Furniture Factory Example

Martin Malone needs to set up his defaults before starting his first payroll. These 
defaults include setting up the company information, security passwords, the 
application printer and the system preferences. While setting up the system 
preferences, he wants to interface Sage DacEasy Payroll with Sage DacEasy 
Accounting so he does not have to manually enter the payroll transaction into 
the Sage DacEasy Accounting General Ledger and he can reconcile his payroll 
checks in Sage DacEasy Accounting. 

To set up the interface, Martin selects the Interface with Sage DacEasy 
Accounting and Reconcile with Sage DacEasy Accounting check boxes on the 
System Preferences dialog box. Because he selected to interface with Sage 
DacEasy Accounting, Martin is required to enter the path to his accounting data 
files. When he selected the Reconcile with Sage DacEasy Accounting check box, 
the Erase Check Register after Posting check box is automatically selected. 

Now that he has set up the preferences, the next time Martin posts his payroll 
transaction, Sage DacEasy Payroll automatically updates the General Ledger 
module in Sage DacEasy Accounting with the appropriate payroll entry and also 
updates the Check Register in Sage DacEasy Accounting to include the payroll 
checks.

Setting Up Company Information

The Edit Company dialog box lets you enter important information about your 
company. Use this dialog box to identify the company name and address as well 
as the structure of your working year. The company name and address entered 
here print at the top of reports. 
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To Set Up Company Information

1 Choose Company on the Edit menu. The Edit Company dialog box 
appears.

2 Type your company name, address, phone number and fax number in the 
appropriate fields.

Tip: Click Help from the Edit Company dialog box for a detailed description 
of each field.

3 Complete the remaining fields. These areas hold the number of days in the 
prenote period, the structure of your working year and your current month, 
quarter and year.

Note: You cannot edit the current month, quarter or year fields after you post 
your first payroll.

4 4.Click Options, and then choose Direct Deposit. The Company Direct 
Deposit Accounts dialog box appears. If you are using the direct deposit 
feature, use this dialog box to enter the company’s direct deposit account 
information. The direct deposit account information needed depends on the 
Direct Deposit type selected in the System Preferences dialog box. Click OK 
to save the direct deposit information and return to the Edit Company dialog 
box.

You can click Help from the Company Direct Deposit Accounts dialog box 
for a detailed description of each field.

5 Click OK to save your changes and exit the Edit Company dialog box.

Use the Edit Company
dialog box to enter the

company name and
address as well as the

structure of your working
year.
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Editing Standard Earning Code Descriptions

Sage DacEasy Payroll allows you to edit the standard earning code descriptions 
that display on the Earnings page of the Edit Codes dialog box. This allows you 
to customize the descriptions to suit your business needs. The descriptions you 
enter display throughout Sage DacEasy Payroll in areas such as reports, pay 
checks, and direct deposit advices.

To edit standard earning code descriptions

1 Select Edit > Defaults > Standard Earning Code Descriptions to open the 
Standard Earning Code Descriptions dialog box.

2 Edit the default name or enter a new name for each standard earning code.

3 Click OK to save your changes and to close the Standard Earning Code 
Descriptions dialog box.

Setting Up Security

One of the most important issues when using a computerized payroll system is 
the safety and security of your data. If one or more operators enter data or print 
reports, you may want to restrict access to certain routines or information.

Sage DacEasy includes a six-level password protection system. This system 
allows you to assign separate password values for different sections of the 
program. To use the password system, you must fill in all five password levels 
and the controller password. An error message appears if you try to save the Edit 
Passwords dialog box without completing all six fields. Make sure you assign a 
unique password to each level.
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Assign the operators their password. Since there is only one password for each 
level, it is important operators not disclose their password to anyone else.

To Set Up Passwords

1 Point to Defaults on the Edit menu, and then choose Passwords. The Edit 
Passwords dialog box appears.

2 Type unique passwords for each level and the controller. Keep these 
passwords in a secure place where you have full control over who knows the 
passwords.

You can click Help from the Edit Passwords dialog box for a detailed 
description of each field and a list of functions available for each level.

3 Click OK to save the passwords. 

4 Click Close to exit the Edit Passwords dialog box. 

Setting Up the Printer

Before you print any reports, you should set up your default application printer 
in Sage DacEasy Payroll. It is important that you indicate the type of printer you 
are using so the program can correctly print information. 

Use the Edit Passwords
dialog box to restrict

access to certain areas of
Sage DacEasy.
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To Set Up the Printer

Sage DacEasy uses the default printer settings unless you edit the report layout. 
For more information on customizing the report layout, refer to “Viewing Your 
Data” in Chapter 4, “Working With Sage DacEasy” in the Getting Started Guide.

1 Select Defaults from the Edit menu, and then select Printers. The Edit 
Default Printer dialog box appears.

You can click Help for a detailed description of each option. Also, click 
Restore Default to restore the default printer settings.

2 Select the printer in the Name box on the Printer tab. 

Note: The printers that appear in the Name list are based on the printers you 
have installed on your local Windows system. For more information on 
installing a printer on your system, refer to your Microsoft® Windows® 
operating system documentation.

3 Select your font preferences for each section of the report. Click the Fonts 
tab, select a section, and then select your preferences for the section. Repeat 
this process for each section of the report.

4 Click the Page tab. Select your preferences for the page setup. 

Note: The Width and Height boxes only apply when you select a custom 
paper size. 

5 Click OK to save your printer settings. 

Tip: Click Apply to All to update the report layouts for each report with the 
printer settings set on this dialog box.

Setting Up Tax Table Information
Sage DacEasy Payroll allows you to set up tables for federal, state and local taxes. 
After setting up these tables, you need to assign the appropriate tax code to the 
employees. Sage DacEasy Payroll retrieves and processes the tax table 
information when necessary.
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Setting Up Federal Tax Tables

Federal law requires employers and employees to pay taxes based on their 
earnings to support the government. The Federal Insurance Contributions Act 
(FICA) requires most employers and employees to pay taxes to finance two 
social programs: Old Age, Survivors, and Disability Insurance (OASDI, more 
commonly known as Social Security) and Medicare. The amount of Social 
Security tax withheld is based on a percentage of an individual’s earnings with a 
set dollar amount limit for the year. The same applies for Medicare tax, except 
there is no set dollar amount limit.

FICA (Federal Insurance Contributions Act)

Social Security is the biggest program funded by FICA. It provides pensions to 
retired persons 62 years or older, payments to disabled persons and benefits to 
dependents of insured workers who have died or become disabled. Medicare is 
another program funded by FICA. It is a health insurance program for persons 
disabled and 65 years or older. 

FUTA (Federal Unemployment Tax Act)

Employers must pay taxes to the federal government to fund services and 
benefits for temporarily unemployed workers. The employer pays these taxes 
even though they are based on employee earnings. The Federal Unemployment 
Tax Act (FUTA) requires employers to pay a tax to help support government 
run employment offices across the country. The FUTA tax rate and limit vary 
depending on the nature of your company. Check with the IRS to determine 
what your FUTA rate and limit are before you start processing payrolls.

A company’s SUI (State Unemployment Insurance) rate is credited against its 
FUTA rate, reducing the amount of FUTA paid. For example, if a company has 
a SUI rate of 3.5%, its FUTA rate would be 2.7 (6.2%—the maximum FUTA 
percent—minus 3.5% of SUI). Sage DacEasy defaults to the minimum FUTA 
rate, which is 0.8%.

Federal Withholding

The Current Tax Payment Act of 1943 and the 1986 Tax Reform Act require 
employers to subtract estimated taxes from employees’ taxable earnings and pay 
this amount to the IRS. These estimated income taxes are called withholdings. 
Taxable earnings for income tax purposes are gross earnings including:

• bonuses

• commissions

• cash advances
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• other payments such as the cash value of meals and lodgings when 

provided for the convenience of the employee

An employee’s taxable earnings are affected by marital status and withholding 
allowances. A withholding allowance, or personal exemption, is the amount of 
money by which someone can reduce the amount of earnings subject to income 
tax. Everyone is allowed one allowance plus an additional allowance for each 
dependent.

Employees indicate how many exemptions they claim by filling out a W-4 
Federal Form when they are hired. Federal law requires employers have a W-4 
on file for every employee. Federal income withholdings differ for married and 
single employees; the tax rate for a single person is higher than that for married 
people.

In addition, employees who had no federal income tax liability the past year and 
expect no liability in the current year can claim a no-tax liability exemption 
when filling out the W-4. Employers must not withhold federal income taxes 
from these employees.

To Set Up a Federal Tax Table

1 Choose Federal Tax from the Edit menu. The Edit Federal Tax Table dialog 
box appears.

2 Type the tax table number in the Table field. The description appears in the 
appropriate field. If you are not sure of the tax table number, click LookUp to 
view a list of federal tax tables.

You can click Help from the Edit Federal Tax Table dialog box for a detailed 
description of each field.

3 Type your Federal ID along with the rate and limits for Supplemental Earnings, 
Social Security, Medicare and FUTA.

Use the Edit Federal Tax
Table dialog box to set up

your federal taxes.
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4 Update any necessary allowances, credits or exemptions in the Allowances/

Credits/Exemptions area. The information in this area is already set up. You 
should only modify this information when tax legislation changes.

5 Click the Tax Brackets tab. Update any necessary tax bracket information. 
The information on this tab is already set up. You should only modify this 
information when tax legislation changes.

6 Click the Pretax Settings tab. Use the Pretax Settings tab to select when 
you want the tax to calculate. Select Before to calculate the tax before the 
plan is deducted from the employee’s wages. Select After to calculate the tax 
after the plan is deducted from the employee’s wages. 

Note: The Pretax Settings tab is only available for federal tax tables 01 and 
02.

7 Click OK to save your changes. 

8 Click Close to exit the dialog box.

Behind the Scenes With Federal Taxes

You can make changes to the federal tax tables yourself. To make sure you do 
this correctly, use the tax information outlined in the IRS Publication 15, 
Circular E, Employer’s Tax Guide (commonly referred to as the Circular E), and 
the IRS Publication 15-A, Employer’s Supplemental Tax Guide. Figures listed in 
the Circular E are in decimal format but Sage DacEasy Payroll requires 
percentages. Before entering the information into Sage DacEasy Payroll, you 
need to convert each decimal figure to a percentage.
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Sage DacEasy Payroll calculates the amount of federal withholding 
automatically, based on the percentages you enter on the Edit Federal Tax Table 
dialog box. The amount to actually withhold from each employee’s earnings is 
determined by dividing the number of pay periods in a year by the annual 
withholding figure. The following steps give a more detailed description of the 
method Sage DacEasy Payroll uses to calculate the amount of federal income tax 
to withhold from earnings.

1 The employee’s annual federal taxable earnings are calculated as follows: the 
employee’s federal taxable earnings (for one pay period) are multiplied by the 
number of pay periods in a year. The number of pay periods is determined by 
the employee’s pay frequency.

2 The number of federal allowances (exemptions) is multiplied by the standard 
deduction amount.

3 The amount calculated in step 2 is subtracted from the employee’s annual 
federal taxable earnings (step 1) to determine the amount of annual earnings 
that are taxable.

4 To determine the annual amount withheld for federal income tax, use Table 7 
in the IRS Publication 15, Circular E, and prorate the amount for one year. You 
do this by (1) identifying the amount to withhold for federal income tax in 
Table 7 and (2) dividing the amount by the number of pay periods in a year.

Setting Up State Tax Tables

State law requires employers and employees to pay taxes based on their earnings 
to support the state government. Many states also have income taxes. This 
section explains some of these state taxes.

SUI (State Unemployment Insurance)

The State Unemployment Insurance tax (SUI, also known as State 
Unemployment Tax Acts, or SUTA) requires employers to pay a tax to the state 
government to fund services and provide benefits for qualified unemployed 
workers. The employer pays these taxes but the amount paid is based on 
employee earnings for the year (in some states, employees also pay the tax.). The 
SUI tax rate and limit are based on each individual company (the nature of 
business and unemployment history) and the limit varies from state to state. 
Check with your state’s revenue department to determine what your SUI rate 
and limit are before you start processing payrolls.
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SDI (State Disability Insurance)

Many states require businesses to provide insurance for their employees who 
become sick or have a non-work related accident. State Disability Insurance 
(SDI) can be based on a percentage of gross wages with a maximum amount per 
year or per week. For example, Hawaii and New York base a percentage of gross 
wages with a maximum amount per week. In addition to these two states, SDI 
also applies to California, Rhode Island and Puerto Rico.

Related Help Topics

• Setting up Colorado’s Occupational Privilege Tax

• Setting up Massachusetts’ Health Insurance Contribution

• Setting up New Jersey’s Health Care/Work Force Split

• Setting up Oregon’s County Tax

To Set Up a State Tax Table

1 Choose State Tax from the Edit menu. The Edit State Tax Table dialog box 
appears.

2 Type the tax table number in the Table field. The description and two letter 
state identification appears in the appropriate fields. If you are not sure of the 
tax table number, click LookUp to view a list of state tax tables.

You can click Help from the Edit State Tax Table dialog box for a detailed 
description of each field.
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3 Type your State ID along with the rate and limits for Supplemental Earnings, 

SUI Employer and Employee and SDI Employer and Employee. It is important 
you enter the correct SUI and SDI percentages and limits for both the 
employer and employee. Check with your state government agency for the 
correct percentages and limits.

4 Update any necessary allowances, credits or exemptions. The information in 
this area is already set up. You should only modify this information when tax 
legislation changes. 

5 Click the Tax Brackets tab. Update any necessary tax bracket information. 
The information on this tab is already set up. You should only modify this 
information when tax legislation changes. 

6 Click Options, and then choose Special Tax. The dialog box that appears 
depends on the state tax table you are editing. Enter the appropriate 
information, and then click OK to save the special tax settings.

You can only choose Special Tax from the Options menu for the following 
states, Colorado, Massachusetts, New Jersey and Oregon.

7 Click the Pretax Settings tab. Use the Pretax Settings tab to select when 
you want the tax to calculate. Select Before to calculate the tax before the 
plan is deducted from the employee’s wages. Select After to calculate the tax 
after the plan is deducted from the employee’s wages. Select Taxable for 
Group Term Life and Third Party Sick Pay if these plans are taxable. Select 
Nontaxable if the plans are not taxable.

8 Click OK to save your changes. 

9 Click Close to exit the dialog box.



Setting Up Tax Table Information
Setting Up Local Tax Tables

51

4
Setting Up Local Tax Tables

You can set up an unlimited number of local tables with this feature and you 
have the ability to assign up to four local tables to each employee.

If you have a local withholding that is a flat amount or a percentage calculation 
based on gross earnings, federal or state withholding, use the Edit Local Tax 
Table dialog box to set up the local withholdings. If your city, county or school 
district does not have any withholding taxes, you do not need to set up any local 
tax tables. 

To Set Up a Local Tax Table

1 Choose Local Tax from the Edit menu. The Edit Local Tax Table dialog box 
appears.

2 Type a unique tax table number and description for the local tax.

Note: Local tax table numbers 1-999 are not available when setting up a new 
local tax table. These numbers are reserved for use by the Sage DacEasy 
Payroll program.

3 Type your State Code, Local EIN and W2 Description along with the 
calculation settings for this local tax table.

You can click Help from the Edit Local Tax Table dialog box for a detailed 
description of each field.

4 Click the Pretax Settings tab. Use the Pretax Settings tab to select when 
you want the tax to calculate. Select Before to calculate the tax before the 
plan is deducted from the employee’s wages. Select After to calculate the tax 
after the plan is deducted from the employee’s wages. Select Taxable for 
Group Term Life or Third Party Sick Pay if the plan is taxable. Select 
Nontaxable if the plan is not taxable. 
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5 Click OK to save your changes. 

6 Click Close to exit the dialog box.

Furniture Factory Example

Martin checks his federal, state and local tax tables to make sure Sage DacEasy 
calculates taxes on his 401k plan according to government requirements. To do 
this, Martin must check the pretax settings for the federal, state and local tax 
tables. 

First, he checks the Pretax Settings tab on the Edit Federal Tax Table dialog box. 
He makes sure the 401k plan is set to calculate federal withholdings after Sage 
DacEasy takes out the deduction and that Social Security, Medicare and FUTA 
are set to calculate before Sage DacEasy takes out the deduction. 

Next, he checks the Pretax Settings tab on the Edit State Tax Table dialog box, 
Martin sets the state withholdings to calculate after the 401k deduction and 
SUTA and SDIF to calculate before the 401k deduction. 

Finally, he checks the Pretax Settings tab on the Edit Local Tax Table dialog box 
and sets the local withholdings to calculate after taking out the 401k deduction.

Setting Up Code Information
Codes are items that affect the amount of an employee’s payroll check. Codes in 
Sage DacEasy Payroll also hold the account numbers for each company expense 
related to a payroll transaction. View codes by choosing Codes on the Edit 
menu.
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Codes are divided into three categories, earnings, deductions and liabilities. 
Each category represents the affect this code has on the employee’s payroll check 
or the company’s account balances related to the payroll transaction. Earnings 
usually increase the amount of an employee’s paycheck. Deductions usually 
decrease the amount of an employee’s paycheck and liabilities are the amount 
the employer pays a third party, such as the government, based on the amount 
of the employee’s earnings.

Standard Codes

Standard codes represent those codes used by the majority of companies. For 
example, standard earning codes include salary, hourly and overtime. You 
cannot delete standard codes.

User Defined Codes

Codes you create are referred to as user defined codes. Since every company has 
unique payroll needs, it is possible that the standard codes included in the 
program do not accommodate every type of payroll situation you encounter.

For example, commissions are paid differently in each company. Since we 
cannot determine if a company needs such an earning, Sage DacEasy Payroll 
does not come with a standard earning for commissions. Instead, Sage DacEasy 
allows you to create a user defined earning code for commission and allows the 
company to define how to pay the commission. 

Related Help Topics

• Deleting user defined codes

• Adding accounts

Adding and Editing Codes

Use the Edit Code dialog box to set up your standard and user defined codes. To 
access this dialog box, choose Codes on the Edit menu. The Edit Code dialog 
box appears with the Liabilities tab open. There are three tabs on the Edit Codes 
dialog box, the Liabilities, Earnings and Deductions tabs. The standard codes 
are separated from the user defined codes on each tab. You can only edit the 
settings for a standard code, but you can add, edit and delete as many user 
defined codes as necessary.
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To Edit a Code

Follow these steps to make an edit to a standard or user defined code

1 Choose Codes on the Edit menu. The Edit Code dialog box appears.

2 Click the tab to view the appropriate information, if necessary.

3 Make the necessary changes to the code.

You can click Help from the Edit Code dialog box for a detailed description 
of each field.

4 Click OK to save the change and exit the dialog box.

Adding and Setting Up User Defined Liabilities

Codes 55-70 are preassigned standard liabilities in Sage DacEasy Payroll. In 
addition to these standard liabilities, you can create an unlimited number of 
user defined liabilities such as profit sharing plans and insurance. You can assign 
up to 12 user defined liabilities to each employee. 

When processing a payroll for your employees, you can enter liabilities 
manually using the Transaction Entry dialog box. You can also assign the codes 
to each employee using the Edit Department or the Edit Employee 
Accumulations dialog box, and then use the automatic Calculate Payroll 
routine. In either case, you should first set up all user defined codes on the Edit 
Code dialog box before assigning them to any department or employee.

To Add a User Defined Liability

1 Choose Codes on the Edit menu. The Edit Code dialog box appears.
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2 Select a blank line in the User Defined Liabilities area and type a unique code 

in the Code column.

You can click Help from the Edit Code dialog box for a detailed description 
of each field.

3 Type a description of the user defined liability you are creating in the 
Description column.

4 Type the expense account number in the Expense column. This account is 
debited when this code is used in a payroll transaction. If you are interfaced 
with Sage DacEasy Accounting, click LookUp to select an account from a list.

5 Type the liability account number in the Liability column. This account is 
credited when this code is used in a payroll transaction. If you are interfaced 
with Sage DacEasy Accounting, click LookUp to select an account from a list.

6 Click the Type column to view the liability type options available. This column 
displays the type of user defined code you are adding. Choose from the 
options listed. 

Note: If you select E Employer contribution in the Type column to add an 
Employer Contribution liability code, the Employer Contribution Type 
dialog box appears. Refer to the Help topic titled “Setting up employer 
contribution plans” for more information on setting up this type of code.

7 Type the fixed dollar amount or percentage used to calculate this liability for 
each employee in the Amount/Rate column. The amount or rate you type 
becomes the default on the Edit Department and Edit Employee 
Accumulations dialog boxes for each employee in the department. You can 
change the value on these dialog boxes later if necessary.

8 Type the annual limit amount when the company’s liability ceases to calculate 
in the Year Limit column. The liability ceases when the year-to-date liability or 
wage reaches this amount. If there is no limit, type 99999999.99.

9 Select the All Dept check box if you want to automatically assign this code to 
all new and existing departments.

10 Repeat steps 2-9 to add more user defined liability codes.

11 Click OK to save the codes and exit the dialog box.

Related Help Topics

• Setting up employer contribution plans

• Setting up cafeteria plans

• Setting up 401k plans

• Setting up simple IRA plans
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Adding and Setting Up User Defined Earnings

Codes 1 - 09 and 40 are preassigned standard earnings in Sage DacEasy Payroll. 
In addition to these standard earnings, you can create an unlimited number of 
user defined earnings such as bonuses, holiday pay and contract labor. You can 
assign up to 30 user defined earnings to each employee. When processing a 
payroll for your employees, you can enter earnings manually using the 
Transaction Entry dialog box, or apply the earning to a group of employees 
using the Blanket Entry routine. 

You can also assign the codes to each employee using the Edit Department or 
the Edit Employee Accumulations dialog box, and then use the automatic 
Calculate Payroll routine. In either case, you should first set up all user defined 
codes on the Edit Code dialog box before assigning them to any department or 
employee.

To Add a User Defined Earning

1 Choose Codes on the Edit menu. The Edit Code dialog box appears.

2 Click the Earnings tab and select a blank line in the User Defined Earnings 
area. Type a unique code in the Code column.

You can click Help from the Edit Code dialog box for a detailed description 
of each field.

3 Type a description of the user defined earning you are creating in the 
Description column.

4 Click the Federal column. Select whether the earning is taxable using the 
standard federal tax withholding tables, supplemental earning tax rates or not 
taxable at all.

5 Click the State column. Select whether the earning is taxable using the 
standard state tax withholding tables, supplemental earning tax rates or not 
taxable at all.

6 Click the Local column. Select whether the earning is taxable using the 
standard local tax withholding tables or not taxable at all.

7 Type the expense account number updated when this code is used. If you are 
running Sage DacEasy Payroll interfaced with Sage DacEasy Accounting, click 
LookUp to select an account from a list.

8 Click the Type column to view the earning type options available. This column 
displays the type of user defined code you are adding. Choose from the 
options listed. 
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9 Type the fixed dollar amount or percentage used to calculate this earning for 

each employee in the Amount/Rate column. The amount or rate you type 
becomes the default on the Edit Department and Edit Employee 
Accumulations dialog boxes for each employee in the department. However, 
you can change the value on these dialog boxes later if necessary.

10 Select the All Dept check box if you want to automatically assign this code to 
all new and existing departments.

11 Select the Disabled check box for the user defined earning codes you wish to 
disable, permanently or temporarily.  Any user defined code that is marked as 
disabled at the Department level is ignored in payroll calculations for the 
corresponding departments.  

12 Repeat steps 2-10 to add more user defined earning codes.

13 Click OK to save the codes and exit the dialog box.

Adding and Setting Up User Defined Deductions

Codes 20 - 32 are preassigned standard deductions in Sage DacEasy Payroll. In 
addition to these standard deductions, you can create an unlimited number of 
user defined deductions such as 401k plans, insurance and employee meals. You 
can assign up to 30 user defined deductions to each employee. When processing 
a payroll for your employees, you can enter deductions manually using the 
Transaction Entry dialog box, or apply the earning to a group of employees 
using the Blanket Entry routine. 

You can also assign the codes to each employee using the Edit Department or 
the Edit Employee Accumulations dialog box, and then use the automatic 
Calculate Payroll routine. In either case, you should first set up all user defined 
codes on the Edit Code dialog box before assigning them to any department or 
employee.

To Add a User Defined Deduction

1 Choose Codes on the Edit menu. The Edit Code dialog box appears.

2 Click the Deductions tab and select a blank line in the User Defined 
Deductions area. Type a unique code in the Code column.

You can click Help from the Edit Code dialog box for a detailed description 
of each field.

3 Type a description of the user defined deduction you are creating in the 
Description column.
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4 Type the account number updated when this code is used. This account is 

usually a liability account. If you are running Sage DacEasy Payroll interfaced 
with Sage DacEasy Accounting, click LookUp to select an account from a list.

5 Click the Type column to view the deduction type options available. This 
column displays the type of user defined code you are adding. Choose from 
the options listed. 

6 Type the fixed dollar amount or percentage used to calculate this deduction 
for each employee in the Amount/Rate column. The amount or rate you type 
becomes the default on the Edit Department and Edit Employee 
Accumulations dialog boxes for each employee in the department. However, 
you can change the value on these dialog boxes later if necessary.

7 Select the pretax status of the user defined deduction in the Pretax column. 
Pretax indicates whether the deduction is subtracted from an employee’s pay 
before or after calculating the withholding. Select the Pretax check box to 
subtract the deduction before calculating the withholding.

Note: If you select the Pretax check box, the Pretax Deductions dialog box 
appears. Complete the fields on the dialog box appropriately. Click Help from 
the Pretax Deductions dialog box for a detailed description of each field. 
The Maximum Contribution amount from the Pretax Deductions dialog box 
automatically appears in Year Limit column on the Deductions tab.

8 Type the annual limit where the deduction ceases to calculate in the Year Limit 
column. The deduction ceases to calculate when the year-to-date deduction 
reaches this amount. If there is no limit, type 0 or 99999999.99. 

9 Select the All Dept check box if you want to automatically assign this code to 
all new and existing departments.

10 Repeat steps 2-9 to add more user defined deduction codes.

11 Click OK to save the codes and exit the dialog box.

Related Help Topics

• Setting up a repayment deduction
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Setting Up Department Information

Departments represent logical groups of employees within a company. Each 
company groups its employees in different ways. Many companies use 
functional units to group their employees. A functional unit might be defined as 
administration, human resources, accounting, training and development. View 
departments by choosing Departments from the Edit menu.

If you want to keep track of the labor associated with specific groups of 
employees, you will want to set up all your departments and assign each 
employee to their home department. Then you can use the Department report 
to track expenses per department. If you choose not to group your employees 
into departments, you would set up a single department and assign all 
employees to one department.

When setting up departments, you can assign earnings, deductions and 
liabilities appropriate for the employee’s within the department. Using the All 
Employees check box on the Edit Department dialog box allows you to 
automatically assign the code to employees in the department. If you use this 
option, most of your employee’s earning, deduction and liability information is 
automatically set up for you when you assign the department to the employee. 
After entering your employees and assigning departments, you can use the 
Calculate Payroll routine to process your payroll transaction.

Assigning Account Numbers

If Sage DacEasy Payroll is interfaced with Sage DacEasy Accounting, you must 
assign certain account numbers to each department so the General Ledger in 
Sage DacEasy Accounting is updated when you post your payroll transaction in 
Sage DacEasy Payroll. As you assign an account number in each field, Sage 
DacEasy Payroll verifies the account is the appropriate account in Sage DacEasy 
Accounting. You can add the account on-the-fly if an account does not exist. 

If Sage DacEasy Payroll is not interfaced with Sage DacEasy Accounting, you 
need to assign account numbers to track the total dollar amount for salary 
expense, Social Security, Medicare, federal withholding and so forth. Sage 
DacEasy only uses earning, deduction and liability codes assigned account 
numbers. 
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Required Fields for Your Departments

 If you assigned account numbers to the earning, deduction or liability code on 
the Edit Code dialog box, these accounts are automatically assigned when you 
create a new department. If you want to use different accounts for a department 
you are setting up, you can change these accounts on the Edit Department 
dialog box. You are required to assign a detail reconcilable bank account in the 
Checking Account field for each department if you are interfacing with Sage 
DacEasy Accounting. If you are not interfaced, you are just required to enter an 
account number in the Checking Account field for each department.

You must enter account numbers in the following fields before you save a 
department:

• Checking account

• Social Security (liability and deduction accounts)

• Medicare (liability and deduction accounts)

• FUTA

• SUI (liability account)

• Federal withholding

Note: Predefined standard liability codes 60–70 apply to employers in New 
Jersey, Colorado, Oregon and Massachusetts. These account numbers are not 
required when adding a new department but if your company does business in 
one of these states, you should enter an account number for each specific field 
related to your state before saving the department. 

Related Help Topics

• Adding an existing code to a department

• Adding accounts

• Duplicating a department

• Deleting departments

Adding or Editing Departments

If you have already set up your codes on the Edit Code dialog box the account 
numbers assigned on the Edit Code dialog box automatically appear for those 
codes on the Edit Department dialog box. You do not have to use the default 
information entered when setting up the codes; you can change the information 
as needed for each department. 
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If you do not need to add any additional user defined codes, you can save the 
department and begin to add your employees. If you need to assign additional 
user defined codes to the department, it is easier to add them to the department 
before you begin assigning the department to your employees.

To Add or Edit a Department

1 Choose Department on the Edit menu. The Edit Department dialog box 
appears.

2 Type a unique code and name for the department if adding a new 
department or click LookUp to select an existing department from a list.

3 Type the account number of the payroll checking account for this department 
in the Checking Account field. This account is credited with the total net 
amount paid to all employees assigned this department in the payroll. If you 
are running Sage DacEasy Payroll interfaced with Sage DacEasy Accounting, 
you can click LookUp to select an account from a list.

4 Make any necessary changes to the standard code information for the new 
department.

5 Assign any necessary user defined codes to the new department. 

Note: Click Add from the Code column in the user defined area to add a new 
user defined code. After adding the user defined code, you can assign it to 
the department.

You can click Help from the Edit Department dialog box for a detailed 
description of each field.

6 Click OK to save the department information.

Use the Edit Department
dialog box to enter
information for the

department.
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7 Click Close to exit the dialog box.

Setting Up Employee Information
The Edit Employee Information and Edit Employee Accumulations dialog 
boxes are designed to help you maintain information about each employee. The 
Edit Employee Information dialog box contains information about the 
employee such as name, address, pay, vacation time, sick time and tax 
information. The Edit Employee Accumulations dialog box contains the 
employee’s accumulations for all earnings, deductions and liabilities. 

After you add an employee, you can begin making payroll entries for the 
employee. Sage DacEasy automatically updates monthly, quarterly and yearly 
accumulations when you post a payroll including the employee. 

Related Help Topics

• Adding employees with accumulations

• Viewing employee payroll transaction history

• State tax modifications 

• Setting up employees for direct deposit

• Setting up EIC employees

• Adding contract labor employees

• Deleting employees

• Entering employee’s third party sick pay accumulations

• Transferring employee information to new employees

• Integrating with Microsoft Word

• Attaching notes to employee records

• Changing the note file name

• Sending an e-mail

Adding or Editing Employees

The following steps explain how to add a new employee or edit information 
about an existing employee.
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Note: If this is the first time you have used Sage DacEasy Payroll and you have 
an existing company, you probably already have employees working for you that 
have earning, deduction and liability accumulations. When adding these 
employees to Sage DacEasy Payroll, enter the amount of the employee’s 
earnings, liabilities, deductions and payment totals for the year using the Edit 
Employee Accumulations dialog box.

To Add or Edit an Employee

Tracking your employee’s earnings, deductions and liabilities is the most 
important part of your payroll software. Sage DacEasy has an Edit Employee 
Information and an Edit Employee Accumulations dialog box that are easy-to-
use and simple to understand. These dialog boxes hold all the necessary 
information you need to know about your employee.

1 Choose Employee Information on the Edit menu. The Edit Employee 
Information dialog box appears.

2 Type a unique code for the new employee in the Code field or click LookUp 
to select an employee from a list. Enter or view the appropriate information 
on each tab.

3 Click Accumulations. The Edit Employee Accumulations dialog box 
appears. Use this dialog box to add or edit any user defined codes necessary 
for the employee. 

Note: You can assign up to 30 user defined earnings and deductions and 12 
user defined liabilities to each employee.

Note: If your employees have any existing accumulations; record them on the 
Edit Employee Accumulations dialog box. For more information on adding 
existing accumulations, refer to the Help topic titled “Adding employees with 
accumulations.”

Use the Edit Employee
Information dialog box to

set up the employee’s
code and enter

information identifying
this employee. This dialog

box is divided into seven
tabs: Main, Dates and Pay,
Vacation and Sick, Federal,

State, Local and Custom.
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4 Click OK to save any changes and return to the Edit Employee Information 

dialog box.

You can click Help from the Edit Employee Information dialog box for a 
detailed description of each field.

5 Click OK to save the new employee. 

6 Click Close to exit the dialog box.
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• Processing Payroll •
You are ready to process a payroll for your employees after you set your defaults, 
enter your tax tables and set up your codes, departments and employees. This 
chapter explains all the routines used to process and post a payroll transaction. 

When to Use the Transaction Entry dialog box
Use the Transaction Entry dialog box to manually enter standard or special 
earnings, deductions and liabilities. Use the Transaction Entry routine when 
one of the following conditions applies to an employee. These conditions are 
referred to as exceptions. If no exceptions apply, use the Calculate Payroll 
routine. For example, use the Transaction Entry dialog box to enter the vacation 
earnings for an employee, then use the Calculate Payroll routine to calculate the 
employee’s deductions and liabilities. 

If you are applying the same exceptions to a group of employees, use the Blanket 
Entry feature and apply them all at once. You can also reuse payroll entries from 
past payrolls using the Renew Payroll feature. Using either of these features 
generates payroll entries just as if you had manually entered them using the 
Transaction Entry dialog box. After generating the entries, use the Calculate 
Payroll routine to continue the payroll process. 

For more information on using the Transaction Entry feature, refer to 
“Processing a Payroll Using the Transaction Entry” on page 67. For more 
information on using the Blanket Entry feature, refer to “Processing a Payroll 
Using Blanket Entry” on page 71. For more information on using the Renew 
Payroll feature, refer to “Processing a Payroll Using Renew Payroll” on page 70. 
For more information on using the Calculate Payroll routine, refer to 
“Calculating Payrolls” on page 79.

Some situations when you would use the Transaction Entry dialog box are if any 
of the following exceptions occur:

• You need to pay an hourly or salaried employee who did not work the 
normal number of hours or days in the pay period (for example, part-
time or overtime employees).

• You want to enter an after-the-fact payroll or manually reverse a posted 
payroll check.

• You want to run a special payroll and do not want the check to include 
normal earnings (for example, paying vacation pay, sick pay or a 
bonus).

• You want to process a partial payroll.

• You want to use the Time Card Entry feature to track an employee’s 
hours.
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• You want to enter Third Party Sick Pay.

• You generated negative pay for an employee. For more information 
about negative pay, see the following section titled “Learning About 
Negative Pay.” 

• You need to allocate wages for multi-state withholdings.

Learning About Negative Pay

When you process a payroll for an employee with large deductions and few 
working days, a negative payment may be generated. If this occurs, you can 
modify the amounts on the Transaction Entry dialog box. In addition, if the 
Calculate Payroll routine creates deductions that reduce gross pay to an amount 
less than zero, you can run the Cancel Calculation routine. The Cancel 
Calculation routine removes the earnings, deductions and liabilities created 
using the Calculate Payroll routine and allows you to make any necessary 
corrections so you can calculate the payroll again. If you decide to reduce 
deductions to correct the negative net to pay amount, we recommended you 
reduce the user defined deductions first. If you decide to do this however, you 
also need to reduce the amount of the withholding, and then manually subtract 
the deductions from the employee’s wages in several installments over the next 
few pay periods.

If you attempt to save a payroll entry on the Transaction Entry dialog box with 
a negative net to pay amount, a warning message appears asking if you want to 
process a negative amount. If you select Yes, Sage DacEasy clears the screen 
allowing you to make an entry for the next employee. If you continue to process 
the negative amount, you may experience problems in other payroll processing 
functions. You can save a negative amount temporarily, but you cannot post a 
payroll transaction with a negative amount in an entry.

Processing a Payroll Using the Transaction Entry

The following steps explain how to use the Transaction Entry routine to process 
a payroll for employees with exceptions.

Related Help Topics

• Processing a payroll for an employee earning tips

• Processing a payroll for an employee using vacation or sick time

• Processing a payroll in a different quarter

• Processing a payroll with multi-state withholdings

• Processing a payroll with third party sick pay

• Recording manual checks
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To Process a Payroll Using the Transaction Entry Dialog Box

1 Choose Entry on the Process menu. The Pay Frequency dialog box appears.

Note: The Pay Frequency dialog box appears if there are no entries in the 
current payroll. If you have already made entries using the Transaction Entry, 
Renew Payroll, Blanket Entry or Calculate Payroll routine for the current 
payroll but have not posted the payroll transaction yet, the Pay Frequency 
dialog box does not appear. 

2 Type the dates and select which payroll frequencies you want to process. Click 
OK to continue. The Transaction Entry dialog box appears.

3 Type the employee’s code in the Code field. If you are not sure of the 
employee’s code, click LookUp to view a list of employees. Select an 
employee from the list. The employee’s information appears.

Tip: Click Options, and then Time Card Entry if you are using time cards. 
Refer to “Entering Time Cards” on page 76 for more information on this 
feature.

Use the Transaction Entry
dialog box to enter a payroll

entry for a particular
employee.

Use the Pay Frequency
dialog box to enter the

dates and select which pay
frequencies you want to

process.
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4 Type the employee’s normal pay if necessary. Then, to pay any exception to 

the employee’s pay such as vacation time, sick time, hourly rate or tips, enter 
the appropriate code and amount. 

When typing the amounts for standard earnings, type the amount in whole or 
fractional numbers. For example, when entering days as the amount and you 
are recording that an employee took a half day of sick time, type 4.5 for the 
standard earning code-01 Salary and .5 as the standard code-07 Sick time.

Tip: Click AutoApply after entering an employee’s vacation or sick time to 
automatically calculate the regular earnings.

Note: To charge the earning to a different department, enter the department 
number in the Department field. 

5 Click OK to save the payroll entry for the employee. 

6 Repeat steps 3-5 to enter payroll entries for each employee necessary. Click 
OK to save each entry. 

You can click Help from the Transaction Entry dialog box for a detailed 
description of each field.

7 Click Close to exit the Transaction Entry dialog box after all entries have 
been entered.

8 Choose Calculate Payroll from the Process menu. Use the Calculate Payroll 
routine to calculate the employee’s deductions and liabilities. You will also use 
this routine to calculate the payroll for the employee’s without exceptions. For 
more information on the Calculate Payroll routine, refer to “Calculating 
Payrolls” on page 79.

Furniture Factory Example

After reviewing the time his employees worked during the pay period, Martin 
has determined he has exceptions to his normal payroll. He views the 
Transaction Entry dialog box to enter those exceptions. Employee No. 106, 
Wyn Caldwell, was sick for one day during the pay period. Martin enters the 
employee’s sick time by adding code 07 Sick Time. He enters 8 in the Number 
column to indicate he is paying the employee 8 hours of sick time. Martin clicks 
AutoApply and the regular hourly earning for Code 02 Hourly is calculated and 
appears on the entry. After Martin saves all his exceptions, he prints a Payroll 
Register to verify his entries.
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Processing a Payroll Using Renew Payroll

The following steps explain how to use the Renew Payroll routine to reuse 
payrolls from your past payroll history.

To Process a Payroll Using Renew Payroll

1 Choose Renew Payroll on the Process menu. The Pay Frequency dialog 
box appears.

Note: The Pay Frequency dialog box appears if there are no entries in the 
current payroll. If you have already made entries using the Transaction Entry, 
Renew Payroll, Blanket Entry or Calculate Payroll routine for the current 
payroll but have not posted the payroll transaction yet, the Pay Frequency 
dialog box does not appear. 

2 Type the dates and select which payroll frequencies you want to process. Click 
OK to continue. The Renew Payroll dialog box appears.

Note: You can also access the Renew Payroll feature from the Transaction 
Entry dialog box. To renew a payroll entry for a single employee, view the 
employee on the Transaction Entry dialog box, and then select Renew.

3 Type the payroll reference for the payroll transaction you want to reuse. Click 
LookUp to select a payroll from a list.

4 Use the Scope option to select how you want to select the employees 
included in the range. Choose Range to use a consecutive range of 
employees. Choose Select to use a nonconsecutive range of employees. Type 
the employee code range in the Employee Code From and Employee Code To 
fields. If you are renewing a payroll for a single employee, and accessed the 
Renew Payroll feature from the Transaction Entry dialog box, the Scope 
option is not available so you can proceed to the next step.

Use the Renew Payroll
dialog box to reuse a payroll

entry from a past payroll
transaction.
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5 Select whether you want to use the rate or amount from the original payroll 

entry, or if you want to use the current rate or amount assigned to the 
employee.

6 Select which user defined codes you want copied into the new payroll. If you 
select Earnings Type 3 or Deductions Type 3, you can also select whether or 
not you want to use the rate from the original payroll entry, or if you want to 
use the current rate assigned to the code.

7 Click OK.

If you chose the Select option as the Scope, the range of employees you 
entered appears in a list. Select the employees whose payroll entries you want 
to renew and click OK. 

Sage DacEasy Payroll copies the selected payroll entries to the current payroll 
transaction. A confirmation message appears when the entries are 
successfully renewed.

8 Click OK to continue and exit the Renew Payroll routine.

Note: After the payroll entries are generated, you can view the entries using 
the Transaction Entry dialog box to make any changes necessary. To 
continue with the payroll process, use the Calculate Payroll routine to 
calculate the deductions, company liabilities and employee withholdings.

Processing a Payroll Using Blanket Entry

The following steps explain how to use the Blanket Entry routine to apply 
exceptions to a group of employees all at once.

To Process a Payroll Using Blanket Entry

1 Choose Blanket Entry on the Process menu. The Pay Frequency dialog box 
appears.

Note: The Pay Frequency dialog box appears if there are no entries in the 
current payroll. If you have already made entries using the Transaction Entry, 
Renew Payroll, Blanket Entry or Calculate Payroll routine for the current 
payroll but have not posted the payroll transaction yet, the Pay Frequency 
dialog box does not appear.  

2 2.Type the dates and select which payroll frequencies you want to process. 
Click OK to continue. The Blanket Entry dialog box appears.
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3 Type the name of the blanket template you want to use. If you are creating a 
new blanket template, type a unique description of the template you are 
adding. Click LookUp to select an existing template from a list. 

4 Use the Scope option to select how you want to select the employees. 
Choose Range to use a consecutive range of employees. Choose Select to 
use a nonconsecutive range of employees. 

5 Select the appropriate Use Employee option to indicate whether you are using 
the employee’s code or department when selecting the group.

6 Type the range in the From and To fields.

7 Select the pay type you want to include in the payroll transaction.

8 Select the Standard Earnings tab. Select the standard earnings you want 
included in the payroll transaction. Type the number of hours to apply for 
each standard earning.

9 Select the User Defined Earnings tab. Add each user defined earnings code 
you want included in the payroll transaction. Click LookUp to select a code 
from a list. Type the appropriate amount to apply to each user defined 
earning.

10 Select the User Defined Deductions tab. Add each user defined deduction 
code you want included in the payroll transaction. Click LookUp to select a 
code from a list. Type the appropriate amount to apply to each user defined 
deduction.

11 Click Save to save the settings if you are creating a new blanket template or 
editing an existing blanket template. 

Use the Blanket Entry dialog
box to create a template

you can use to apply to a
group of employees when

creating payroll entries.
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12 Click OK.

If you chose the Select option as the Scope, the range of employees you 
entered appears in a list. Select the employees you want to include in the 
payroll transaction and click OK. 

Sage DacEasy Payroll applies the exceptions from the blanket template to the 
selected employees. A confirmation message appears when the entries are 
successfully created.

13 Click OK to continue and exit the Blanket Entry routine.

Note: After the payroll entries are generated, you can view the entries using 
the Transaction Entry dialog box to make any changes necessary. To 
continue with the payroll process, use the Calculate Payroll routine to 
calculate the deductions, company liabilities and employee withholdings.

Payroll Processing with Groups

More flexible payroll processing! Now you may classify your payroll runs into 
groups defined by you. For example, you may want to run payroll for a group of 
employees that contain both hourly and salaried employees. Payroll Groups 
consist of one or more salaried or hourly employees that are processed in the 
same payroll run. Use Payroll Groups when you want to have payroll processing 
cycles segregated by groups of employees with similar characteristics. 

To Create Payroll Groups

1 Select Payroll Groups from the Edit menu. The Edit Payroll Groups dialog box 
appears.

2 To create a new group, enter a unique identifier in the Group Code field. i.e., 
HOUR_SHFT1, SAL_EXEC1, etc. 

3 Enter a descriptive description in the Description field.

4 Click OK to save the payroll group.
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To Assign Payroll Groups to Employees

1 Select Employee Information from the Edit menu. The Edit Employee 
Information dialog box appears.

2 Click on LookUp to select the employee you want to assign the payroll group 
to.

3 Select the Dates and Pay tab to move to that section of the dialog box.

4 Enter the payroll group code in the Pay Group field. Click on LookUp to 
select from existing payroll groups.

5 Click OK to save the employee.

6 Click OK to save the employee information.

To Process Payroll Groups

1 Select Calculate Payroll from the Process menu. The Pay Frequency dialog 
box appears.

2 Fill in the pay frequency information and click OK to continue. The 
Automatic Payroll Calculation dialog box appears.

3 Select the Payroll Group you want to process from the Include Pay Type 
dropdown box.

Note: The Include Pay Type dropdown box includes Salaried, Hourly, All, and 
all the payroll group codes from the Payroll Groups table.

4 Fill in the rest of the information in the Automatic Payroll Calculation dialog 
box.

5 Click OK to process your payroll.



When to Use the Transaction Entry dialog box
Editing a Transaction After Printing Checks

75

5

To Print Payroll Checks for Payroll Groups

1 Select Checks from the Process menu. The Print Checks dialog box appears.

2 Select the Payroll Group you want to process from the Employee Type 
dropdown box.

Note: The employee type dropdown box includes Salaried, Hourly, All, and all 
the payroll group codes from the Payroll Groups table.

3 Fill in the rest of the information in the Print Checks dialog box.

4 Click OK to print your checks. 

Editing a Transaction After Printing Checks

If you have already printed a check for an employee, you cannot edit the payroll 
entry in the Transaction Entry dialog box. If you need to change the amounts 
on the payroll entry, you have two options:

• Void the check—To void the check, point to Reconciliation on the 
Periodic menu, and then select Reconcile Checks. Select the check 
corresponding with the entry you need to change and mark it as Void. 
After voiding the check, you can edit the payroll entry, and then print a 
new check.  

• Delete the entry—Deleting the entry on the Transaction Entry dialog 
box automatically voids the check. After voiding the check, you can 
reenter the correct payroll entry, and then print a new check.

Furniture Factory Example

After printing checks, Victoria noticed that Martin had forgotten to enter the 
overtime hours for Employee No. 107, Chase Headley. Since Martin had not 
posted the payroll transaction yet, he accessed the Transaction Entry dialog box 
and viewed the payroll entry for employee 107. 

While viewing the entry, Martin clicked Delete to delete the entry and, in turn, 
void the check associated with this employee’s entry. Martin then reentered the 
employee’s regular hours and the overtime he had forgotten. He saved the entry, 
and then ran the Calculate Payroll routine. Martin calculated the payroll again 
so the taxes would generate for that employee, and then he printed this 
employee’s check.
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Using Time Cards

Use the Time Card Entry feature to track the number of hours employees work 
each day or each week. In addition to automatically calculating the number of 
hours worked, this option also determines how much of the total time worked 
is regular hours or overtime hours. Use the Time Card Entry dialog box if the 
following situations apply.

• Your company collects employee time cards on a regular basis (for 
example, daily, weekly or bi-weekly) and you want to keep track of 
your employees’ hours on the computer.

• You want a report to track the hours for employees who do not work a 
typical or regular work week during the pay period. Print the Time 
Card Report to view these hours.

Entering Time Cards

The information you enter on a day-by-day basis remains in the Time Card 
Entry dialog box until you post your payroll. In addition to tracking your 
employee’s regular work hours, you can track your employees’ overtime hours 
using one of three methods: daily, weekly or both. 

• If you select Daily as the Overtime Tracking option on the System 
Preferences dialog box, Sage DacEasy tracks overtime for any work 
done in excess of the Hours per Day amount on the Edit Company 
dialog box.

• If you select Weekly as the Overtime Tracking option on the System 
Preferences dialog box, Sage DacEasy tracks overtime for any work 
done in excess of the Hours per Week amount on the Edit Company 
dialog box.

• If you select Both as the Overtime Tracking option on the System 
Preferences dialog box, Sage DacEasy first calculates overtime as any 
time exceeding the specified hours per day. If weekly totals exceed the 
specified hours per week, weekly overtime hours replace total daily 
overtime.

To Enter a Time Card

1 Choose Entry on the Process menu. The Pay Frequency dialog box appears.

Note: The Pay Frequency dialog box appears if there are no entries in the 
current payroll. If you have already made entries using the Transaction Entry, 
Renew Payroll, Blanket Entry or Calculate Payroll routine for the current 
payroll but have not posted the payroll transaction yet, the Pay Frequency 
dialog box does not appear.
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2 Type the dates and select which payroll frequencies you want to process. Click 

OK to continue. The Transaction Entry dialog box appears.

3 Type the employee’s code in the Code field. If you are not sure of the 
employee’s code, click LookUp to view a list of employees. Select an 
employee from the list. The employee’s information appears.

4 Click Options, and then choose Time Card Entry. The Time Card Entry 
dialog box appears.

5 Type the time the employee arrived at work or returned from lunch or break in 
the Time In field. Type the time the employee left work for lunch, a break or 
for the day in the Time Out field.

6 Type the number identifying the week in the current payroll in the Week field. 
This number is used to track regular and overtime hours worked.

For example, if your employees are paid weekly, type 1 in the Week field. If 
your employees are paid biweekly, type 1 for the first week and 2 for the 
second week.

7 Type a code identifying the day of the week in the Day Code field.

You can click Help from the Time Card Entry dialog box for a detailed 
description of each field.

8 Click OK to save the time card entry.

9 Click OK to save the payroll entry for the employee.

Use the Time Card Entry
dialog box to track an

employee’s hours.
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Note: It is important you do not use codes 02 Hourly or 03 Overtime #1 in the 
Code field in the body of the Transaction Entry dialog box. When using the 
Time Card Entry feature, these codes are entered and updated automatically 
for you based on the time card entries. When these amounts are updated on 
the Transaction Entry dialog box, the amounts are automatically converted 
to fractional amounts if necessary.

Printing the Time Card Report

You can print this report to verify entries made using the Time Card Entry 
dialog box. If you find mistakes on the report, return to the Time Card Entry 
dialog box and make any necessary corrections.

If you are using the Sage DacEasy Business Center, this report is available as an 
Instant Report.

To Print the Time Card Report

1 Choose Time Card Report on the Process menu. The Time Card Report 
dialog box appears.

2 Select how you want the report sorted and type the range in the From and To 
fields.

3 Select how you want the report ranked and type the range in the From and To 
fields.

You can click Help from the Time Card Report dialog box for a detailed 
description of each field.

4 Click OK to save the information. The Report Layout dialog box appears.

5 Select the target and click OK to generate the report.

Time Card Report
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Calculating Payrolls

Use the Calculate Payroll routine to calculate any regular or user defined 
earnings, deductions, company liabilities and employee withholdings. 
Deductions and liabilities calculate based on earnings entered manually on the 
Transaction Entry dialog box and the codes set up on the Edit Employee 
Accumulations dialog box. 

To Calculate a Payroll

1 Choose Calculate Payroll on the Process menu. The Pay Frequency dialog 
box appears.

Note: The Pay Frequency dialog box appears if there are no entries in the 
current payroll. If you have already made entries using the Transaction Entry, 
Renew Payroll, Blanket Entry or Calculate Payroll routine for the current 
payroll but have not posted the payroll transaction yet, the Pay Frequency 
dialog box does not appear. 

2 Type the dates and select which payroll frequencies you want to process. Click 
OK to continue. The Automatic Payroll Calculation dialog box appears.

3 Select the Calculate Regular Earnings check box to calculate the regular 
earnings for all active employees in the pay frequencies you selected. Clear 
this check box if you made entries in the Transaction Entry dialog box and 
only want to calculate the earnings, deductions and liabilities for those 
employees with manual entries.

4 Select the pay type for the employees you want to include in the payroll 
transaction.

Use the Automatic Payroll
Calculation dialog box to

generate your payroll
entries.
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Use the Scope option to select the employees you want included in the payroll 
calculation. Choose the Range option to use a consecutive range of 
employees. Choose the Select option to use a nonconsecutive range of 
employees. Type the employee code range in the From and To fields.

5 Select which user defined earnings you want to generate for this payroll 
transaction.

6 Select which user defined deductions you want to generate for this payroll 
transaction.

7 Select the Calculate Taxes on Cost of Group Term Life check box if it 
applies to this payroll.

You can click Help from the Automatic Payroll Calculation dialog box for a 
detailed description of each field.

8 Click OK. 

If you chose the Select option as the Scope, the range of employees you 
entered appears in a list. Select the employees you want to include in the 
payroll calculation and click OK. 

Note: A Select column is available to identify the employees you selected. To 
view the Select column, you may need to resize the column headings, or scroll 
to the right of the list.

Sage DacEasy Payroll begins calculating the payroll transaction. A 
confirmation message appears when the payroll is calculated successfully.

9 Click Continue to exit the Automatic Payroll Calculation dialog box. 

Furniture Factory Example

After entering the payroll exceptions using the Transaction Entry dialog box 
(for example, payroll entries for employees using sick time, or who do not work 
the same number of hours each pay period), Martin wants to automatically 
calculate the deductions and liabilities for these employees, and calculate the 
payroll entries for all the other employees. To do this, Martin accesses the 
Calculate Payroll routine. Martin selects the Calculate Regular Earnings check 
box. This option automatically generates the payroll entries for all the other 
employees receiving their normal pay and calculate taxes for all the employees.

Martin also wants to include the user defined deductions he set up for the same 
frequency as the employee’s pay frequency, so he selects the appropriate pay 
frequencies in the User Defined Deductions To Include area. When he clicks 
OK, his payroll entries are automatically generated.
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Percentage Method

After calculating your payroll, you may notice the federal or state withholding 
amounts do not match your wage bracket. That is because Sage DacEasy, like 
other computerized payroll systems, uses a formula to calculate withholdings. 
This is commonly known as the percentage method. This method was designed 
for computer payroll systems. It is more accurate than using the wage bracket 
tables since the payroll program calculates withholdings on an annual basis 
versus a periodic basis. The percentage method calculates to the penny as 
opposed to the wage bracket tables, which round off the result. The difference 
you notice can be anywhere from one cent to a couple of dollars.

Troubleshooting the Calculate Payroll Routine

If deductions do not calculate for employees during the Calculate Payroll 
routine, check for one of the following situations:

• Find the department assigned to the deduction. Make sure account 
numbers are assigned to the deduction for the department. You can 
check for these account numbers using the Edit Department dialog 
box.

• Check the federal, state and local tax tables. The employee may not 
have enough income to justify taking out these taxes.

• Check the Federal, State and Local columns on the Edit Department 
dialog box for Earnings. A T should appear in each of the Federal, State 
and Local columns in order for Sage DacEasy to calculate a tax for the 
earning using the federal tax tables. An S in these columns instructs 
Sage DacEasy to use the supplemental percent from the tax tables. An 
N in these columns indicates the earning is not taxable, so no taxes will 
calculate for the earning.

• If the deduction problem relates to Social Security, Medicare, FUTA, 
SDI or SUI, check the Edit Employee Accumulations dialog box to 
confirm the employee has not reached the limit specified. If you 
selected the Exempt option for Social Security, Medicare, FUTA, SDI or 
SUI on the Edit Employee Information dialog box, these amounts do 
not calculate. You can also check the limit set up on the appropriate tax 
table to confirm it is correct.

• If you entered employee earnings on the Transaction Entry dialog box, 
you must run the Calculate Payroll routine to automatically calculate 
deductions.

• If user defined deductions did not generate, make sure the deduction 
was assigned to the employee. Check to verify the deduction appears 
and is set up correctly on the Edit Employee Accumulations dialog 
box. Also make sure you selected the correct frequency assigned to the 
employee on the Pay Frequency dialog box.
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• Check the pay type for the employee on the Edit Employee 

Information dialog box. If the employee’s pay type is Contract, the 
standard deductions do not calculate.

• Check the federal or state tax information for the employee on the Edit 
Employee Information dialog box. If the Allowances for the employee 
are 99 on the Federal tab of the Edit Employee Information dialog box, 
the federal deductions do not calculate. If the Allowances for the 
employee are 99 on the State tab of the Edit Employee Information 
dialog box, the state deductions do not calculate.

Canceling the Automatic Payroll Calculation

The Cancel Calculation routine clears all earnings, deductions and liabilities 
that were automatically calculated by Sage DacEasy using the Calculate Payroll 
routine. However, it does not delete manual payroll entries for codes you 
entered using the Transaction Entry dialog box or transactions where a check 
was printed. After canceling the calculations, you can make changes on the 
Transaction Entry, Edit Employee Information or Edit Employee 
Accumulations dialog boxes to correct an error, and then run the Calculate 
Payroll routine again.

To Cancel the Calculation

1 Choose Cancel Calculation on the Process menu. The Cancel Automatic 
Calculation dialog box appears.

You can click Help from the Cancel Automatic Calculation dialog box for 
more information.

2 Click OK to continue. When the Cancel Calculation routine is complete, a 
message appears.

3 Click Continue to complete the routine and exit the dialog box. 

Cancel Calculation Work-Around

If you discover an error involving only one employee or just a few employees, 
and you have not printed or posted the payroll entries yet, you do not need to 
use the Cancel Calculation routine. Instead, access the Transaction Entry dialog 
box, select the employee and click Delete to delete the payroll entry. You can 
then either reenter the data for the employee on the Transaction Entry dialog 
box or correct the record on the Edit Employee Information or Edit Employee 
Accumulations dialog box. Run the Calculate Payroll routine again to process 
only those entries deleted.
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Printing the Payroll Register

Use this report to verify all entries on the Transaction Entry dialog box. If you 
find mistakes, go back to the Transaction Entry dialog box and make any 
necessary corrections, or run the Cancel Calculation routine. 

You can use this report several times throughout the payroll process. First, if you 
print this report after entering exceptions using the Transaction Entry dialog 
box, you can easily double-check your entries. Second, print this report after 
automatically calculating a payroll using the Calculate Payroll routine to make 
sure all earnings, deductions and liabilities were generated correctly. View this 
report before printing your payroll checks, and you will save yourself time and 
money by catching errors before the checks are printed.

The 941, state and local tax information print on the last page of the Payroll 
Register. This section of the report is useful when you need to know your tax 
deposit accumulations for a particular payroll.

Tip: If you are using the Sage DacEasy Business Center, this report is available 
as an Instant Report. For more information on this feature, refer to Chapter 6, 
“Working With Sage DacEasy Business Center Pages” in the Sage DacEasy 
Business Center Guide.

To Print the Payroll Register

1 Choose Payroll Register on the Process menu. The Payroll Register dialog 
box appears.

2 Select how you want the report sorted and type the range in the From and To 
fields.

3 Select how you want the report ranked and type the range in the From and To 
fields.

4 Complete the remaining fields if necessary.

You can click Help from the Payroll Register dialog box for a detailed 
description of each field.

5 Click OK to save the information. The Report Layout dialog box appears.

6 Select the target and click OK to generate the report.
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Payroll Register (Detail)

Payroll Register (Tax Information)
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Printing Payment Forms

After reviewing the Payroll Register and confirming everything is correct, you 
are ready to print your payroll checks and direct deposit advices. You are 
required to print direct deposit advices before transmitting your direct deposit 
file to your financial institution or direct deposit service. This section includes 
the steps for print payroll checks, direct deposit advices and additional 
information on correcting transactions found after printing your payment 
forms.

Printing Payroll Checks

You can print continuous-feed and laser checks from Sage DacEasy Payroll. Be 
sure to select the appropriate setting for your checks using the Payment Settings 
tab of the System Preferences dialog box before printing your checks. Sage 
DacEasy provides you with the option to print OCReady Long Stub payroll 
checks. If you are using laser checks other than the OCReady Long Stub Format, 
you can print up to 10  earnings and 10 deductions. 

If you select to use the OCReady Long Stub Format laser checks, you can print 
up to print 27 earnings and 27 deductions on the check in addition to vacation 
and sick time. The OCReady Long Stub format has an area specifically designed 
for printing vacation and sick time. You can order payroll checks and envelopes 
from the Sage DacEasy Forms division by calling (800) 222-0505.

Note: If you are using the OCReady Long Stub Format laser payroll check, you 
do not have the option of printing a duplicate stub. 

Related Help Topics

• Aligning continuous-feed checks on your printer

• Reprinting payroll checks using a new check number

• Reprinting payroll checks using the same check number

• Voiding payroll checks
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To Print Payroll Checks

1 Choose Checks on the Process menu. The Print Checks dialog box appears.

2 Use the Scope option to select the employees for which you want to print 
checks. Choose the Range option to use a consecutive range of employees. 
Choose the Select option to use a nonconsecutive range of employees. Select 
how you want the checks sorted and type the range in the From and To fields.

3 Select how you want the checks ranked and type the range in the From and 
To fields.

4 Select the group of employees, whose payroll checks you are printing, using 
the Employee Type option.

5 Enter the starting check number in the Starting Check Number field. This is 
the first check number in the batch of checks loaded in your printer.

6 Do not select the Reprint Checks check box.

7 Complete the remaining fields as necessary. Click Help from the Print Checks 
dialog box for a detailed description of each field.

8 Click OK to save the information. 

If you chose the Select option as the Scope, the range of employees you 
entered appears in a list. Select the employees you want and click OK. The 
Report Layout dialog box appears.

Note: If using continuous-feed checks, click Test Page from the Report 
Layout dialog box to print a test check and verify the check is loaded 
properly. This voids the first check. To view the voided check, choose 
Reconciliation on the Periodic menu, and then choose Reconcile Checks.

9 Select the target and click OK to begin printing checks.

Use the Print Checks dialog
box to enter information
regarding the checks you

want to print.
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To Set up Customizable Checks in Sage DacEasy Payroll

1 Select Defaults from the Edit menu and then select Preferences. The 
Preferences dialog appears.

2 Click on the Payment Settings tab to move to that section in the dialog box.

3 Select Custom from the Check Type dropdown box.

4 Enter the name of your check template in the Employee Check Form 
field, or click on LookUp to select from a list of available templates.

5 From the Employee Check Form field select Edit Forms to edit the 
employee check template.

6 Enter the name of your Tax Deposit check template in the Tax 
Deposit Check Form field. Click on LookUp to select from a list of 
available templates.

7 From the Tax Deposit Check Form field select Edit Forms to edit the 
tax deposit template.

8 To create an employee check template, type a new name in the 
Employee Check Form field. To select an existing template, type the 
template name or select LookUp and select the template.

9 To create a tax deposit template, type a new name in the Tax Deposit 
Check Form field. To select an existing template, type the template 
name or select LookUp and select the template.

Note: Refer to the “Editing templates” and “Template Variables” topic in 
Help for more information on how to create or edit form templates. 
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Tip: Select Options and select Copy Format to make a copy of an existing 
template.

10 Click on OK to save the Preferences and return to the menu.

To Print OCR Checks

1 Select Defaults from the Edit menu and then select Preferences. The 
System Preferences dialog appears.

2 Select Payments Settings tab.

3 Click on the Check Type dropdown box and select OCR Checks as your 
check printing option.

4 Click OK to save your check form settings.

Printing Direct Deposit Advices

After reviewing the Payroll Register, confirming everything is correct, and you 
have employees using direct deposit, you are ready to print your direct deposit 
advices. Direct deposit advices are also referred to as direct deposit slips. Direct 
deposit advices are plain paper forms you provide to your direct deposit 
employees that include their current payroll information. Providing this plain 
paper direct deposit advice form is beneficial since you do not have to void a 
check to provide your employee with their current payroll information.

To Print Direct Deposit Advices

1 Choose Direct Deposit Advices on the Process menu. The Print Direct 
Deposit Advices dialog box appears.

Note: The Direct Deposit Advices feature is only available if you have 
employees using direct deposit as indicated on the Edit Employee 
Information dialog box. 
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2 Use the Scope option to select the employees for which you want to print 
direct deposit advices. Choose the Range option to use a consecutive range 
of employees. Choose the Select option to use a nonconsecutive range of 
employees. Select how you want the advices sorted and type the range in the 
From and To fields.

3 Select how you want the advices ranked and type the range in the From and 
To fields.

4 Select the group of employees, whose direct deposit advices you are printing, 
using the Pay Type to Include option.

5 Complete the remaining fields as necessary. Click Help from the Print Direct 
Deposit Advices dialog box for a detailed description of each field.

6 Click OK to save the information. 

If you chose the Select option as the Scope, the range of employees you 
entered appears in a list. Select the employees you want and click OK. 

The Report Layout dialog box appears.

7 Select the target and click OK to begin printing direct deposit advices.

Correcting Unposted Payroll Entry Errors

If you discover an error on a printed check or direct deposit advice before 
posting, follow these steps.

Use the Print Direct Deposit
Advices dialog box select

and print your direct
deposit information for the

current payroll.
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To Correct Unposted Payroll Entry Errors

1 Choose Entry on the Process menu. The Transaction Entry dialog box 
appears.

2 Delete the transaction for the employee whose check or advice is incorrect. To 
do this, type the employee’s code in the Code field. When the payroll entry 
information appears, click Delete to delete the payroll entry. When you delete 
the payroll entry, the corresponding check is voided.

3 Add a new payroll entry for each deleted transaction and make the necessary 
changes. Enter any earnings, deductions and/or liabilities manually if you did 
this originally, otherwise, use the Calculate Payroll routine. Click OK to save 
your transactions.

4 Process your payroll as usual.

Printing the Check Register
Print this report to retain a copy of your employee paychecks and direct deposit 
payments. The Check Register only prints those items in the Check Register file. 
If you are reconciling with Sage DacEasy Accounting or if you purge the Check 
Register during posting, you cannot print the Check Register after posting your 
payroll transaction. If you are reconciling with Sage DacEasy Accounting, you 
can print the Check Register from the Sage DacEasy Accounting program. 
Manual checks do not appear on the Check Register until you post your payroll.

Tip: If you are using the Sage DacEasy Business Center, this report is available 
as an Instant Report. 

To Print the Check Register

1 Choose Check Register on the Process menu. The Check Register dialog 
box appears.

You can click Help from the Check Register dialog box for a detailed 
description of each field.

2 Select how you want the report sorted and type the range in the From and To 
fields.

3 Select how you want the report ranked and type the range in the From and To 
fields.

4 Select the type of checks you want included on the report.

5 Click OK to save the information. The Report Layout dialog box appears.
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6 Select the target and click OK to generate the report.

Check Register

Printing the Department Report
This report analyzes departmental payroll records. The Department report 
shows the totals of each general ledger account number by department and gives 
you information regarding the payroll expenses of each department relating to 
the current payroll. You can only print this report before posting the current 
payroll.

This report is particularly useful to individual department managers who want 
to determine labor costs per department. If you selected the Allocate Cost By 
Department check box on the System Preferences dialog box, you can print this 
report to view all deductions and liabilities allocated based on the department 
associated with each earning.

Tip: If you are using the Sage DacEasy Business Center, this report is available 
as an Instant Report. For more information on this feature, refer to Chapter 6, 
“Working With Sage DacEasy Business Center Pages” in the Sage DacEasy 
Business Center Guide.
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To Print the Department Report

1 Choose Department Report on the Process menu. The Department 
Report dialog box appears.

You can click Help from the Department Report dialog box for a detailed 
description of each field.

2 Type the sort range in the From and To fields.

3 Select how you want the report ranked and type the range in the From and To 
fields.

4 Select the type of report you want to generate.

5 Click OK to save the information. The Report Layout dialog box appears.

6 Select the target and click OK to generate the report.

Department Report
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Creating the Direct Deposit File

The Direct Deposit feature transfers funds directly from an employer’s bank 
account(s) into an employee’s bank account(s). Process a direct deposit by 
choosing Direct Deposit on the Process menu.

Types of Direct Deposit Files

You can create two types of direct deposit files, an NPC (National Payment 
Corporation) file or a generic ACH (Automated Clearing House) file. You can 
use either option to process direct deposits for your employees. If you are using 
the third-party institution NPC to process your direct deposit, you want to 
create an NPC specific file. If you check with your company’s financial 
institution and they provide direct deposit as part of their payroll services, you 
can create a generic ACH file and work directly with your financial institution.

Identify the type of direct deposit file you are creating on the System Preferences 
dialog box. To view the System Preferences dialog box, point to Defaults on the 
Edit menu, and then choose Preferences.

How the Direct Deposit Feature Works

An NPC specific direct deposit file uses modem communication software to 
directly link with an encryption algorithm routine. This ensures the security of 
your transmission and prevents any unauthorized access to your electronic 
payment information. This routine scrambles electronic payment information 
according to predetermined unique calculations for each user.

A generic ACH direct deposit file is transmitted over the modem using your 
bank’s software or it is copied to a disk and delivered to your financial 
institution. The method you use to transfer your direct deposit information 
depends on the arrangements set up with your bank. 

Related Help Topic

• Setting up the communication settings for NPC

Prenoting a Direct Deposit

Prenote a zero dollar amount credit to your bank to make sure the routing and 
bank account numbers are correct. You need to set up the company direct 
deposit account information and the employee direct deposit account 
information before you can prenote a direct deposit. When prenoting a direct 
deposit, make sure no entries are in the Transaction Entry dialog box.

Note: When setting up the employee direct deposit account information, notice 
the letter N appears as the Prenote setting and no date appears in the Prenote 
Date field.



Processing Payroll
Sage DacEasy Payroll User’s Guide

94

5
Related Help Topics

• Setting up employees for direct deposit

• Setting up company information

To Prenote a Direct Deposit

Creating the Prenote Direct Deposit Transaction

1 Choose Direct Deposit on the Process menu. The Direct Deposit dialog 
box appears.

2 Type a file name for your payroll transaction. The direct deposit file name 
begins with XMIT followed by a four-digit number.

3 Type any management information notes in the New Transmit Description 
field.

4 Type the date to begin the prenote process.

You can click Help from the Direct Deposit dialog box for a detailed 
description of each field.

5 Click OK to create and transmit the prenote file. After the file is transmitted, 
click Continue to exit the Direct Deposit dialog box.

Verifying the Employee Direct Deposit Account Information

6 Choose Employee Information on the Edit menu. The Edit Employee 
Information dialog box appears.

7 Select an employee using direct deposit. If you are not sure of the employee 
code, click LookUp and select the employee from the list. The employee’s 
information appears.

8 Click Options, and then choose Direct Deposit. The Employee Direct 
Deposit Accounts dialog box appears.

Use the Direct Deposit
dialog box to prenote your
direct deposit transaction.
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9 Notice a “W” appears as the Prenote setting. This indicates Sage DacEasy is 

waiting to ensure the prenote was successful. The date you prenoted the 
direct deposit appears in the Date Prenoted field.

You can process a direct deposit for your employees when the number of days 
in the prenote period has passed and an “A” appears as the Prenote setting. 
The “A” indicates direct deposit is now active for the employee. To check the 
number of days in the prenote period, view the Edit Company dialog box. 

Creating a Generic ACH Direct Deposit File

You need to complete the payroll transaction before attempting to create a 
generic Automated Clearing House direct deposit file. Create and transmit your 
direct deposit file before you post your payroll transaction. Check with your 
financial institution to ensure you satisfy all their requirements necessary to use 
the generic direct deposit feature. 

To Create a Generic ACH Direct Deposit File

1 Choose Direct Deposit on the Process menu. The Direct Deposit dialog 
box appears.

2 Type a file name for your payroll transaction. The direct deposit file name 
begins with XMIT followed by a four-digit number.

3 Type any management information notes in the New Transmit Description 
field.

4 Type the date you want your payment center to deposit the funds into your 
employees’ bank accounts in the Effective Date field. The date defaults to the 
current program date for ACH direct deposit files.

You can click Help from the Direct Deposit dialog box for a detailed 
description of each field.

5 Click OK to create the file. A confirmation message appears when the file is 
successfully created. Select Details to view the Direct Deposit Disbursement 
Report.

After Creating a Generic ACH Direct Deposit File

When a generic direct deposit file is created, the file name of the direct deposit 
file appears on your screen. This file is created in the Sage DacEasy Payroll 
program folder. Send this file to your financial institution using your modem 
and your financial institution’s software application, or you can copy the file to 
a disk and deliver the file to them. Check with your financial institution for the 
recommended method of transferring your direct deposit file. 
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Creating an NPC Direct Deposit File

You need to complete the payroll transaction before attempting to create a 
National Payment Corporation direct deposit file. Create and transmit your 
direct deposit file before you post your payroll transaction. 

To Create and Transmit an NPC Direct Deposit File

1 Choose Direct Deposit on the Process menu. The Direct Deposit dialog 
box appears.

2 Type a file name for your payroll transaction. The direct deposit file name 
begins with XMIT followed by a four-digit number.

3 Type any management information notes in the New Transmit Description 
field.

4 Do not select the Retransmit check box, unless you are retransmitting the 
file.

5 Type the date you want your payment center to deposit the funds into your 
employees’ bank accounts in the Effective Date field. The date defaults to two 
days from the current program date for NPC direct deposit files.

You can click Help from the Direct Deposit dialog box for a detailed 
description of each field.

6 Click OK to create and transmit the file. A confirmation message appears 
when the file is successfully created. Select Details to view the Direct Deposit 
Disbursement Report.

After You Transmit an NPC Direct Deposit File

When you transmit your payroll transaction, your payment processing center 
software application should ask you to provide your password. If you enter the 
password correctly, your payroll files transmit. 

After completing the transmission, your payment center sends you a count of 
the items in your file, the total dollar amount and a confirmation number. Be 
sure to keep the confirmation number in a safe location. The confirmation 
number is your guarantee that the file was sent and received properly. Compare 
the total dollar amount provided by NPC with your dollar amount. If you have 
any problems, call your payment center’s customer service department. 

It is important you do not send your direct deposit file again after receiving your 
totals from your payment center. If you send the same batch twice, your 
payment center must contact your company to verify the information before 
processing anything. 
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Posting Payroll Transactions

Posting is the last routine you need to perform for each payroll. This routine 
performs these important processes:

• Clears the current payroll from the Transaction file, allowing you to 
enter the next payroll.

• Adds totals from the current payroll to the monthly, quarterly, yearly or 
next quarter accumulation columns on the Edit Employee 
Accumulations dialog box.

• Purges all checks from the Check Register file if you selected the Erase 
Check Register after Posting check box on the System Preferences 
dialog box.

• Transfers the payroll checks to Sage DacEasy Accounting if you selected 
the Reconcile with Sage DacEasy Accounting check box on the System 
Preferences dialog box.

• Updates the Payroll History files. The posted payroll now appears on 
the Transaction History, Codes History and Detail reports. 

• Updates the Direct Deposit files if using the Direct Deposit feature. The 
Direct Deposit Current Payroll file is cleared and the information is 
transferred to the Direct Deposit Transaction History file. The posted 
payroll is available from the Direct Deposit Transaction History file 
when creating custom reports in DacAccess or Crystal Reports. You can 
also view this information from the Edit Employee Information dialog 
box by selecting the History button, selecting a direct deposit 
transaction, and then selecting Deposits.

• Updates the Hours Accrued, Hours Paid and Hours Available fields on 
the Edit Employee Information dialog box for vacation and sick time.

• Adds totals from the current payroll to the 940, 941 and Schedule B file.

• Clears all time card entry information for the current payroll.

• Posts a transaction into the General Ledger in Sage DacEasy 
Accounting if you are running Sage DacEasy Payroll interfaced with 
Sage DacEasy Accounting. A journal entry is created with the PY 
journal code. 
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To Post a Payroll Transaction

1 Choose Posting on the Process menu. The Transaction Posting dialog box 
appears.

2 Click Backup. The File Backup/Restore dialog box appears. Make a backup 
of your payroll data. If you are running Sage DacEasy Payroll interfaced with 
Sage DacEasy Accounting, run the Backup routine again and make a separate 
backup of your accounting data.

3 Verify the dates on the Transaction Posting dialog box are correct.

If the process date is incorrect, click Options, and then choose Date. The 
current date appears. Enter the correct date, exit the Transaction Posting 
dialog box and choose Posting from the Process menu again.

4 Type a payroll reference for the payroll transaction. Typing a descriptive 
reference helps easily identify the transaction.

5 Select the frequencies you want to accrue vacation time.

6 Select the frequencies you want to accrue sick time.

7 Do not select the Reverse Current Payroll check box.

You can click Help from the Transaction Posting dialog box for a detailed 
description of each field.

8 Click OK to continue. The Report Layout dialog box appears.

9 Select Printer as the target and click OK to generate the Posting report. A 
message appears stating the posting is complete.

10 Click Continue to exit the dialog box.

Use the Transaction Posting
dialog box to post your

payroll transactions.
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Furniture Factory Example

After Martin prints all of his reports and has determined the information is 
correct, he makes a backup of his data files by clicking the Backup button on the 
toolbar of the Transaction Posting dialog box. Then, Martin posts the payroll to 
finalize the payroll processing routine.

Printing the Posting Report

This report lists the general ledger transaction created when posting the payroll. 
If you are interfaced with Sage DacEasy Accounting, this is the transaction that 
posts into the General Ledger in Sage DacEasy Accounting. A journal entry is 
created with the PY journal code. If you are interfaced with Sage DacEasy 
Accounting, the account number and name print on the report. If you are not 
interfaced with Sage DacEasy Accounting, just the account number prints on 
the report.

To Print the Posting Report

1 Choose Posting on the Process menu. The Transaction Posting dialog box 
appears.

2 Verify the dates on the Transaction Posting dialog box are correct.

3 Complete each field on the dialog box appropriately.

You can click Help from the Transaction Posting dialog box for a detailed 
description of each field.

4 Click OK to continue. The Report Layout dialog box appears.

5 Select Printer as the target and click OK to generate the Posting report. A 
message appears stating the posting is complete.

6 Click Continue exit the dialog box.

For more information on posting a payroll transaction, refer to “Posting 
Payroll Transactions” on page 97.
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Posting Report

Reversing Payrolls
Sage DacEasy allows you to reverse posted payrolls to correct payroll 
transactions without restoring a backup. For example, you may need to correct 
a payroll check posted for the wrong amount. There are two methods to 
reversing a payroll, the AutoReverse Posting routine, and manually reversing a 
payroll using the Reverse Current Payroll option on the Transaction Posting 
dialog box. 

Before reversing a posted payroll, make sure all transactions have been posted 
or deleted. No entries should appear in the Transaction Entry dialog box if all 
transactions have been posted or deleted. If you have already started the next 
payroll, you need to remove any current payroll entries in the Transaction Entry 
dialog box that you do not want to include when reversing a posted payroll. 
Before deleting the payroll entries, you can print a Payroll Register and Time 
Card Report. After you reverse the posted payroll transaction, you can reenter 
the payroll entries by referring to these reports.

Using AutoReverse Posting

You can reverse a posted payroll with a click of the mouse. You do not need to 
reenter the information from the original payroll manually, just select the 
payroll you want reversed and let Sage DacEasy do the rest for you. The option 
to manually reverse a payroll is available, but we recommend you use the 
AutoReverse method to reverse a payroll to ensure accurate reversing entries. 
The AutoReverse Posting routine also allows you to select whether to reverse the 
month to date accumulations and reverse a payroll in a previous quarter of the 
current year. 
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Note: If you do select to reverse a payroll in a previous quarter of the current 
year, Sage DacEasy also updates the year to date accumulations. This may result 
in changes in your previous quarter’s reports.

To Use the AutoReverse Posting

1 Choose AutoReverse Posting on the Process menu. The AutoReverse 
Posting dialog box appears.

2 Click Backup. The File Backup/Restore dialog box appears. Make a backup 
of your payroll data. If you are running Sage DacEasy Payroll interfaced with 
Sage DacEasy Accounting, run the Backup routine again and make a separate 
backup of your accounting data.

3 Type the payroll reference for the payroll transaction you want to reverse. 
Click LookUp to select a payroll from a list.

Note: The AutoReverse routine uses the payroll history to reverse the payroll 
transaction. This means that for each of the employees selected in the 
AutoReverse routine, the entry for that employee is reversed exactly from the 
original payroll transaction, unlike the manual payroll reverse routine. If you 
purge the payroll history during the Close Quarter routine, you cannot 
perform the AutoReverse routine for the payroll transactions that were 
purged.

4 Use the Scope option to select the employees you want included in the 
AutoReverse routine. Choose the Range option to use a consecutive range of 
employees. Choose the Select option to use a nonconsecutive range of 
employees. Type the employee code range in the From and To fields or click 
LookUp to select the employees from a list.

5 Type a payroll reference for the reversing payroll transaction. A default payroll 
reference is provided. Typing a descriptive reference helps easily identify the 
transaction.

6 Select whether or not you need to reverse the month to date accumulations.

7 Click OK. If you chose the Select option as the Scope, the range of 
employees you entered appears in a list. Select the employees you want to 
include in the reversed payroll and click OK. 

A Select column is available in the list to identify the employees you selected. 
To view the Select column, you may need to resize the column headings, or 
scroll to the right of the list. A warning appears if reversing a payroll takes an 
employee’s accumulation below a limit for vacation time, sick time or 
standard codes. 
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You can click Details from the warning to view a list of employees whose 
accumulations will go below a limit. You can print the report for future 
reference. 

8 Click Continue. The Report Layout dialog box appears.

9 Select Printer as the target and click OK to generate the AutoReverse Posting 
report. 

If you continued through the warning that employee accumulations will go 
below a limit for vacation time, sick time or standard codes, a log appears 
listing each employee affected. A message appears stating the reverse posting 
is complete.

10 Click Continue to exit the AutoReverse Posting dialog box. 

You can print a Transaction History report for the check date to verify the 
reverse post transaction. Both the original transaction and the reverse 
transaction appear on the report. The reverse transaction cancels out the 
original transaction to correct the totals.

Behind the Scenes

When you reverse a payroll transaction, a reversing entry is made to the General 
Ledger, the check or checks are voided in the Sage DacEasy Payroll Check 
Register, or in the Sage DacEasy Accounting Check Register if you are 
reconciling with Sage DacEasy Accounting, and the amount is deducted from 
the Edit Employee Accumulations dialog box, payroll history files, 940 file and 
941 file. The Payroll Transaction History and Detail reports are also updated. 
Negative entries for each selected employees for the reversed payroll transaction 
appear on the Transaction History report. The Detail report is also updated with 
the reversed payroll if the Create Detail Report When Posting check box is 
selected on the System Preferences dialog box.

Furniture Factory Example

The day after Martin posts the payroll, Victoria notices her bonus was not 
included on her check. Martin tells her he will print another check immediately. 
To do this, Martin decides he has to reverse the original payment for Victoria 
and recalculate and reprint her check correctly to make sure his accounting and 
payroll records are correct. 

Martin prints the Transaction History report to locate the payroll he needs to 
reverse. Using the payroll reference from the Transaction History report, he 
runs the AutoReverse Posting routine. Since he only needs to reverse the payroll 
for Victoria, Martin selects Range as the Scope option on the AutoReverse 
Posting dialog box and enters Victoria’s employee code in both the From and 
To fields. 
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Martin completes the AutoReverse Posting routine, and the original payroll 
entry is reversed and the original check is voided. Martin verifies the reverse 
posting by printing a Transaction History report to view the new entry with 
negative amounts. Martin then runs a payroll just for Victoria, this time 
remembering to pay her the bonus.

Manually Reversing a Payroll

When manually reversing a payroll, it is important you do not run the Calculate 
Payroll routine to generate deductions and/or liabilities. The following problem 
may occur:

When you posted the original entry, Sage DacEasy calculated the liabilities and 
deductions in full if limits were not reached. However, after posting, some 
employees may come close to their limit. So, the next time you run the Calculate 
Payroll routine, the liability and deduction information for these employees 
would be less than the original entry if they reached the limit. Therefore, when 
you reverse this payroll, liabilities and deductions are not reduced back to their 
previous amounts. The solution is to enter the earnings, deductions and 
liabilities on the Transaction Entry dialog box manually exactly as they 
appeared before posting the transaction. Refer to the Payroll Register you 
printed prior to posting the payroll transaction for the details of each entry.

If you are reversing a payroll and the employee has exceeded the wage limits for 
FUTA, SUI, SDI or Social Security in the original payroll transaction, Sage 
DacEasy does not update these amounts during the Manual Reverse Posting 
routine, even if the liabilities and deductions are present in the payroll entry. 
You must view the employee on the Edit Employee Accumulations dialog box 
and manually reduce the amount for the appropriate taxable wage fields. 

For example, if an employee had exceeded the Social Security wage limit and you 
reversed a payroll for that employee, you need to manually adjust the 
employee’s taxable wages. Select this employee in the Edit Employee 
Accumulations dialog box, click the Earnings tab and reduce the Social Security 
Month, Quarter, Year and Next Quarter column if applicable, by the amount of 
the last payroll. If you do not want to manually edit these amounts, use the 
AutoReverse Posting routine.

To Manually Reverse a Payroll

Entering the Reversing Payroll Entry

1 Choose Entry on the Process menu. The Pay Frequency dialog box appears.

2 Type the dates and select which payroll frequencies you want to process. Click 
OK to continue. The Transaction Entry dialog box appears.
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3 Type the employee’s code in the Code field. If you are not sure of the 

employee’s code, click LookUp to view a list of employees. Select the 
employee from the list. The employee’s information appears.

4 Enter the payroll entry exactly as it originally appeared for all earnings, 
deductions and liabilities according to the Payroll Register.

You can click Help from the Transaction Entry dialog box for a detailed 
description of each field.

5 Click Options, and then choose Manual/Computer. The Check Type dialog 
box appears. Choose Manual and type the original check number.

Perform this step if you need to void the original payroll check.

6 Click OK to save the check number.

7 Click OK to save the payroll entry for the employee.

8 Repeat steps 3-7 for each employee necessary to reverse the payroll 
transaction.

Reversing the Payroll Entry

Follow these steps to reverse a payroll transaction. Be sure to make a backup of 
your payroll data before you begin posting a payroll. You can restore this backup 
in the event an error occurs during the Posting routine. Before you post a 
payroll, print the Payroll Register for your records.

9 Choose Posting on the Process menu. The Transaction Posting dialog box 
appears.

10 Click Backup. The File Backup/Restore dialog box appears. Make a backup 
of your payroll data. If you are running Sage DacEasy Payroll interfaced with 
Sage DacEasy Accounting, run the Backup routine again and make a separate 
backup of your accounting data.

11 Verify the dates and select the same vacation and sick time accrued options as 
the original payroll transaction you are reversing.

12 Select the Reverse Current Payroll check box.

13 Click OK to continue. The Report Layout dialog box appears.

14 Select Printer as the target and click OK to generate the Posting report. A 
message appears stating the posting is complete.

15 Click Continue to exit the dialog box.
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You can print a Transaction History report to verify the reverse post 
transaction. Both the original transaction and the reverse transaction appear 
on the report. The reverse transaction cancels out the original transaction to 
correct the totals.

Making Tax Deposits

Making 940 Tax Deposits

The 940 Tax Deposit routine maintains a record of your Federal Unemployment 
Tax (FUTA) liabilities, deposits and amount due for the 940 federal tax return. 
Use this routine to print the 940 tax deposit checks.

Post all transactions before entering the 940 Deposit dialog box. The liability 
and deposit sections pull information from the Edit Employee Accumulations 
dialog box and the 940 and 941 files. Post all payroll transactions to ensure this 
information is current.

The 940 Deposit dialog box holds information regarding the liability to date. 
These fields are a record of transactions and are not accessible. Each deposit 
transaction updates the deposit record. Sage DacEasy uses this information to 
calculate the amount of the deposit due. To view or print the deposit history, 
click History while on the 940 Deposit dialog box.

Related Help Topic

• Recording a tax deposit for a manual check
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To Make a 940 Tax Deposit

1 Point to Tax Deposit on the Process menu, and then select 940. The 940 
Deposit dialog box appears.

2 Select the quarter you want to make a deposit for using the Deposit For field. 
You can make a deposit for the prior, current, next quarter or entire year.

3 Complete the appropriate fields on the dialog box.

You can click Help from the 940 Deposit dialog box for a detailed description 
of each field.

You can click Address to record the address of the institution to whom the 
check is payable.

4 Click OK to save the 940 tax deposit.

If you selected Computer as the Check Type, the Report Layout dialog box 
appears so you can print the tax deposit check. After printing the tax deposit 
check, the Report Layout dialog box appears to print the GL Transaction 
Summary report.

If you use continuous-feed checks, click Test Page from the Report Layout 
dialog box to print a test check and verify the check is loaded properly. If you 
use this feature, the check number on the 940 Deposit dialog box is voided.

If you selected Manual or None as the Check Type, a message appears 
confirming you want to continue. Choose Yes to continue. The Report 
Layout dialog box appears to print the GL Transaction Summary report.

5 Select the target and click OK to begin generating the report.

Use the 940 Deposit dialog
box to enter your tax

deposits.
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Making 941 Tax Deposits

The 941 Tax Deposit routine maintains a record of your quarterly federal tax 
liabilities, deposits and the amount due for the 941 Form. Use this routine to 
print the 941 tax deposit checks. 

Post all transactions before entering the 941 Deposit dialog box. The liability 
and deposit sections pull information from the Edit Employee Accumulations 
dialog box and the 941 and 940 files. Post all payroll transactions to ensure this 
information is current. 

The 941 Deposit dialog box holds information regarding the current and prior 
quarters. These fields are a record of transactions and are not accessible. Each 
deposit transaction updates the deposit record. Sage DacEasy uses this 
information to calculate the amount of the deposit due. To view or print the 
deposit history, click History while on the 941 Deposit dialog box. In order to 
use the 941 Tax Deposit routine, you must have an account number entered in 
the EIC field in your first department. Refer to the Help topic titled “Setting up 
the EIC account in departments for the 941 tax deposit” for more information.

Related Help Topic
• Recording a tax deposit for a manual check

• Setting up the EIC account in departments for the 941 tax deposit

To Make a 941 Tax Deposit

1 Point to Tax Deposit on the Process menu, and then select 941. The 941 
Deposit dialog box appears.

Use the 941 Deposit dialog
box to enter your tax

deposits.
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2 Select the quarter you want to make a deposit for using the Deposit For field. 

You can make a deposit for the prior, current or next quarter.

3 Complete the appropriate fields on the dialog box.

You can click Help from the 941 Deposit dialog box for a detailed description 
of each field.

You can click Address to record the address of the institution to whom the 
check is payable.

4 Click OK to save the 941 tax deposit.

If you selected Computer as the Check Type, the Report Layout dialog box 
appears so you can print the tax deposit check. After printing the tax deposit 
check, the Report Layout dialog box appears to print the GL Transaction 
Summary report.

If you use continuous-feed checks, click Test Page from the Report Layout 
dialog box to print a test check and verify the check is loaded properly. If you 
use this feature, the check number on the 941 Deposit dialog box is voided.

If you selected Manual or None as the Check Type, a message appears 
confirming you want to continue. Choose Yes to continue. The Report 
Layout dialog box appears to print the GL Transaction Summary report.

5 Select the target and click OK to begin generating the report.

If an amount due exists for the prior quarter, a message appears. If you want 
to apply a portion of this deposit to the prior quarter, choose Yes. The deposit 
amount cannot be over the amount due for the prior quarter. If you choose 
No, Sage DacEasy applies the deposit to the current quarter.

Making State Tax Deposits

The State Tax Deposit routine maintains a record of your tax liabilities, deposits 
and amount due for state withholding, State Unemployment Insurance (SUI) 
and State Disability Insurance (SDI). Use this routine to print the state tax 
deposit checks.

Post all transactions before entering the State Deposit dialog box. The liability 
and deposit sections pull information from the Edit Employee Accumulations 
dialog box. Post all payroll transactions to ensure this information is current.
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The State Deposit dialog box holds information regarding the current and prior 
quarters. These fields are a record of transactions and are not accessible. Each 
deposit transaction updates the deposit field. Sage DacEasy uses this 
information to calculate the amount of deposit due. You can make a SUI/SDI 
deposit and State deposit from this dialog box. You cannot combine both the 
SUI/SDI and State deposits into one deposit. You must enter each deposit 
separately. To view or print the deposit history, click History while on the State 
Deposit dialog box.

Related Help Topic

• Recording a tax deposit for a manual check

To Make a State Tax Deposit

1 Point to Tax Deposit on the Process menu, and then select State. The State 
Deposit dialog box appears.

2 Type the two-letter abbreviation of the state for which you want to make a 
deposit or click LookUp to select the state abbreviation from a list. 

If you are withholding for more than one state, you need to enter deposits for 
each state separately.

3 Select the quarter you want to make a deposit for using the Deposit For field. 
You can make a deposit for the prior, current or next quarter.

4 Complete the appropriate fields on the dialog box.

The Amount of Deposit field cannot exceed the Total Amount Due.

You can click Help from the State Deposit dialog box for a detailed 
description of each field.

You can click Address to record the address of the institution to whom the 
check is payable.

5 Click OK to save the state tax deposit.

If you selected Computer as the Check Type, the Report Layout dialog box 
appears so you can print the tax deposit check. After printing the tax deposit 
check, the Report Layout dialog box appears to print the GL Transaction 
Summary report.

If you use continuous-feed checks, click Test Page from the Report Layout 
dialog box to print a test check and verify the check is loaded properly. If you 
use this feature, the check number on the State Deposit dialog box is 
voided.
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If you selected Manual or None as the Check Type, a message appears 
confirming you want to continue. Choose Yes to continue. The Report 
Layout dialog box appears to print the GL Transaction Summary report.

6 Select the target and click OK to begin generating the report.

If an amount due exists for the prior quarter, a message appears. If you want 
to apply a portion of this deposit to the prior quarter, choose Yes. The deposit 
amount cannot be over the amount due for the prior quarter. If you choose 
No, Sage DacEasy applies the deposit to the current quarter.

Making Local Tax Deposits

The Local Tax Deposit routine maintains a record of your local tax liabilities, 
deposits and the amount due for each of your local taxes. Use this routine to 
print local tax deposit checks. 

Post all transactions before entering the Local Deposit dialog box. The liability 
and deposit sections pull information from the Edit Employee Accumulations 
dialog box. Post all payroll transactions to ensure this information is current.

The Local Deposit dialog box holds information regarding the current and prior 
quarters. These fields are a record of transactions and are not accessible. Each 
deposit transaction updates the deposit record. Sage DacEasy uses this 
information to calculate the amount of the local deposit due. To view or print 
the deposit history, click History while on the Local Deposit dialog box.

Related Help Topic

• Recording a tax deposit for a manual check

To Make a Local Tax Deposit

1 Point to Tax Deposit on the Process menu, and then select Local. The Local 
Deposit dialog box appears.

2 Type the code of the local tax for which you are making a deposit or click 
LookUp to select a code from a list.

3 Select the quarter you want to make a deposit for using the Deposit For field. 
You can make a deposit for the prior, current or next quarter.

4 Complete the appropriate fields on the dialog box.

You can click Help from the Local Deposit dialog box for a detailed 
description of each field.

You can click Address to record the address of the institution to whom the 
check is payable.
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5 Click OK to save the local tax deposit.

If you selected Computer as the Check Type, the Report Layout dialog box 
appears so you can print the tax deposit check. After printing the tax deposit 
check, the Report Layout dialog box appears to print the GL Transaction 
Summary report.

If you use continuous-feed checks, click Test Page from the Report Layout 
dialog box to print a test check and verify the check is loaded properly. If you 
use this feature, the check number on the Local Deposit dialog box is 
voided.

If you selected Manual or None as the Check Type, a message appears 
confirming you want to continue. Choose Yes to continue. The Report 
Layout dialog box appears to print the GL Transaction Summary report.

6 Select the target and click OK to begin generating the report.

If an amount due exists for the prior quarter, a message appears. If you want 
to apply a portion of this deposit to the prior quarter, choose Yes. The deposit 
amount cannot be over the amount due for the prior quarter. If you choose 
No, Sage DacEasy applies the deposit to the current quarter.
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• Management Reporting •

Overview
This chapter contains information on printing Payroll’s management reports. 
The management reports available in Payroll provide you with the information 
you need to make decisions affecting your company. The management reports 
included in Sage DacEasy Payroll are the Employee Directory, Employee 
History, Detail report, New Hire, Transaction History and Codes History 
report. Sage DacEasy Payroll also allows you to print employee labels and 
integrate with Microsoft® Word. Integrating with Word means you can merge 
your payroll data into attractive Word documents that can be e-mailed or 
printed. 

Related Help Topics

• Changing the report layout

• Integrating with Microsoft Word

• Integrating with Microsoft Excel

Printing the Employee Directory Report
This report prints a copy of the information that appears on the Edit Employee 
Information and Edit Employee Accumulations dialog boxes. The format of 
this report is similar to the information that appears on these dialog boxes. 

Since the Employee Directory contains valuable information, it is a good idea to 
print and store a hard copy of this report at the end of each period. An example 
of the first page of the Employee Directory report is shown after these steps.

To Print the Employee Directory Report

1 Choose Directory on the Reports menu. The Employee Directory dialog 
box appears.

2 Select how you want the report sorted and type the range in the From and To 
fields.

3 Select how you want the report ranked and type the range in the From and To 
fields.

4 Select whether or not you want to include terminated employees on the 
report.
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You can click Help from the Employee Directory dialog box for a detailed 
description of each field.

5 Click OK. The Report Layout dialog box appears.

6 Select the target and click OK to generate the report.

Employee Directory Report

Printing Employee Labels
Sage DacEasy Payroll lets you print labels with your employees’ information. If 
you select to print Mailing labels, the employee name and address print. If you 
select to print Attendance Card labels, the employee name, code, title, 
department code and department description print.
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To Print Employee Labels

1 Choose Labels on the Reports menu. The Mailing Labels dialog box 
appears.

2 Select how you want to sort the labels and type the range in the From and To 
fields.

3 Use the the From and To fields to rank the labels and select the report range.

4 Complete the fields in the Filter Options area if necessary. 

This area includes options for indicating whether or not you want terminated 
employees included on the labels, and the pay types and the employee types 
you want to include in the labels you are printing.

5 Complete the fields in the Label Options area if necessary. 

This area includes options for the type of labels you are printing, the label 
format and the print mode you want to use for the labels you are printing.

You can click Help from the Mailing Labels dialog box for a detailed 
description of each field.

6 Click OK. The Report Layout dialog box appears.

For more information on editing the label layout, refer to the Help topic titled 
“Editing the Label Layout.”

To ensure your labels are loaded properly in your printer and your printer 
settings are correct, click Test Page.

7 Select your target and click OK to begin printing.

Related Help Topics

• Changing the report layout

• Aligning continuous-feed forms in the printer

• Editing the label layout

Printing the Employee History Report
Each time you change information on the Edit Employee Information dialog 
box regarding personnel information, Sage DacEasy updates the Employee 
History file. This report prints one employee per page and details the changes 
with corresponding dates. The report reflects information such as hire date, date 
of pay raise, review date, date of promotion and so forth.
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To Print the Employee History Report

1 Choose Employee History on the Reports menu. The Employee History 
dialog box appears.

You can click Help from the Employee History dialog box for a detailed 
description of each field.

2 Use the From and To fields to select sorting and selection options. 

3 Select how you want the report ranked and type the range in the From and To 
fields.

4 Select the Include Terminated Employees check box if you want to include 
terminated employees in the report.

5 Click OK. The Report Layout dialog box appears.

6 Select the target and click OK to generate the report.

Employee History Report

Printing the Detail Report
To print this report, you must select the Create Detail Report when Posting 
check box on the System Preferences dialog box. This option causes Sage 
DacEasy to accumulate specific data from the Posting routine in the Payroll 
History files. 
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This report comes in handy at the end of a quarter. It can print individual check 
information. You can use it to double-check your deposit amounts and 
information pertaining to the Form 941. Print the Transaction History or Codes 
History report for more detailed information regarding each payroll 
transaction. For more information on these reports refer to “Printing the 
Transaction History Report” on page 123 and “Printing the Codes History 
Report” on page 124.

Note: You can purge information from this report during the Close Quarter and 
Close Year routines. To purge information from the Detail report, select the 
Purge History check box on the Close Quarter and Close Year dialog box.

To Print the Detail Report

1 Choose Detail Report on the Reports menu. The Detail Report dialog box 
appears.

2 Select how you want the report sorted and type the range in the From and To 
fields.

3 Use the From and To fields to rank the report and set the report range.

4 Select the Include Terminated Employees check box if you want to include 
terminated employees in the report.

You can click Help from the Detail Report dialog box for a detailed 
description of each field.

5 Click OK. The Report Layout dialog box appears.

6 Select the target and click OK to generate the report.
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Detail Report

Printing the New Hire Report
In accordance with the Personal Responsibility and Work Opportunity 
Reconciliation Act of 1996 (PRWORA), all employers are required to report 
certain information on their newly hired employees to a designated state agency. 
Most states accept the W-4 Federal Form, but some states require additional 
information. The New Hire Report includes three report type options, the 
Worksheet, the W-4 Federal Form and the W-4+ Form. Print the W-4+ or the 
New Hire Worksheet if your state requires additional information. 

The Worksheet prints the information you need and allows you to complete the 
form manually. The W-4 Federal Form allows you to print the information on 
the preprinted form or on plain paper. The last option is the W-4+ Form. This 
form includes all the information on the W-4 Federal Form and the employee’s 
SUI account, hire date, birth date, state of hire, salary, gender, status and 
occupation. If you select to print the W-4+ Form, you can only print the federal 
form with the corresponding payroll data on plain paper.

To Print the New Hire Report

1 Choose New Hire Report from the Reports menu. The New Hire Report 
dialog box appears.

2 Select the Report Type. Type the Sort By range in the From and To fields.

3 Select how you want the report ranked and type the range in the From and To 
fields.
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You can click Help from the New Hire Report dialog box for a detailed 
description of each field.

4 Click OK. The Report Layout dialog box appears.

5 Select the target and click OK to generate the report.

To print the W-4 Federal Form or W-4+ Form on plain paper, select the Plain 
Paper check box on the Printer tab of the Report Layout dialog box. This 
feature requires Adobe® Acrobat® Reader®.

For more information on using the Publish option on the Report Layout 
dialog box, refer to Chapter 4, “Working With Sage DacEasy” in the 
Installation and New Features Guide.

New Hire Report-W-4 Federal Form
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New Hire Report-W-4+ Form

New Hire Report-Worksheet

Integrating With Microsoft Word
Sage DacEasy’s seamless integration with Microsoft Word allows you to merge 
your employee data with Word documents. Use this feature to create 
professional letters that include information from your payroll company. You 
can e-mail or print these documents directly from Sage DacEasy or access the 
document in Word to take advantage of the powerful features available in 
Word. You can merge a single record or a range of records. For more 
information on merging a single employee record with a Word document, refer 
to the Help topic titled “Integrating with Microsoft Word.”
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To Merge a Range of Employee Records With a Word Document

1 Select Mail Merge from the Reports menu. The Employee Mail Merge 
Jobs dialog box appears.

2 Type the name of the job in the Job Name field or click LookUp to select an 
existing job.

3 You can select an existing Word document, add a new Word document, or 
edit an existing document.

If you selected an existing job, the last associated Word document file name 
appears automatically.

To select an existing Word document, type the path and file name to an 
existing Word document or click the Browse button to locate the document.

To add a Word document, type a path and file name, and then click Edit. 

To edit an existing Word document, type the path and file name to an 
existing Word document or click the Browse button and locate the 
document. Click Edit; the document appears in Word. Edit the document as 
necessary, save the document, and then return to Sage DacEasy to continue 
with the mail merge.

4 Complete each field in the Filter/Sort Options area.

Select the type of employees included in the mail merge using the Include Pay 
Type option.

Select the Exclude Records Without an Address check box if you do not 
want to include the record in the mail merge if it does not contain an address.

Use the Employee Mail
Merge Jobs dialog box to

integrate Sage DacEasy
Payroll with Microsoft
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Select the Exclude Records Without an E-mail Address check box if you 
do not want to include the record in the mail merge if it does not contain an 
e-mail address.

Select the Suppress Blank Lines check box if you want to skip blank lines 
resulting from empty merge fields.

5 Merge the selected data with the Word document using any of the following 
methods.

Click Send E-Mail to e-mail the Word document to the range of employees.

Click Print to send the output to your printer.

Click View Job to view the output in Microsoft Word. You can use all 
Microsoft Word functionality as needed.

Printing the Transaction History Report
Follow these steps to print the Transaction History report. This report is 
designed similar to the Payroll Register, but includes only posted payroll 
transactions, whereas the Payroll Register includes only the unposted payroll 
transaction.

Note: The Transaction History report is a report added to Version 11. All payroll 
history information is recorded in detail format in the new Payroll History files 
and the Detail file. To view the payroll history information, print the 
Transaction History report or the Codes History report. You cannot use the 
Transaction History report to print payroll information prior to Version 11.

To Print the Transaction History Report

1 Choose Transaction History from the Reports menu. The Transaction 
History dialog box appears.

You can click Help from the Transaction History dialog box for a detailed 
description of each field.

2 Select how you want the report sorted and type the range in the From and To 
fields.

3 Select how you want the report ranked and type the range in the From and To 
fields.

4 Select the type of report you want to print.

5 Click OK to save the information. The Report Layout dialog box appears.

6 Select the target and click OK to generate the report.
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Transaction History Report

Printing the Codes History Report
Follow these steps to print the Codes History report. Use the Codes History 
report to print a report detailing a code’s activity in each payroll transaction. If 
you have added a code, but have not posted a payroll transaction using the code, 
the code is not available for viewing on the Codes History report.

Note: The Codes History report is a report added to Version 11. You cannot use 
the Codes History report to print payroll information prior to Version 11.

To Print the Codes History Report

1 Choose Codes History from the Reports menu. The Codes History dialog 
box appears.

You can click Help from the Codes History dialog box for a detailed 
description of each field.

2 Type the report layout name of the report you want to view. Click LookUp to 
select a report from a list. 

You can click Layout to add or edit a report layout for the Codes History 
Report.

3 Select how you want the report sorted and type the range in the From and To 
fields.

4 Select how you want the report ranked and type the range in the From and To 
fields.

5 Select the codes you want to view on the report and type a descriptive 
heading for each code.
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6 Click OK. The Report Layout dialog box appears.

7 Select the target and click OK to generate the report.

Codes History Report

Vacation/Sick time report
The Vacation/Sick time report lists one or more employees and the status of 
their vacation and sick time. You can sort and rank the report by Name, Code, 
or Department. You may also filter the report by providing From and To values 
for the sort and rank criteria you select.

Printing the Vacation/Sick time report

1 Select Vacation/Sick Time Report  from the Reports menu and the 
Vacation/Sick Time Status report front-end dialog box appears:

2 Select the field you want to use to sort the report. You can sort the vacation/
sick time status report by Employee Name, Employee Code, or Employee 
Department.
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3 If you want to setup a filter for the sort criteria you selected, enter a range of 

values in the From and To fields for the sort criteria. If you want to print all 
available records, leave the From and To fields empty.

4 Select the field you want to use to rank the report. You can rank the vacation/
sick time status report by Employee Name, Employee Code, or Employee 
Department.

5 If you want to setup a filter for the rank criteria you selected, enter a range of 
values in the From and To fields for the rank criteria. If you do not want to 
setup a filter on the rank criteria, leave the From and To fields empty.

Note: Sage DacEasy uses the sort criteria as the primary sort and hence a filter 
setup on this criterion takes precedence over a filter setup in the rank criteria. 

6 Click OK or press F10 to print the report.

Print 1096 Forms

Beginning with Sage DacEasy Accounting and Payroll Version 15 include the 
ability to print Federal Form 1096. The 1096 form, required by the Internal 
Revenue Service, contains the summary data of all 1099 forms that you sent to 
your vendors and contractors for the current year. This new Daceasy feature 
allows you to print the summary information for a batch of 1099’s directly into 
the 1096 form provided by the IRS. Once printed, the 1096 form is ready for 
sending to the Internal Revenue Service. 
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Creating a 1099/1096 batch

A 1099 batch consist of a run of 1099 forms that should be summarized into one 
1096 form. To create a 1099/1096 batch you must do the following:

1 Select Payables and then select 1099’s from the Reports menu in Sage 
DacEasy Accounting, or select Year End and then select Federal 1099’s from 
the Periodic menu in Sage DacEasy Payroll. The print 1099’s dialog box 
appears:

Note: Sage Daceasy Accounting prints all 1099’s in one batch and does not 
offer the sorting and ranking option that Sage DacEasy Payroll offers. 

2 If you are printing 1099’s from Sage DacEasy Payroll, 

a Enter the sort and rank fields and the From and To values for each one.

b Select the Print 1096 check box if you want to proceed to printing 1096 
immediately after printing the 1099’s.  

c Enter a batch identifier in the Batch Code field. (The Batch code is a 
unique identifier you assign to the batch of 1099’s you are printing. This 
batch code is used to select the batch for which you want to print the 
1096.)

d Click OK or press F10 to print the 1099’s.

3 If you are printing 1099’s from Sage DacEasy Accounting, 
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a Enter the Federal Tax ID, the State Tax ID, the Year, and the Minimum 

amount for printing 1099’s. 

b Select the Print 1096 check box if you want to proceed to printing 1096’s 
immediately after printing 1099’s.

c Enter a unique batch identifier in the Batch Code field.

d Click OK or Press F10 to print the 1099’s.

Note: Even though Sage DacEasy Accounting prints all 1099’s in one batch, it 
is still necessary to enter a batch code to identify a particular 1099 run. 

4 Select Payables and then select 1096’s from the Reports menu in Sage 
DacEasy Accounting, or select Year End and then select Federal 1096’s from 
the Periodic menu in Sage DacEasy Payroll. The print 1096’s dialog box 
appears.

5 Enter the Name, Telephone, and E-mail for the 1096’s contact person in your 
company. 

6 Select the batch code for which you want to print the 1096 forms. 

You can click on Help or Press F1 for more information on each field on the 
Print 1099’s dialog box.

You can click on the Lookup icon on the toolbar or press F5 to launch a 
lookup of existing batch codes.

7 Click OK or press F10 to print the 1096 forms.



7Periodic 
Operations

Checking for Tax Updates Online 130

Printing W-4s 131

Reconciling Checks 132

Purging Checks 134

Closing the Month 135

Printing State Quarterly Reports 135

Printing State Quarterly Worksheets 136

Printing the 941 137

Printing the Schedule B 138

Closing the Quarter 139

Printing the 940 140

Printing W-2s 141

Printing the W-3 142

Printing 1099s and 1096s 143

Creating Magnetic Media Files 144

Closing the Year 145



Periodic Operations
Sage DacEasy Payroll User’s Guide

130

7

• Periodic Operations •
Periodic operations refer to activities you only need to perform occasionally, 
such as once a month, a quarter or a year. For example, you usually reconcile 
your payroll checks once a month. 

This chapter explains how to print reports, forms and worksheets that coincide 
with certain closing routines, such as month end, quarter end and year end. The 
following routines are explained in this chapter.

• Checking for online tax updates

• Reconciling checks

• Purging checks

• Closing the month, quarter and year

• Printing State Quarterly reports and worksheets

• Printing forms such as the W-2, W-3, W-4, 1099, 941, Schedule B and 
940

• Creating W-2 Magnetic Media files

Checking for Tax Updates Online
The Online Tax Update feature allows you to periodically check the Sage 
DacEasy Web site for the latest Payroll Tax Updates for your program. For more 
information on this feature, contact the Sage DacEasy Sales division at (800) 
987-5212. To access the Online Tax Updates dialog box, choose Online Tax 
Updates on the Periodic menu.

To Set Up Sage DacEasy Payroll to Automatically Check for Tax 
Updates

1 Choose Online Tax Updates from the Periodic menu. The Online Tax 
Updates dialog box appears.

Use the Online Tax Updates
dialog box to set up payroll

to automatically check for
the latest tax updates on

the Web.
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2 Type your Account ID.

3 Select how often you want to check for new Tax Update program files. Select 
Monthly or Quarterly if you want Sage DacEasy to automatically check for 
new Tax Update program files. Select Do not check if you want to check for 
new Tax Update program files manually.

4 Click Save to save the changes.

To Check for Tax Updates Manually

1 Choose Online Tax Updates from the Periodic menu. The Online Tax 
Updates dialog box appears.

2 Type your Account ID.

3 Click Check Now. 

4 The Sage DacEasy Online Tax Update Welcome screen will be minimized on 
the taskbar.  Select it to view the available updates.

Note: Even if you have Sage DacEasy set up to check for Tax Updates 
automatically, you can still use the Check Now button to manually check for 
new tax updates at any time.

Printing W-4s
Sage DacEasy allows you to print the W-4 Federal Form. Use this feature to print 
the federal form with your employee’s information. If you need to print 
additional information on the W-4 form, refer to “Printing the New Hire 
Report” on page 119.

Related Help Topic

• Printing a New Hire report
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To Print the W-4s

1 Choose W4 Forms from the Periodic menu. The Form W-4 dialog box 
appears.

2 Type the Sort By range in the From and To fields.

3 Select how you want the report ranked and type the range in the From and To 
fields.

You can click Help from the Form W-4 dialog box for more information on 
each field.

4 Click OK to save the information. The Report Layout dialog box appears.

If you want to print the W-4 Federal Form on plain paper, select the Plain 
Paper check box on the Printer tab of the Report Layout dialog box. This 
feature requires Adobe® Acrobat® Reader®. 

5 Select the target and click OK to generate the report.

Reconciling Checks
You can reconcile checks and direct deposits in Sage DacEasy Payroll if you do 
not select the Erase Check Register After Posting and Reconcile With Sage 
DacEasy Accounting check boxes on the System Preferences dialog box. 

Use the Reconcile Checks routine to keep track of outstanding, cleared and 
voided direct deposit payments and payroll checks. A message appears if you try 
to view the Check Register routine and no checks or direct deposits are in the 
Check Register file. You can access this routine only if you have direct deposits 
or printed checks, or have posted manual checks in Sage DacEasy Payroll.

Use the Form W-4 dialog
box to set the sort and rank

options for the forms.
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When you access this routine, all checks appear in check number order along 
with the check date, employee code and name and the amount of the check. 
Direct deposits are indicated by the “D” preceeding the transaction number in 
the Number column. The following steps explain how to use this routine to 
reconcile your bank account.

If you are using the Direct Deposit feature and want to reconcile direct deposit 
transactions, you must select the Reconcile Direct Deposit Advices check box 
on the Payment Settings tab of the System Preferences dialog box.

To Reconcile Checks

1 Point to Reconciliation on the Periodic menu, and then choose Reconcile 
Checks. The Check Reconciliation dialog box appears.

2 Select the entry you need to mark as cleared or void and choose the 
appropriate option in the Status column.

If you marked the entry as cleared, the word “Clear” appears in the Status 
column. If you marked the entry as void, the word “VOID” appears in the 
employee’s name and Void appears in the Status column.

Note: Once you change the status of an entry to Void and save the 
Reconciliation, you cannot change the status of the entry back to Cleared or 
Outstanding.

3 Repeat step 2 until all entries are marked appropriately.

You can click Help from the Check Reconciliation dialog box for a detailed 
description of each field.

4 Click OK to update the Check Register. 

Use the Check
Reconciliation dialog box to

mark an entry as cleared,
void or outstanding.
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Purging Checks

Depending on the number of checks you issue, you may want to purge checks 
in Sage DacEasy Payroll once a month. Purging checks allows you to either 
delete voided and cleared checks or delete all checks. Run this routine at the end 
of the month to clear the file of excessive data buildup and to preserve hard disk 
storage space. 

Tip: If you have sufficient hard disk space, save all information in the Check 
Register file. By saving all the information, you can print quarterly, semiannual 
or annual Check Register reports during the year. 

Note: Be sure to make a backup of your payroll data before you purge the detail 
in the Check Register file. You can restore this backup to review archived data.

To Purge Checks

1 Point to Reconciliation on the Periodic menu, and then choose Purge 
Checks. The Check Register Purge dialog box appears.

2 Select whether you want to purge only Cleared and Void checks or purge All 
checks prior to the date entered.

Note: If you need a record of the checks being purged from the Check 
Register file, print a Check Register report and make a backup of your payroll 
data before continuing with the Purge Checks routine.

3 Type the date prior to which the payroll checks should be deleted. The checks 
printed before the date entered are purged from the Check Register file.

4 Click OK to remove the checks from the Check Register file.

You can run the Recover routine on the Check Register file after you run the 
Purge routine. The Recover routine compresses your files and frees up hard 
disk drive space.

Use the Check Register
Purge dialog box to purge

checks from the Check
Register.
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Closing the Month

This routine clears and prepares all monthly fields on the Edit Employee 
Accumulations dialog box to receive transactions for the next month. You 
should run this routine prior to posting the first payroll of each month.

To Close the Month

1 Choose Month End on the Periodic menu. The Close Month dialog box 
appears.

2 Click Backup. The File Backup/Restore dialog box appears. Make a backup 
of your payroll data. After the Backup routine is complete, the Close Month 
dialog box appears again.

3 Click OK to close the month. 

Note: Closing the month is not a requirement to run Quarter End and Year End.  

Printing State Quarterly Reports
Sage DacEasy lets you print a Form 9413 or 9414 to use as a source document 
for state governmental reporting requirements. Print the report after posting 
the last payroll for the quarter and before closing the quarter. If you close the 
quarter before printing this report, you must restore a backup to recover the 
information. The State Quarterly Report routine prints the Form 9413 or 9414 
on preprinted forms. If you want to complete the forms manually, use the State 
Quarterly Worksheet routine to print the worksheet. Contact your state 
employment agency to find out where you can get the preprinted forms.

It is important to contact your state employment agency before printing a 
quarterly report because different states have different requirements. Although 
you should be able to use this routine to submit Forms 9413 or 9414 in a 
majority of states, some states do not accept these forms. 

Note: Some states only accept Optical Character Reader (OCR) forms for their 
quarterly reports. Sage DacEasy does not currently provide the ability to print 
OCR reports.

If you need to process a payroll for the next quarter before printing your state 
quarterly reports, be sure to enter the check date in the next quarter on the Pay 
Frequency dialog box. Sage DacEasy stores the payroll in the Next Quarter 
column on the Edit Employee Accumulations dialog box.
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To Print a State Quarterly Report

1 Point to Quarter End on the Periodic menu, and then choose State 
Quarterly Report. The State Quarterly Report dialog box appears.

2 Complete the fields on the dialog box.

You can click Help from the State Quarterly Report dialog box for more 
information on each field.

3 Click OK to continue. The Report Layout dialog box appears.

4 Select the target and click OK to generate the form.

Printing State Quarterly Worksheets
Use the State Quarterly worksheet as a source document for forms submitted to 
your state agencies as required by state governmental reporting requirements. 
Print the worksheet after posting the last payroll for the quarter and before 
closing the quarter. If you close the quarter before printing this worksheet, you 
must restore a backup to recover the information.

It is important to contact your state employment agency to determine what type 
of quarterly form you must provide; different states have different 
requirements. Acquire the appropriate state forms before running this routine. 
Print the State Quarterly worksheet to help you complete the forms.

Note: Some states only accept Optical Character Reader (OCR) forms for their 
quarterly reports. Sage DacEasy does not currently provide the ability to print 
OCR reports.

If you need to process a payroll for the next quarter before printing your state 
quarterly worksheet, be sure to enter the check date in the next quarter on the 
Pay Frequency dialog box. Sage DacEasy stores the payroll in the Next Quarter 
columns on the Edit Employee Accumulations dialog box. 
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To Print a State Quarterly Worksheet

1 Point to Quarter End on the Periodic menu, and then choose State Qtrly 
Worksheet. The State Quarterly Worksheet dialog box appears.

2 Type the range of state codes you want included in the worksheet.

You can click Help from the State Quarterly Worksheet dialog box for 
more information on each field.

3 Click OK to continue. The Report Layout dialog box appears.

4 Select the target and click OK to generate the worksheet.

Printing the 941
This routine prints the federal tax return you must submit to the IRS at the end 
of every quarter. You need to print the 941 before closing the quarter. If you 
close the quarter before printing this form, restore the backup made just prior 
to closing the quarter to recover the information.

Each time you run the Posting routine, Sage DacEasy updates the 941 file with 
all the information necessary to print out the ROFT (Record of Federal Tax 
liability) section of the form. The top section of the 941 prints based on 
information stored on the Edit Employee Accumulations dialog box. When 
viewing the 941 form, the information tracked by Sage DacEasy appears, but 
you can edit these amounts. You can also enter additional information 
including adjustments that Sage DacEasy does not track.

If you need to process a payroll for the next quarter before printing your 941, be 
sure to enter the check date in the next quarter on the Pay Frequency dialog box. 
Sage DacEasy stores the payroll in the Next Quarter columns on the Edit 
Employee Accumulations dialog box.

Related Help Topic

• Aligning continuous-feed forms in the printer

Use the State Quarterly
Worksheet dialog box to

select the information you
want to print on the report.
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To Print the 941

1 Point to Quarter End on the Periodic menu, and then choose Form 941. 
The Form 941 dialog box appears.

2 Select whether you want to print the federal form or the worksheet.

3 Type a name in the Name field if it is different from the trade name.

The information on the form automatically appears pulling the information 
from the Edit Company dialog box and the employee records.

4 Make changes to the amounts on the form if necessary. 

5 Select whether you are a Semiweekly or Monthly depositor.

You can click Help from the Form 941 dialog box for more information on 
each field.

6 Click OK to continue. The Report Layout dialog box appears.

Note: If you selected Federal Form as the Type, you have the option to print 
the form on plain paper. To print the form on plain paper, select the Plain 
Paper check box on the Report Layout dialog box. This feature requires 
Adobe® Acrobat® Reader®. If you are printing the form on a preprinted form, 
do not select this option.

Tip: If printing on continuous-feed preprinted forms, click Test Page from the 
Report Layout dialog box to print a test form and verify the form is loaded 
properly.

7 Select the target and click OK to generate the form.

Printing the Schedule B
The Schedule B prints a report of your tax liability on a daily basis. You must 
complete this schedule if you are required to deposit on a semiweekly basis or if 
your tax liability on any day is $100,000 or more. You must show tax liability, 
not deposits on this form. If you are starting to use your Payroll company in the 
middle of a quarter, the amounts will be incorrect because the 941 file is updated 
during the Posting routine. Therefore, you must manually enter the amounts 
according to the day on the form.

You need to print the Schedule B before closing the quarter. If you close the 
quarter before printing this form, restore the backup made just prior to closing 
the quarter to recover the information.
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To Print the Schedule B

1 Point to Quarter End on the Periodic menu, and then choose Schedule B. 
The Print Schedule B dialog box appears.

2 Select whether you want to print the Federal Form or Worksheet.

3 Click OK to continue. The Report Layout dialog box appears.

Note: If you selected Federal Form as the Type, you have the option to print 
the form on plain paper. To print the form on plain paper, select the Plain 
Paper check box on the Report Layout dialog box. This feature requires 
Adobe® Acrobat® Reader®. If you are printing the form on a preprinted form, 
do not select this option.

4 Select the target and click OK to generate the form.

Closing the Quarter
This routine clears and prepares all quarterly fields on the Edit Employee 
Accumulations dialog box to receive transactions for the next quarter. You can 
still post payroll transactions into the next quarter before you close the current 
quarter. If you select the Purge History check box, you can also clear 
information from the Payroll History files during the Close Quarter routine. 
Print hard copies of the Payroll History files using the Transaction History, 
Codes History and Detail reports to archive before purging the information.

When you close the quarter, Sage DacEasy moves the accumulations held in the 
Next Quarter column to the Quarter columns on the Edit Employee 
Accumulations dialog box.

If the current quarter on the Edit Company dialog box is the fourth quarter of 
the year, run the Close Year routine. The Close Year routine closes both the 
quarter and year at the same time.

To Close the Quarter

1 Point to Quarter End on the Periodic menu, and then choose Close 
Quarter. The Close Quarter dialog box appears.

2 Click Backup. The File Backup/Restore dialog box appears. Make a backup 
of your payroll data. After the Backup routine is complete, the Close Quarter 
dialog box appears again.

3 Select the Purge History check box if you want to clear information from the 
Payroll History files. If you select this option, type the date through which you 
want to purge information.
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4 Click OK to close the quarter.

Note: If a message appears stating you have a tax liability balance for the 
quarter and you are not using the Tax Deposit module, continue through this 
message to close the quarter. If you are using the Tax Deposit module, exit the 
Close Quarter routine and make any necessary tax deposits.

Printing the 940
This routine prints a 940. You can print the form or a worksheet to help you fill 
out your annual federal unemployment (FUTA) tax return, which you must 
submit to the IRS at the end of each year. The 940 pulls information from the 
Edit Employee Accumulations dialog box and the ROFT (Record of Federal Tax 
liability) in the 940 file, both of which Sage DacEasy updates during the Posting 
routine. Because Sage DacEasy clears the ROFT information during the Close 
Year routine, it is important to print out your 940 before you close the year. 

Information on SUI and FUTA wages, total payments, excess over limit and 
FUTA tax for each quarter with a total for the year is available when printing the 
940 worksheet. This information prints in the same format as the actual 940 
form, but it also includes line detail as well as the dollar amounts.

To Print the 940

1 Choose Year End on the Periodic menu, and then choose 940 to open the 
Form 940 dialog box.

Note: If you have employees in more than one state, you cannot file a 940 
form. For more information regarding 940 form, refer to the IRS Circular E Tax 
Guide.

2 Select whether you want to print the form or the worksheet and type a name 
in the Name field if it is different than the trade name. The information on the 
form appears pulling the information from the Edit Company dialog box and 
the employee records.

3 Make changes to the amounts on the form if necessary. 

You can click Help from the Form 940 dialog box for more information on 
each field.

4 Click OK. The Report Layout dialog box appears.

Note: If you selected Federal Form as the Type, the Plain Paper check box is 
selected. This option prints the entire federal form with the data on plain 
paper. This feature requires Adobe® Acrobat® Reader®.

5 Select the target and click OK to generate the form.
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Printing W-2s

This option prints continuous-feed or laser W-2 forms in the format prescribed 
by the Internal Revenue Service. You can purchase these forms from the Sage 
DacEasy Forms division by calling (800) 222-0505.

Tip: The federal government periodically changes the format of W-2 forms 
during the year. If you know the form was changed since your last upgrade or 
purchase of Sage DacEasy Payroll, you need to get a Tax Update from Sage 
DacEasy to print W-2 forms correctly. This Payroll Tax Update is available in 
December, allowing Sage DacEasy to include all new tax laws. Contact the Sage 
DacEasy Sales department at (800) 987-5212 for more information on the 
Payroll Tax Update.

You must print W-2 forms before running the Close Year routine. If you run the 
Close Year routine before printing W-2 forms, you must restore the backup 
made immediately prior to running the Close Year routine to retrieve the 
information.

If you need to process a payroll for the next year before you print your W-2 
forms, simply enter dates for the next year on the Pay Frequency dialog box. 
Refer to Chapter 5, “Processing Payroll” for more information on the Pay 
Frequency dialog box. If you process a payroll in the next quarter before you 
close the year, Sage DacEasy stores this data in the Next Quarter columns on the 
Edit Employee Accumulations dialog box.

Note: Employers who are not filing magnetic media must file a paper Copy A of 
Form W-2 with the Social Security Administration. Copy A is only available in 
the standard 2-Up format. To print this form, choose Year End on the Periodic 
menu, and then choose W2 Forms. When the Print W-2 dialog box appears, 
choose 2-Up as the type of form you want to print.

Employers who are filing magnetic media do not file a Copy A form with the 
Social Security Administration and may use any of the W-2 form types. 
Therefore, any of the three W-2 form options may be selected. 

Related Help Topics

• Aligning continuous-feed forms in the printer

• Customizing W-2s

To Print W-2s

1 Choose Year End on the Periodic menu, and then choose W2 Forms. The 
Print W-2 dialog box appears.

2 Select the type of W-2 form you are printing. 
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Note: The 2-Up option allows you to print on continuous-feed or laser forms. 
The 4-Up and 4-Up Horizontal options only print on laser forms.

3 Complete the remaining fields on the dialog box.

Note: Select the Custom Design check box if you need to customize your W-
2s.

You can click Help from the Print W-2 dialog box for more information on 
each field.

4 Click OK to save the information. The Report Layout dialog box appears.

Note: If you selected the Custom Design check box, the Custom Design 
W2s dialog box appears. Complete the fields as necessary and click OK to 
continue.

5 Select the target and click OK to generate the forms. 

6 Follow the instructions on each screen to continue.

Note: The option to print a second set of W-2s and a W-3 form is available 
after printing the first set of W-2s.

Tip: Click Test Page from the Report Layout dialog box to print a test form 
and verify the form is loaded properly.

Troubleshooting

If your W-2 forms jam in the printer during printing, you can use the sort and 
rank options to print only a selected range of W-2 forms. If you experience a 
jammed printer or a break in the continuous forms, you can reprint just that 
section of the forms, rather than printing the whole batch again.

Printing the W-3
The W-3 form is a summary for the employer of the information printed on the 
W-2 forms. You have the option to print the W-3 form automatically after you 
print the W-2 forms. However, you can print just the W-3 form at any time. 

To Print the W-3

1 Choose Year End on the Periodic menu, and then choose W3 Forms. The 
Print W-3 dialog box appears.

2 Complete the fields on the dialog box as necessary.

3 Click OK. A message appears asking you to insert the form and begin 
printing.
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4 Click Continue to print the W-3 form. The Report Layout dialog box 

appears.

You can click Test Page from the Report Layout dialog box to print a test 
form and verify the form is loaded properly.

5 Select the target and click OK to print the W-3 form.

Printing 1099s and 1096s
This routine prints laser or continuous-feed 1099 forms in the format 
prescribed by the Internal Revenue Service. You must purchase laser or 
continuous perforated forms for federal/state reporting before running this 
routine. You can purchase these forms from the Sage DacEasy Forms division 
by calling (800) 222-0505.

Sage DacEasy prints out 1099 forms for contract labor employees based on the 
dollar limit you specify when printing 1099 forms. You also have the option of 
printing subtotals. If you select this option, every 42nd 1099 form prints a 
subtotal of the previous 41 1099 forms printed.

You must print 1099 forms before you close the year. If you close the year before 
printing these forms, you must restore a backup to recover the information.

Related Help Topics

• Aligning continuous-feed forms in the printer

• Customizing 1099s

To Print 1099s

1 Choose Year End on the Periodic menu, and then choose Federal 1099. 
The Print 1099 dialog box appears.

2 Complete the fields on the dialog box as necessary.

You can select the Custom Design check box if you need to customize your 
1099s.

You can click Help from the Print 1099 dialog box for more information on 
each field.

You may also print the 1096s at this time.  They will print after the 1099s 
have printed.

3 Click OK to save the information. The Report Layout dialog box appears.
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Note: If you selected the Custom Design check box, the Custom Design 
1099s dialog box appears. Complete the fields as necessary and click OK to 
continue.

4 Select the target and click OK to generate the forms. 

5 Follow the instructions on each screen to continue.

Note: The option to print a second set of 1099s is available after printing the 
first set of 1099s.

Tip: Click Test Page from the Report Layout dialog box to print a test form 
and verify the form is loaded properly.

Troubleshooting

If your 1099 forms jam in the printer during printing, you can use the sort and 
rank options to print only a selected range of 1099 forms. If you experience a 
jammed printer or a break in the continuous-feed forms, you can reprint just 
that section of the forms rather than print the whole batch again.

In addition, you can choose whether or not to print subtotals for your 1099 
forms. If you are reprinting a range, you may not need to print subtotals. If you 
do need to reprint the subtotal, make sure you include the whole range of 
employees from the last printed subtotal.

Creating Magnetic Media Files
The federal government requires you to file W-2 forms in a magnetic media file 
if you have more than 250 employees. You must register with the Social Security 
Administration in order to submit a magnetic media file. Sage DacEasy prints 
the W-2 forms to a file that meets the Magnetic Media file requirement set by 
the Social Security Administration.

In addition, Sage DacEasy automatically includes your state records in the 
magnetic media file. If you are required to file magnetically with your state, you 
can copy the same file to another floppy disk and send that file to your state’s 
taxing authority. 

Note: You must save the W-2 magnetic media file to a disk before you close the 
year. If you close the year before creating this file, you must restore a backup to 
recover the information.

To Create a Magnetic Media File

1 Choose Year End on the Periodic menu, and then choose W2 Magnetic 
Media. The Magnetic Media dialog box appears.

2 Complete the fields on the dialog box.
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You can click Help from the Magnetic Media dialog box for more 
information on each field.

3 Click OK to continue. A message appears confirming you want to create the 
W-2 magnetic media file. Click Continue.

The W-2 magnetic media file is created and stored in the path entered. The 
name of the file is W2REPORT.  You may copy this file to different media 
types, such as to a “thumb” drive, compact disk, a folder on the desktop.

Closing the Year
This routine clears year-to-date accumulations on the Edit Employee 
Accumulations dialog box so Sage DacEasy can begin to record accumulations 
for the next year. If you select the Purge History check box, you can also clear 
information from the Payroll History files during the Close Year routine. Print 
hard copies of the Payroll History files using the Transaction History, Codes 
History and Detail reports to archive before purging the information. Print all 
necessary quarterly and yearly reports before running this routine. This includes 
the State Quarterly Report, 941, Schedule B, 940, W-2s, W-3 and 1099s. In 
addition, the Current Quarter field must be 4 on the Edit Company dialog box 
before you can close the year.

If you enter and post transactions for the next quarter while in the fourth 
quarter, Sage DacEasy posts these transactions into the Next Quarter columns 
and transfers them to the Quarter or Year columns when you run the Close Year 
routine.

Note: Be sure to make a backup of your payroll data before closing the year. This 
is important because you cannot access a previous year once the year is closed. 
You also want to make a backup if you need to retrieve any yearly accumulations 
especially if you select to purge history during the Close Year routine.
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To Close the Year

1 Point to Year End on the Periodic menu, and then select Close Year. The 
Close Year dialog box appears.

Note: You are only able to run the Close Year routine if you are currently in 
the fourth quarter. To check the current quarter, choose Company on the 
Edit menu.

2 Make any necessary selections on the dialog box.

3 Select the Purge History check box if you want to clear information from the 
Payroll History files. If you select this option, enter down to the Purge Through 
and type the date through which you want to purge information.

4 Click OK to close the year.

Use the Close Year dialog
box to run the Close Year

routine.
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• Custom Reporting •

Overview
Reporting is one of the most important aspects of any business because reports 
inform you of the stability and profitability of your business. Sage DacEasy 
includes a custom reporting feature, called DacAccess, that gives you the ability 
to create informative reports to fit your specific needs. There are two steps to 
creating a custom report: selecting the records included in the report using the 
Query and defining the layout of the report using the Publisher.

The Query lets you choose up to ninety-six fields from multiple files to include 
on a report. The Publisher lets you create the report format, using fields selected 
in your Query. With the Query and Publisher, you can create listing reports with 
unprecedented detail. In addition, the Query and Publisher include many 
default reports ready for you to use.

Data is organized in a hierarchy from general to specific. Each level is defined in 
the list provided.

Follow these steps to create
a custom listing report

using DacAccess.
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Terms Used in This Chapter

• Catalog - A catalog is the largest grouping of data. It contains an 
associated group of files that contain related fields. For example, the 
Employee Listings catalog contains files such as Employees, 
Transactions, Time Card Entries, Detail Pay History, Departments and 
Codes.

• File - A file is a group of associated records. For example, information 
about individual employees is in the Employee file.

• Record - A record is a group of related fields. For example, all the 
information found on the Edit Employee Information and Edit 
Employee Accumulations dialog boxes for one employee is considered 
a record.

• Field - A field is the lowest level of data. A field is each piece of 
information that makes up a record. For example, the Title field on the 
Edit Employee Information dialog box is part of the employee record.

Fields are referred to in the Query and Publisher because you select 
fields to include on your report.

• Variable - A variable is a placeholder or merge field which pulls 
information from a specified file.

This figure illustrates the
terms used to define data

when creating a query.
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Using the Query

The first step in generating a custom report is to choose the information you 
want to include on the report using the Query in DacAccess. Go to the Query by 
choosing Query on the DacAccess menu. Use this feature to create a query with 
information from a variety of fields in several different files. You can even create 
user defined fields with calculated totals using information pulled from multiple 
files. 

A query is a way of questioning or filtering a database. For example, you have a 
collection of records in your Employee file. You may want to print a report that 
filters out deductions made from gross earnings in the last pay period. The 
remaining list of deductions—those deductions not used in the last pay 
period—is the data set you want to use in a report. In addition to limiting the 
records you want to print on a report, you also use queries to select the specific 
fields you want on a report, to sort the records and to create user defined 
calculations.

The Query Design dialog box is divided into three main areas, the Header area, 
Column Selection area and the Sort Columns area. The Header area includes the 
fields for the Query name and catalog. The Column Selection area is where you 
select the fields and the criteria determining which records to pull for the query. 
The Sort Columns area is where you set the sorting order of the report. 
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Using the Query Checklist

 Step 1—Complete the Header area with the query name and catalog.

 Step 2—Select the fields for the query in the Column Selection area. Enter 
user defined fields and set criteria for the fields if necessary.

 Step 3—Set the sorting order in the Sort Columns area.

 Step 4—Run the query to create a report listing the selected records.

Completing the Header Area

When you access the Query Design dialog box, you must enter a unique name 
for the query. When you give the query a name, a list of all available catalogs 
appears. A catalog holds associated files that contain related fields. For example, 
the Banking catalog includes the Employee, Check Register, Detail, Payroll 
History, Departments and Department Detail files.
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Selecting Fields in the Column Selection Area

After you select a catalog, advance to the Column Selection area and choose 
fields from the files in the catalog. You do not have to include all fields in the 
query in the report layout. However, to use a field in a user defined column or 
for sorting purposes, you must select the field in a column. For example, you 
may select review date in your query so you can sort your records on the report 
by the employee’s review date. However, you do not care to see the review date 
on the report. Therefore, even though you include the field on the query, you do 
not use that field when you create the report layout in the Publisher.

Each column on the Query Design dialog box can hold a field from a file in the 
catalog. You can fill up to ninety-six columns with field information. The 
columns scroll as you move to the right. Press Home to quickly return to the 
first column. The first row of the Column Selection area displays the names of 
the fields you select for the query. 

Selecting the Sort Order for the Query

Once you select your fields and set the criteria, you can specify the sorting order 
for the records included in the query. The sort fields define the order in which 
the records appear on the report. You have up to four sorting levels. If you do 
not specify a sorting order, Sage DacEasy sorts by the field in the first column.

Use the Header area of the
Query Design dialog box to
enter the query name and

select a catalog.

Select the fields and records
to include on the query in

the Column Selection area.
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To Create a Query

1 Select Query from the DacAccess menu. The Query Design dialog box 
appears.

2 Assign the query a unique name (up to 14 characters). If you are editing an 
existing query, type the name of the query or click LookUp and select the 
query from the list.

3 Select the catalog that contains the files you need for the report. The cursor 
advances to the first row of the Column Selection area. Use this row to select 
the fields to include in the query.

The columns scroll as you move to the right. You can press Home to return to 
the first column.

4 Click LookUp to view the Table LookUp. Select the table that contains the 
field to include in the current column and the Column LookUp appears. Select 
the field to include in the current column.

Tip: In addition to selecting fields from the data files, you can create formulas 
to include on the report. For more information, refer to “Creating User 
Defined Fields” on page 154. Each field included in the user defined field 
must be included in the query, in addition to any fields selected as sort fields. 
You can exclude the field from the printed report using the Publisher. 

Note: When you click LookUp from the Column Selection area, the Column 
LookUp appears for the last Table that was selected. To select a field from a 
different table, click the Close button to return to the Table LookUp.

5 To edit the Column Heading on the printed report, click Options, and then 
select Edit Column. You can edit the Title field; however, the new column 
title only appears when you run the query and does not appear on the Query 
Design dialog box.

Use the Sort Columns area
to indicate the order you
want the information to

appear in the query.
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6 If necessary, limit the records to include on the query. The second and third 

rows in the Column Selection area determine which records to include on the 
report. If you leave these rows blank, Sage DacEasy includes all records in the 
query. For more information, refer to “Limiting Records on a Query” on page 
155.

7 If you want to set the sorting order, click Options, and then select Sort 
Columns. The cursor advances to the first field in the Sort Columns area. 
Click LookUp and select the primary sort field for the report. To add a 
secondary sort, enter a different field in the second field in the Sort Columns 
area. You can enter up to four sort fields. 

Note: If you do not specify a sorting order, Sage DacEasy sorts by the field in 
the first column.

Tip: Click Switch Sort to toggle between ascending and descending order 
for the selected sort field.

8 Click Run Query to view the query to the screen. Click the Close button to 
return to the Query Design dialog box.

Tip: To redirect the report to the printer, click Print while viewing the query 
on the screen.

9 Click OK to save the query.

Note: Use the Publisher to define the report layout and view subtotal and 
grand total amounts. For more information on the Publisher, refer to “Using 
the Publisher” on page 161.

Creating User Defined Fields

Besides selecting predefined fields from a file for your query, you can also define 
your own fields. By creating user defined fields, you can calculate mathematical 
operations using one or more fields. 

For example, if you wanted to calculate Social Security liabilities for tax 
purposes, you could define a field called SS_WH_and_Liab and enter a formula 
of SOCSECWHQTD (Social Security withholding, quarter to date) + 
SocSecLiabQTD (Social Security liability, quarter to date). Before you can use a 
field in a formula for a user defined field, you must first select the field as a 
column in the Column Selection area on the query. 

To create a user defined field, place the cursor in a column in the Column 
Selection area. Click Options, and then select Edit Expressions. The User 
Defined Field dialog box appears.
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To Create a User Defined Field

1 Click Options and select Edit Expression from the Column Selection area on 
the Query Design dialog box. The User Defined Field dialog box appears. 

2 Type a name and description for the user defined field.

3 Type the expression. To select a field, enter the field name or click LookUp 
and select the field from a list. For example, to divide the current balance by 
12, enter Current Balance/12.

Note: To use a field in a formula, you must first select the field as a column. In 
addition, the field must be a decimal or numeric field. 

4 Click OK to save the user defined field.

Note: Once the user defined field has been created it is added to the User 
Defined Fields table and can be added to the query.

Limiting Records on a Query
The second and third rows in the Column Selection area on the Query Design 
dialog box determine which records to include on the report. If you leave these 
rows blank, Sage DacEasy includes each record in the query. You can limit 
records in a query by entering criteria and by editing the join.

To limit records by entering criteria, enter a particular field value or conditions 
that must be met in order for a record to be included in the query.

Use the User Defined Field
dialog box to calculate

values needed for a custom
report.
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When you create a query that pulls from two files, the query includes only those 
records that include the join field. The join field is used to tie multiple files 
together. For example, the department number exists in both the Employee file 
and the Department file, allowing you to create a query that pulls information 
from both of these files. The program defaults to an equi-join; however, you can 
edit the query to include all of the records from one file plus the records from 
the second file that include the join field.

Establishing Criteria

When you select fields for your query, you are limiting the information to 
include in the query. You can further limit the records included on the report by 
placing criteria on the fields. You can enter a value as the criterion, indicating 
only fields that contain this value are included in the query. You can also enter 
an expression using logical operators to indicate the fields to include in the 
query. 

For example, to include employees with a review date of 05/15/2003 or prior, 
select Review Date (ReviewDate) as a field and enter <=05/15/2003 (less than or 
equal to 05/15/2003) as the criterion. The logical operator table provided lists 
the available operators and an example of how to use each.

You can enter multiple criteria on a single query. The relationship of your 
criteria depends on the rows in which you enter the criteria. There is an OR 
relationship between rows and an AND relationship between columns. Sage 
DacEasy satisfies all AND criteria before satisfying the OR criteria.
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Understanding AND/OR Logic

The placement of your criteria in the columns and rows is very important. There 
is an OR relationship between rows and an AND relationship between columns. 
Sage DacEasy satisfies all AND criteria before satisfying the OR criteria.

Use the rows and columns
in the Column Selection

area to establish criteria for
the query.

Using the example above,
AND logic means that

records have to meet both
the criteria for city and

review date in order to be
included in the query.
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For example, if you use the Employee Listings catalog and want to include 
employees that live in Dallas OR that have a review date before May 15, 1999, 
you would enter the column selections and criteria as shown in Figure 8-12. This 
would give you a query including both all the employees in Dallas in addition to 
all the employees with a review date before May 15, 1999 (records that meet 
both criteria are not duplicated). 

On the other hand, if you use the Employee Listings catalog and want to include 
employees that live in Dallas AND that have a review date before May 15, 1999, 
you would enter the column selections and criteria as shown in Figure 8-13. This 
would give you a query of all the employees in Dallas with a review date before 
May 15, 1999. 

Using the example above,
OR logic means that records

have to meet either the
criteria for city or the

criteria for review date to
be included in the query.

Query selections for
employees that live in Dallas

or have a review date
before May 15, 1999.
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Understanding Joins

A join is a link between two files. For example, assume you want to print a report 
pulling the employee code, employee name and 401k deductions for the pay 
period. The employee name is stored in the Employee file and the employee’s 
401k deductions for the pay period are found in the Transaction file. The 
employee code is found in both files. Therefore, employee code is the link 
between the two files or the join.

There are three different types of joins: equi, left outer and right outer.

• Sage DacEasy uses the equi-join by default, which includes only records 
found in both files. Using the example above, Sage DacEasy only 
includes employees with an entry found in both the Employee file and 
the Transaction file.

• If you select a left outer join, the query includes all records from the 
first file and only those records in the second file where the joined fields 
are equal. Using the same example, the query would include all records 
in the Transaction file and only the records from the Employee file that 
have an entry in the Transaction file.

• If you select a right outer join, the query includes all records from the 
second file and only those records in the first file where the joined fields 
are equal. Following the same example, the query would include all 
records in the Employee file and only records from Transactions file 
that have an employee code.

Query selections for
employees that live in Dallas

and have a review date
before May 15, 1999.

Query selections for
employees that live in Dallas

and have a review date
before May 15, 1999.



Custom Reporting
Sage DacEasy Payroll User’s Guide

160

8

To Limit Records on a Query

1 Position your cursor in the appropriate box below the field used to limit the 
query. There is an OR relationship between rows and an AND relationship 
between columns. Sage DacEasy satisfies all AND criteria before satisfying the 
OR criteria.

2 Enter the criterion for the field. 

Enter a value in the field to include only those records that have the specified 
value in this field. 

To specify a range of records based on a particular expression, enter the 
expression. You can click LookUp to select an operand. For example, to 
include all records greater than or equal to 1000, click LookUp, select >=, 
and then type 1000.

Tip: You can enter up to 18 characters in the column. If you need to enter a 
longer expression, click Options and select Zoom. The cursor advances to the 
Zoom field where you can enter up to 68 characters.

Note: The format used to enter data in an expression depends on the field 
type. Click Options and select Edit Column to view a field’s Data Type.

3 If you selected fields from two different files and want to edit the join, click 
Options and select Edit Join. The Join Editing dialog box appears. Select 
the type of join and click OK to return to the Query Design dialog box.

Printing the Query

When you run the query, the results appear on the screen. To direct your output 
to the printer, click Print. Printing your query may be helpful as you build your 
query. You can print the information to make sure you are pulling the correct 
data before you create the report layout using the Publisher.

Use the Join Editing dialog
box to select the type of

join you want for the
report.
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To Print the Query

1 Choose Query on the DacAccess menu. Enter a query name or click LookUp 
to select a query from a list.

2 Click Run Query. The query appears on the screen.

3 Click Print. The Report Layout dialog box appears.

4 Select your target and click OK to begin printing.

Note: The columns on the Query report vary in width depending on whether 
you have renamed a column title or have accepted the default name. From 
the Query Design dialog box, click Options, and then select Print Format 
to print the Query format. This information is helpful when trying to 
determine the size of a column.

Related Help Topic

• Copying queries

Query List

Using the Publisher
The Publisher is the tool you use to create your report layout and print a custom 
report using a query. When you first access the Publisher, you see the Report 
Editor dialog box. The top portion of the dialog box is for the report name and 
data source. The data source is the query you use to select the fields from for the 
report. Once you have selected a query as the data source for a report, you 
cannot change the data source. 

Note: If you need to use a different query as the data source for the report, you 
must create a new report layout using the Publisher.
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The body of the Report Editor has four sections, the Page Header area, Detail 
area, Group Footer area, and Report Footer area. Use the Page Header area to 
enter the information that prints on the top of each page. Use the Detail area to 
make your field selections for the report. The Group Footer area lets you create 
subtotals for your sort breaks and the Report Footer area lets you create grand 
totals for the report.

You can enter text into each of the four sections of the report or select from 
available variables such as query fields, company information fields and control 
options. You can use different variables in different areas of the Report Editor. 
The fields you chose in the query are available in all sections of the Report 
Editor. If a field you want to include on the report is not included in the query 
selected as the data source, you must save the report layout, exit the Publisher, 
access the query and add the necessary field to the query. Save the query and go 
back to the Publisher to complete the report layout.

Use the Report Editor to lay
out the fields on the report.
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Using the Publisher Checklist

 Step 1—Complete the Header area with the report name and the name of 
the query you want to use as the data source. Enter your report heading 
and column headings in the Page Header area.

 Step 2 —Complete the Detail area with the query fields you want to 
include on the report.

 Step 3 —Complete the Group Footer area if you want subtotals on the 
sorts. 

 Step 4 —Complete the Report Footer area if you want to report grand 
totals.

 Step 5 —Preview and print the final report.

Completing the Header and Page Header Area

The Header area contains a field for a report name and a query name. The fields 
available for the report depend on the query you select. Once you choose a 
query, you cannot change the query name in the Publisher. However, you can 
edit the query if you need to use different fields on the report. The Page Header 
area holds the report heading. The report heading prints at the top of each page 
of the custom report.

Use the Page Header area
of the Report Editor dialog
box to lay out report titles

and column headings.
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Completing the Detail Area

The Detail area is the body of the report. This is where you select fields from 
your query. You can enter either text or place fields in this section. You may 
want to enter text as a note, instructions or to describe the fields.

Completing the Group Footer Area

The Group Footer is for sort subtotals. If you set a sorting order in the query, 
you may want each sort group to have a total for the group. For example, when 
printing a commission report, you may want a total per salesperson. You can 
enter text to describe the total, and then place the field you want totaled in this 
section. If you do not want sort totals, leave this section blank.

Completing the Report Footer Area

The Report Footer area is for grand totals. You can also enter text into this area. 
This area is similar to the Group Footer. Select the fields from your query you 
want to include as grand totals for the report. 

Use the Detail area of the
Report Editor dialog box to
select fields from the query.

Use the Group Footer area
to print subtotals for each

sort on the report.
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To Create a Custom Report With the Publisher

1 Select Publisher on the DacAccess menu. The Report Editor dialog box 
appears.

2 Enter a unique name for the report, and then press Enter. The Report 
Defaults dialog box appears. 

3 Complete each field on the Report Defaults dialog box.

4 In the Data Source field, enter the query name from which you want to create 
the report or click LookUp and select the query from a list.

Note: The query details the information to include on the report and must be 
created before the report can be laid out in the Publisher. 

5 Type a heading for the report in the Page Header area. You can enter text or 
click LookUp and select a variable from a list.

Note: You can select the following types of variables: Company Text, Control 
Fields and Query Fields. Company Text allows you to select variables 
corresponding to the information you entered about your company. Control 
Variables include the current program date, time and page number. Query 
Fields selected in the Page Header area are inserted as text fields to be used as 
column headings.

Tip: Click Options and select Center to center the lines of text or variables 
on the report.

6 Insert the query fields to include on the report in the Detail area. You can type 
text or place fields in this section. 

To insert a query field, click LookUp and select the field from a list. If you 
need to include a field that is not in the list, you must edit the query. The field 
is inserted at the cursor position. You can use the mouse to drag a query field 
to a different location. 

Continue placing fields into this section until all necessary fields are on the 
layout. It may take some trial and error to line up the fields with your column 
headings. 

Use the Report Footer area
to print grand totals on the

report.
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7 If you set a sorting order in the query, you may want each sort group to have 

a total. To include a subtotal on sorted fields, type text to describe the total, 
and then place the field you want totaled in the Group Footer area. If you do 
not want sort totals, leave this section blank.

Note: If no fields are selected in the Sort Columns area on your query, Sage 
DacEasy uses the field in the first column of the query as the sort field.

8 To include grand totals on the report, select each field to total in the Report 
Footer area. You can also type text in this section. 

Tip: Press Enter from any field to edit the formatting. The Field Edit dialog 
box appears. Click Help from this dialog box for a detailed description of each 
formatting option.

Previewing and Printing the Final Report

When you print the report, the information specified by the query appears using 
the layout created in the Publisher’s Report Editor. You can print to the screen 
to preview the report and verify the format. If it is not correct, edit the layout 
and print the report again.

To Print the Report

1 Choose Publisher on the DacAccess menu. The Report Editor dialog box 
appears. Create a new report or click LookUp to select one from a list.

2 Click Print to view the Report Layout dialog box.

3 Select your target and click OK to begin printing.

Related Help Topic

• Copying report layouts in the publisher



9Glossary of Terms 

1099 Misc Form

You provide 1099-MISC forms, at the end of the year to your 
contract labor employees. This form shows the wages paid to the 
contract labor employee for the year. Sage DacEasy Payroll 
prints both continuous-feed or laser 1099-MISC forms in the 
format prescribed by the Internal Revenue Service (IRS). You 
can purchase these forms from the Sage DacEasy Forms 
department by calling (800) 222-0505.

940 Form

The Form 940 is the federal unemployment (FUTA) tax return 
you must submit to the IRS at the end of each year. The data 
supplied by Sage DacEasy for the form is retrieved from the Edit 
Employee Accumulations dialog box and the ROFT (Record of 
Federal Tax liability) in the 940 file, both of which Sage DacEasy 
updates during posting. 

If you need further information on the Form 940, refer to the 
IRS Circular E Tax Guide.

941 Form

The Form 941 is the quarterly federal tax return you must 
usually submit to the IRS at the end of every quarter (when you 
submit the form depends on your liability). You should acquire 
laser or continuous-feed 941 forms before running this routine 
or you can choose to print the 941 form on plain paper. There 
is an additional option that allows you to print the 941 
worksheet. Use the 941 worksheet as the source document to 
complete the 941 form manually.
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ACH (Automated Clearing House)

You can create two types of direct deposit files, an NPC (National Payment 
Corporation) file or a generic ACH (Automated Clearing House) file. You can 
use either option to process direct deposits for your employees. If you checked 
with your company’s financial institution and they provide direct deposit as 
part of their payroll services, you can create a generic ACH file and work directly 
with your financial institution. Identify the type of direct deposit file you are 
creating on the System Preferences dialog box. View this dialog box by choosing 
Defaults from the Edit menu, and then choose Preferences.

A generic ACH direct deposit file is transmitted over the modem using your 
bank's software or it is copied to a disk and delivered to your financial 
institution. The method you use to transfer your direct deposit information 
depends on the arrangements set up with your bank. 

Sage DacEasy Business Center

The Sage DacEasy Business Center provides a single entry point for all Sage 
DacEasy programs and includes a number of features designed to increase 
productivity. This includes the ability to view multiple windows concurrently, 
update company information for all Sage DacEasy modules, and back up or 
restore data without exiting the Sage DacEasy Business Center. In addition, you 
get quick access to Sage DacEasy, the Internet and user assistance.

Code

Codes are items that affect the amount of an employee's payroll check and the 
accounts for each company expense related to a payroll transaction. View codes 
by choosing Codes on the Edit menu.

Codes are divided into three categories, earnings, deductions and liabilities. 
Each category represents the affect this code has on the employee's payroll check 
or the company's account balances related to the payroll transaction. Earnings 
usually increase the amount of an employee's paycheck. Deductions usually 
decrease the amount of an employee's paycheck and liabilities is the amount the 
employer pays a third party, such as the government, based on the amount of 
the employee's earnings. See also Standard Codes and User Defined Codes.

Deduction

Deductions refer to amounts subtracted from an employee's earnings. Many 
deductions are mandated by federal, state and local tax authorities. For example, 
the federal government requires employers to deduct set amounts for federal 
income taxes.
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Direct Deposit

The Direct Deposit feature transfers funds directly from an employer's bank 
account(s) into an employee's bank account(s). Process a direct deposit by 
choosing Direct Deposit from the Process menu. Sage DacEasy Payroll supports 
two types of direct deposit files, NPC (National Payment Corporation) and 
ACH (Automated Clearing House). See also NPC and ACH.

Earning

Earnings refer to amounts paid to the employee for services performed that 
benefit the employer. These amounts are subject to federal, state and local taxes 
and do not include amounts received as reimbursement (for example, business-
related travel expenses).

EIC (Earned Income Credit)

EIC or Advanced Earned Income Credit is not a tax withheld from an 
employee's earnings but, rather, a tax credit the employee receives. An 
employee's eligibility to receive EIC payments is based on certain requirements, 
which are listed on the Form W-5 (Earnings Income Credit Payment 
Certificate).

For an employee to receive EIC payments, the employee must provide the 
employer with a properly completed Form W-5. EIC payments are strictly 
regulated. For more detailed information about this tax credit, please refer to 
the IRS Publications, Circular E, Section 10, Advanced Earned Income Credit 
(EIC). 

Federal Withholding

The Current Tax Payment Act of 1943 and the 1986 Tax Reform Act require 
employers to subtract estimated taxes from employees’ taxable earnings and pay 
this amount to the IRS. These estimated income taxes are called withholdings. 
Taxable earnings for income tax purposes are gross earnings including: bonuses, 
commissions, cash advances, other payments such as the cash value of meals and 
lodgings when provided for the convenience of the employees

An employee’s taxable earnings are affected by marital status and withholding 
allowances. A withholding allowance, or personal exemption, is the amount of 
money by which someone can reduce the amount of earnings subject to income 
tax. Everyone is allowed one allowance plus an additional allowance for each 
dependent.
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Employees tell employers how many exemptions they claim by filling out a W-
4 Federal Form when they are hired. Federal law requires employers have a W-
4 on file for every employee. Federal income withholdings differ for married and 
single people, the tax rate for single people is higher than that for married 
people.

In addition, people who had no federal income tax liability the past year and 
expect no liability in the current year can claim a no-tax liability exemption 
when filling out the W-4 Federal Form. Employers must not withhold federal 
income taxes from these workers. 

FICA

The FICA (Federal Insurance Contributions Act) tax finances two social 
programs: Old Age, Survivors and Disability Insurance (OASDI, which is more 
commonly known as Social Security) and Medicare.

Social Security is the largest program funded by FICA. It provides pensions to 
retired persons 62 years or older, payments to disabled persons and benefits to 
dependents of insured workers who have died or become disabled. Medicare is 
a health insurance program for persons 65 or older and the disabled. 

FUTA

Employers must pay taxes to the federal government to fund services and 
benefits for temporarily unemployed workers. The employer pays these taxes 
even though they are based on employee earnings. The Federal Unemployment 
Tax Act (FUTA) requires employers to pay a tax to help support government 
run employment offices across the country. The FUTA tax rate and limit vary 
depending on the nature of your company. Check with the IRS to determine 
what your FUTA rate and limit are before you start processing payrolls.

A company’s SUI (State Unemployment Insurance) rate is credited against its 
FUTA rate, reducing the amount of FUTA paid. For example, if a company has 
a SUI rate of 3.5%, its FUTA rate would be 2.7 (6.2%—the maximum FUTA 
percent—minus 3.5% of SUI). Sage DacEasy defaults the minimum FUTA rate, 
which is 0.8%.

Liability

Liabilities refer to amounts paid by the employer but the amount paid is based 
on the amount of the employee's earnings. For example, both the employer and 
the employee are responsible for paying the Social Security tax. The employee's 
share of the tax is considered a deduction, while the employer’s share of the tax 
is considered a liability.
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Magnetic Media

The federal government requires you to file W-2 forms in a magnetic media file 
if you have more than 250 employees. You must register with the Social Security 
Administration in order to submit a magnetic media file. Sage DacEasy creates 
W-2 forms to a file that meets the magnetic media file requirement set by the 
Social Security Administration.

In addition, Sage DacEasy automatically includes your state records in the 
magnetic media file. If you are required to file magnetically with your state, you 
can copy the magnetic media file to another disk and send the file to your state’s 
taxing authority.

Medicare

See FICA.

New Hire Report

In accordance with the Personal Responsibility and Work Opportunity 
Reconciliation Act of 1996 (PRWORA), all employers are required to report 
certain information on their newly hired employees to a designated state agency. 
This report can be the W-4 Form or the W-4+ Form. See also W-4 Form and W-
4+ Form. 

NPC (National Payment Corporation)

You can create two types of direct deposit files, an NPC (National Payment 
Corporation) file or a generic ACH (Automated Clearing House) file. You can 
use either option to process direct deposits for your employees. If you are using 
the third-party institution NPC to process your direct deposit, you want to 
create an NPC specific file. Identify the type of direct deposit file you are creating 
on the System Preferences dialog box. View this dialog box by choosing 
Defaults from the Edit menu, and then choose Preferences.

An NPC specific direct deposit file uses modem communications software to 
directly link with an encryption algorithm routine. This ensures the security of 
your transmission and prevents any unauthorized access to your electronic 
payment information. This routine scrambles electronic payment information 
according to predetermined unique calculations for each user.
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Prenote

Transmitting a zero dollar amount credit to your bank to make sure the routing 
and bank account numbers are correct for direct deposit. You need to set up the 
company direct deposit account information and the employee direct deposit 
account information before you can prenote a direct deposit. When prenoting 
a direct deposit, make sure no entries are in the Transaction Entry dialog box.

Reconciliation

A routine used to keep track of outstanding, cleared and voided payroll checks. 
To access Sage DacEasy Payroll’s reconciliation routine, choose Reconciliation 
on the Periodic menu, and then select Reconcile Checks.

Schedule B

The Schedule B prints a report of your tax liability on a daily basis. You must 
complete this schedule if you are required to deposit on a semiweekly basis or if 
your tax liability on any day is $100,000 or more. You must show tax liability 
here, not deposits. If you are starting in the middle of a quarter, the amounts will 
be incorrect because the 941 file is updated during the posting routine. 
Therefore, you must manually enter the amounts according to the day.

You can choose to print a Schedule B worksheet or the federally approved form. 
If you select to print the worksheet, use the worksheet as the source document 
to complete the Schedule B form manually.

SDI

Many states require businesses to provide insurance for their employees who 
become sick or have a non-work related accident (in some states, employees also 
must also pay the tax). State Disability Insurance (SDI) can be based on a 
percentage of gross wages with a maximum amount per year or per week. For 
example, Hawaii and New York base a percentage of gross wages with a 
maximum amount per week. In addition to these two states, SDI also applies to 
California, Rhode Island and Puerto Rico. 

Social Security

See FICA.

Standard Codes

Standard codes represent those codes used by the majority of companies. For 
example, standard earning codes include salary, hourly and overtime. You 
cannot edit or delete standard codes.
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SUI

Employers must pay taxes to the state government to fund services and benefits 
for temporarily unemployed workers. The employer pays these taxes but the 
taxes are based on employee earnings (in some states, employees must also pay 
the tax). The State Unemployment Insurance tax (SUI, also known as State 
Unemployment Tax Acts, or SUTA) requires employers to pay a tax to provide 
benefits for qualified unemployed workers. Like FUTA, SUI taxes are based on 
employees’ earnings for the year. The SUI tax rate and limit is based on each 
individual company (the nature of business and unemployment history) and 
the limit varies from state to state. Check with your state’s revenue department 
to determine what your SUI rate and limit are before you start processing 
payrolls.

SUTA

See SUI. 

Third Party Sick Pay (TPSP)

When a third party such as an insurance company pays an employee’s sick pay. 
Sick pay is generally any amount paid under a plan because of an employee's 
injury, sickness or disability. This includes both short- and long-term disability 
benefits.

User Defined Codes

Codes you create are referred to as user defined codes. Every company has 
unique payroll needs, and the standard codes included in the program do not 
accommodate every type of payroll situation. For example, commissions are 
paid differently in each company. If a company needs such an earning, Sage 
DacEasy allows you to create a user defined earning code for commission and 
allows the company to define how to pay the commission.  

W-2 Form

You provide W-2 Forms, Wage and Tax Statement, at the end of the year to your 
employees. This form shows the wages paid and taxes withheld for the year for 
each employee. Sage DacEasy Payroll prints both continuous-feed or laser W-2 
forms in the format prescribed by the Internal Revenue Service. You can 
purchase these forms from the Sage DacEasy Forms department by calling (800) 
222-0505.
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W-3 Form

The W-3 Form is a summary for the employer of the information printed on the 
W-2 forms. You will be prompted to print the W-3 form automatically after you 
print the W-2 forms. However, you can print the W-3 Form at any time.

W-4 Form

In accordance with the Personal Responsibility and Work Opportunity 
Reconciliation Act of 1996 (PRWORA), all employers are required to report 
certain information on their newly-hired employees to a designated state 
agency. Most states accept the W-4 Federal Form, but some states require 
additional information. Refer to the New Hire Report if your state requires 
additional information.

W-4+ Form

Similar to the W-4 Form, but includes additional information such as SUI  
(State Unemployment Insurance) account, hire date, birth date, state of hire, 
salary, gender, status and occupation. Since some states require additional 
information you can use the W-4+ Form to provide this information.
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